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1 Company Set-up
1.1 Overview

In order to utilize the Polish functionality, the company must be set up as using the Poland
localization. This is defined in the page Company.

1.2 Define localization

e Open the page, Company.

e Search for the company.

o Select “Poland” in the drop-down list in the Localization field and save. Note that this cannot
be changed once transactions are created for the company.

Search asvencea
Company: AMKA-PLN * @  CreationDate ¥ CreatedBy ¥ Name ¥ More ¥ © Favorites  Clear Q i settings

sty v

Company AMKA-PLN - AMKA-PLN ¥ 1of1

AMKA-PLN

& # 7 B~ Update Company Update Company Translation New Company Q
Name: AMKA-PLN
Address
Communication Method company Name Assadiation No Created By
Message Seup AMKA-PLN AMKA-PLN ~ AMKALK
Emplayees X X X

General Information Miscellaneous Information
Accounting Rules

Default Language Country Dotument Logatype Document Recipient Address Positioning
Tax Contral ~

English ~ POLAND - Right -
Ivoice

Localization Form ne nde Authrization 1D
Payment

Poland -
Fixed Assets

Classification of Business zation ID Exp dentifier Reference
Periodical Cost Allocation Auonzanon e o dentifier Referenc
Supply Cnain Information &

Jate ource Company ) eterence validatio
Localization Control Center bar mpan 10 Reference Valkdarion
=
Show less 8 None v
urce Template ID Template Company

STD-PL

Country Solution POLAND 2
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1.3 Select Localization functionality.

Specify which functionality to use.
e Open Localization Control Center sub menu under Company.

e The localization selected in previous step is displayed in the Localization Control Center field
and cannot be changed.

o All functionality available for Poland is presented in the list. Enable/Disable the functionality
based on the requirements for the company by enabling the radio buttons. Note that some
functionality is mandatory and cannot be disabled.

Localization Control Center waeerouano-poiish company = 30r6

> # 0

i Access Control for Inventory Rese  Enables a more specific access control for making inventory reservation, instead of using the user-allowed-sites control as in core.

 Access Control for

ntory Tran  Enables a more SPECIfi User ACcess control Tor pe Wentory ransactions instead of using the user-allowes
Cash Account Currency Rate Mett  Enables to use FIFD or AVG method in mixed payment and cash box

¢ Currency Rate Date and Woucher | Enables to use delivery date 35 voucher date and Lax currency rate date in customer order invoice, instant invoice and project invoice. Enhancement of outgoing invoice currency rate date

i Discounted Price Rounded Enables the rounding of the sales price after applying the discounts on the custamer order ines and customer order invoice ines
i Polish E-nvoice Enables the generation of the e-invoice XML file, including Polish legally required data, used for sending invoices 1o tax authorities
i Polish Spit Payment Enables handling of split payment transactions when using payment formats. Spiit payment transactions are created according to Polish specific regulations.

¢ Reposting of Cumrency Difference  Enables to handle currency difference related to tax separately from currency difference related to net amount by introduction of additional postings. The additional postings make it possi

i Round Tax Amount for Supplier It Enables rounding of tax amount ta O detimals for suppler invoices in accounting currency when tax code is of type Calculated Tax. In Poland this is used in order to register customs docur

Specific Data for Customer Invoic  Enables to incude specific additional data in Polish customer invoices, including tax amount and gross amount on the invoice lines, 0% tax rate printed in characters and Company Tax ID.

i Standard Audt File-Tax for Polant  Enables to generate reports in XML format for VAT declaration and records of VAT an sales/purchase, customer invoices, inventory, mixed payments and accounting ooks.

¢ TaxReliability Control on Supplier  Enables the control of the supplier's tax reliability status when entering purchase orders, manual suppber invoices and payment proposals

B BEBEB6B6E688
z e I e s Rz

2 Cash Account Currency Rate Method
2.1 Overview Legal Requirement

This requirement covers the different currency rate methods for bank and cash account movements
in Poland. In Poland, at the outgoing payment moment it is not needed to account for the differences
between the invoice currency rate and payment currency rate.

The rate for the outgoing transaction is calculated based on the incoming transactions.

The different methods for calculating currency rates are weighted average (AVG) and FIFO.

Country Solution POLAND 3
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2.2 Process Overview

Create Currency rate Create
Incoming updated in the Outgoing
Transactions cash account Transactions

Define basic
data

View Postings

Postings are created for the currency difference when the outgoing payment is approved.

2.3 Solution Overview

Cash Account

Two-step
Currency Rate Currency
Short Name Calculation Method Handling of Negative Balance Profiv/Loss
AVG-GBP Weighted Average Currency Profit/Loss after each Inflow m
AVG-USD Weighted Average Currency Profit/Loss after each Inflow Yes

The column Currency Rate Calculation Method in the Cash Accounts page defines the method of
currency rate calculation for outflow. It can have following values:

e Weighted average
e Firstin, First Out

The column Handling of Negative Balance on the Cash Accounts page defines how the calculation
is carried out in case the cash account has a negative balance. It can have the following values:

e Currency Profit/Loss after each inflow
e Aggregate Currency Profit/Loss

The Two-steps Currency Profit/Loss check box in the Cash Account page is enabled for editing. It
controls how currency differences are posted. The details are explained below.

If Two-steps Currency Profit/Loss check box is checked —

e Currency rate which is in the cash account queue will not be fetched to postings, instead the
currency rate which is given when approving the outgoing payment is fetched to the postings.

Country Solution POLAND 4
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If Two-steps Currency Profit/Loss check box is Unchecked —

e Currency rate which is in the cash account queue is fetched to the postings when the outgoing
payment is approved.

New currency rate calculation methods are introduced when approving,

e Mixed Payments
e Cash Box Payments

2.4 Prerequisites

1. The company must be set-up to use Poland localization, see the Company Set-up chapter
and the “Cash Account Currency Rate Method” parameter must be enabled.

2. Cash accounts should be created.
- In the Cash Accounts page, you can define the calculation method of currency rate for
cash account in foreign currency.
- These columns are editable only when Cash Account is not in accounting currency.

3. Cash Accounts should be linked to posting control PP1.

4. Posting controls PP80 (currency Gain) and PP79 (Currency loss) should be created. (This is
only needed when Two-steps Currency Profit/Loss check box is checked.

5. Customers and Suppliers should be created.

2.5 Weighted Average Method

In the AVG method the average currency rate is calculated for the cash account using incoming
transactions. The current balance of the cash account in transaction currency and accounting
currency is calculated after each incoming transaction. It is used when calculating currency rate for
outgoing transactions.

Balance in accounting currency divided by balance in transactions currency calculates currency rate
for outgoing transaction. The currency rate of an outflow is updated with the historical average
currency rate in the mixed payment line after the mixed payment is approved.

EXAMPLE:

Currency Rate Calculation Method - Weighted Average
Handling of Negative balances - Currency Profit/loss
Two step - Checked

Country Solution POLAND 5
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Inflow Amount In Infl Amountin Average
. nflow .
Transaction Accounting Currency
Currency Rate
Currency Currency Rate
150 43 645
100 4.2 420
200 4 800
450 1865 4.14
1. Create 3 manual customer invoices as below,
Manual Customer Invoices
= Y B v New Manual Customer Invoice = v
Invoice Gross
v g 4 Customer Series ID Invoice No Invoice Type Date Currency Amount Net Amount Tax Amount
2 ° PL_CUS-PL_CUS FS A1 FS 5/12/2021 USD 150.00 150.00 0.00
2 ° PL_CUS-PL_CUS FS A2 FS 5/12/2021 usb 200.00 200.00 0.00
2 ° PL_CUS-PL_CUS FS A3 FS 5/12/2021 USD 100.00 100.00 0.00

2. Create a mixed payment, connect the previously created invoices with respective currency rates

and approve.

Debit
450.00

Credit
0.00

Credit Amountin Acc Curr

0.00

Transaction Details

Y B v R v View Transactions

(l) Amount Currency Rate  Inv/Prepaym No
@ : 200.00 4 A2
100.00 42 A3
150.00 43 Al

Debit Amount in Acc Curr

1865.00

Notes Cancel Matching

Lump Sum
Trans Number

Payment Transaction Type
3  Enter Customer Paymen
2 Enter Customer Paymen'

1 Enter Customer Paymen

Cash Account User Group

*

*

Bank Transactio

3. Cash account should be updated.

Country Solution POLAND 6
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Currency
3 : Amount
[ 450.00

Cash Account Queue - PL WA

Amountin Acc
Curr

1865.00

Currency Rate

4.1444

4. Create a manual supplier invoice for 200.

T A Posted
Manual Supplier Invoice rz-an v #of
K2 7 B v New Manual Supplier Invoice More Information Pre Posting V)
PO Reference Receipt Reference Sub Contract Reference Invoice Advice Reference  Project ID
= -
Supplier Invoice Type Series ID Invoice No
@ - suppLsue Fz Fz Al
Currency Currency Rate Invoice Date Arrival Date pay Term Base Date
usb 5i 5/12/2021 5/12/2021 5/12/2021
Payment Terms Due Date Plan Pay Date Payment Reference Voucher Type Reference
0 - Due Immediately v 5/12/2021 5/12/2021 I
Voucher No Reference Authorizer ID Notes Advance Invoice Period Allocation Pre-posting
2021000001 . - @ o [ o] [ o]
Received Attachments On Hold Installment Posting Proposal Gross Amount Net Amount Tax Amount
[ no) [ no} [ no} 200.00 200.00 0.00
Line Information
Gross Amount Net Amount Tax Amount Non-deductible Tax Am Cost Amount
200.00 200.00 0.00 0.00 200.00

Iy

IN

A\

5. Create a mixed payment with the currency rate 5 and connect the previously created invoice and

approve.

Transaction Balances

Cash Account Statement No

AJTEST1 3

Debit

0.00

Credit Amount in Acc Curr

1000.00

Transaction Details

Y B v t 7 R Edit Transactions Open Supplier Bills Open Issued Checks B v
Lump Sum
(l) Amount Currency Rate  Inv/Prepaym No Trans Number ~ Payment Transaction Type ~ Cash Account User Group Bank Transacti
&e ‘ -200.00 ‘ 5 Al 1 ‘ Enter Supplier Payment  * *
|

Credit
200.00

Remaining Amount

200.00

Debit Amount in Acc Curr

0.00

6. View the postings for the mixed payment,

Country Solution POLAND 7
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Mixed Payment Vouchers ein-com-2021000003-512/2021 ¥ 1081

« B~ v
Company Voucher Type Voucher No Voucher Date

PLN-COM N 2021000003 5/12/2021

Accounting Year Accounting Period

2021 5

Voucher Rows

v Bv | Bv B~

Debit Amount  Credit Amount Amountin DebitAmount  Credit Amount Amount in Debit Al

in Transaction in Transaction Transaction in AECOquIﬁg in AECOUHUHg AECOUIW\Hg in P,

m Account Currenc Currency Currenc Currenc Currenc Currenc Cul
B y y y y y y
13010 - Current banking account 200.00 -200.00 1000.00 -1000.00

21015 - Short-term domest.payabl.c. 200.00 200.00 1000.00 1000.00 2

13010 - Current banking account 0.00 0.00 171.12 171.12 2

3] | 3960 - Exch gain on receivables and ... 0.00 0.00 17112 = lTakibs 2
75030 - Positive currency differences 0.00 0.00 0.00 0.00

Calculation for the exchange gain is calculated as below,

Amount in Transaction Currency Amount in Accounting Currency
200 * 4.14 828.8
200 * 5 1000

171.12

Note - This is a positive currency difference (Currency Gain), posted with PP80. If in case there is a
currency loss, then postings are posted with PP79 (Currency Loss)

In this scenario Two-steps Currency Profit/Loss check box is checked —

e Currency rate which is in the cash account queue will not be fetched to postings, instead the
currency rate which is given when approving the outgoing payment is fetched to the postings.

Cancelling mixed payment

- For AVG method, cancelling the mixed payment is allowed.

- The warning message “There is an existing approved mixed payment with later payment
date. The wrong order of approval creates wrong average currency rate. Do you want to
proceed” will be presented to the user when there is any approved mixed payment which has
later payment date.

Country Solution POLAND 8
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2.6 Weighted Average Method —Handling of Negative Balance using Currency
Profit/Loss after each inflow

Currency Profit/Loss after each inflow is one of the calculation methods of Handling of Negative
Balance in the Cash Accounts page, it defines how the calculation is carried out in case the cash

account has a negative balance.

This is when the cash account has a negative balance instead of a positive balance.

How the functionality works - when there is a negative amount in the cash account — Creating an

outflow

1. Make the balance of cash account negative.

iii

Y B v

| LiA

ot 3 Amount

Currency Amount in Acc
Curr

-290.00 -1450.00

Cash Account Queue-PL WA-P

Currency Rate

5

2. Create a Manual supplier invoice for an amount of 200, create a mixed payment and connect the
created manual supplier invoice with the currency rate 3 and approve.

& 2| 4 R v Cancel

GENERAL TRANSACTIONS

Transaction Balances

Cash Account Statement No
PL_WA 525

Debit

0.00

Credit Amount in Acc Curr

600.00

Transaction Details

Y | B v

-200.00

v i Amount Currency Rate

3

Print Mixed Payment

Credit

200.00

Inw/Prepaym No

59

Mixed Payment PL_WA-525-5/17/2021 ¥  3o0f3

View Vouchers Notes Check Collection Level

Remaining Amount

0.00

Debit Amount in Acc Curr

0.00

Lump sum
Trans Mumber  Payment Transaction Type Cash Account User Group

1  Enter Supplier Payment ¥ =

Approved

Q

Bank Transactio

Country Solution POLAND 9



3. Cash account will get updated as below,

Currency Amountin Acc
Amount Curr
-490.00 -2050.00

Calculation is done as below,

Cash Account Queue - PL WA

Currency Rate

4.18

Currency Amount

Amout in Accounting Currency

Currency Rate

-290 -1450 5
-200 -600 3
-490 -2050 4.18

Postings are as below,

£ 8B~

Company
PLN-COM

Accounting Year
2021

Voucher Rows

B v

Transaction
v i Code

{E[ 2]

IP1

Voucher Type Voucher No

N 2021000013

Accounting Period

5

Account
13010 - Current banking account

21015 - Short-term domest.payabl.c...

Mixed Payment Vouchers sin.com-2021000013-

5/17/2021 ¥

10of1

Voucher Date

5/17/2021

Debit Amount

Conversion in Transaction

Currency
usD

usD

Currency Rate
2

3

Factor Currency
1

1 200.00

Credit Amount
in Transaction
Currency

200.00

D\,
N

IFS

Note — Even though cash account shows a currency rate of 4.18 this will not be fetched to postings
as the cash account balance is negative. Here currency rates are posted based on the currency rate
entered in the mixed payment.

Country Solution POLAND 10
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How the functionality works - When there is a negative amount in the cash account — Creating an
inflow

1. Cash account is already negative.

Cash Account Queue - PL WA

Currency  Amountin Acc
v i Amount Curr Currency Rate
-490.00 -2050.00 4.18

2. Create a manual customer invoice for an amount of 100, Create a mixed payment and connect
the same invoice with the currency rate 3.5 and approve.

Transaction Balances

Cash Account Statement No Remaining Amount

PL_WA 526 0.00
Debit Credit Debit Amount in Acc Curr
100.00 0.00 350.00

Credit Amountin Acc Curr

0.00

Transaction Details

¥ | B 8 v
Lump Sum
v i Amount Currency Rate  Inv/Prepaym No Trans Number  Payment Transaction Type = Cash Account User Group Bank Transactio
100.00 3.5 9874 1 Enter Customer Paymen * -

3. View the cash account.

Cash Account Queue - PL WA

i= V B v

Currency  Amountin Acc
v : Amount Curr Currency Rate
-390.00 -1632.00 4.18

Note — Cash account currency rate will not get updated, instead it will remain the same currency
rate. This is because the cash account has a negative balance. when this balance is changed to
positive, currency rates will be used proportionally.

Country Solution POLAND 11
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2.7 Weighted Average Method - Handling of Negative Balance using

Aggregate Currency Profit/Loss

Aggregate Currency Profit/Loss is one of the calculation methods of Handling of Negative Balance
in the Cash Accounts page, it defines how the calculation is carried out in case the cash account

has a negative balance.

This is when the cash account has a negative balance instead of a positive balance.

How the functionality works - When there is a negative amount in the cash account — Making an

outflow.

1. Make the balance of cash account negative.

Cash Account Queue - PL_A(

= Y B v
Currency Amountin Acc
v H Amount Curr Currency Rate
-1000.00 -5000.00 5

2. Create a Manual supplier invoice for an amount of 3000, create a mixed payment and connect
the created manual supplier invoice with the currency rate 3 and approve.

Transaction Balances

Cash Account Statement No

PL_AGGREGRATE 3

Debit Credit
0.00 3000.00
Credit Amountin Acc Curr

9000.00

Transaction Details

Y | B v /7 m RV

Amount

W2

Currency Rate Inv/Prepaym No

: -3000.00 3 6220213

Edit Transactions

Remaining Amount

3000.00

Debit Amount in Acc Curr

0.00

Open Supplier Bills Open Issued Checks B v
Lump Sum
Trans Number Payment Transaction Type Cash Account User Group Bank Tran|
1  Enter Supplier Payment ¥ 2

Country Solution POLAND 12




3. Cash account will get updated as below.

B v

Currency
v : Amount

-4000.00

Amount in Acc
Curr

-14000.00

Cash Account Queue-PL A

Currency Rate

3:5

Calculation for currency rate is as below.

. |Amount
Inflow amount in| . Inflow curr
in Acc
Trans curr rate
curr
-1000 -5000 5
-3000 -9000 3
-4000 -14000 3.5

4. View vouchers.

=
7N

IFS

Voucher Type

N

Accounting Period

6

- Negative currency differe...

£ 8 v
Company
PLN-COM
Accounting Year
2021
Voucher Rows
Y B~
Tran...
- i Code Account
PP12 75140
PP13  75030-
IP1 21015 -
IP1 21015 -
PP1 13010 -

Current banking account

Positive currency differen...
Short-term domest.payab...

Short-term domest.payab...

Mixed Payment Vouchers ru.co

M - 2021000042 - 6/2/2021 ¥

Voucher No
2021000042
Curre..

currency Rate
usD 3
usb 3
usD 3
usD 3
usp 3

10f1

Woucher Date

6/2/2021

Debit Amount

Conversion in Transaction
Factor Currency
1 0.00
1
1 3000.00

1

1

Credit Amount
in Transaction
Currency

0.00

0.00

3000.00

E

Amaountin
Transaction
Currency
0.00

0.00
3000.00

0.00

-3000.00

Note — Even though cash account shows a currency rate of 3.5 this will not be fetched to postings
as the cash account balance is negative. Here currency rates are posted based on the currency rate
entered in the mixed payment.

How the functionality works - When there is a negative amount in the cash account — Making an

inflow.

Country Solution POLAND 13



1. Make the balance of cash account negative.

= R 1o
Currency Amountin Acc
v z Amount Curr
: -4000.00 -14000.00

Cash Account Queue - PL_Al

Currency Rate

3.5

Z-IFS

2. Create a Manual customer invoice for an amount of 1500, create a mixed payment and connect
the created manual supplier invoice with the currency rate 3 and approve.

Transaction Balances

Cash Account Statement No

PL_AGGREGRATE 4
Debit Credit
1500.00 0.00

Credit Amount in Acc Curr

0.00

Transaction Details

Y | B v R v View Transactions

o ] Amount Currency Rate  Inv/Prepaym No

1500.00 3 6220213

®

Remaining Amount

0.00

Notes Cancel Matching

Lump Sum
Trans Number

Payment Transaction Type

Enter Customer Payment &

Debit Amount in Acc Curr

4500.00

Cash Account User Group Bank Tran

*

3. View cash account.

Cash Account Queue - PL_A!

Currency  Amount in Acc

v F Amount Curr  Currency Rate

-2500.00 -9500.00 3.8

Country Solution POLAND 14



Calculation is as below.
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. |Amount
Inflow amountin | . Inflow curr
in Acc
Trans curr rate
curr
-4000 -14000 3.5
1500 4500 3
-2500 -9500 3.8
4. View vouchers.
Mixed Payment Vouchers rincom-2021000042- 6272021 ¥ 10f1
€| B v
Company Voucher Type Voucher No Voucher Date
PLN-COM N 2021000042 6/2/2021
Accounting Year Accounting Period
2021 6
Voucher Rows
T I [ i3]
Debit Amount Credit Amount Amountin
Tran... Curre... Conversion in Transaction in Transaction Transaction
¢ i Code Account Currency Rate Factor Currency Currency Currency
¢ PP12 75140 - Negative currency differe... | USD 3 1 0.00 0.00
¢ PP13 75030 - Positive currency differen... | USD 3 1 0.00 0.00
= 1M 21015 - Short-term domest.payab... | USD 3 1 3000.00 3000.00
PP 21015 - Short-term domest.payab... | USD 3 1 0.00 0.00
:  PP1 13010 - Current banking account usD 3 1 3000.00 -3000.00

Country Solution POLAND 15
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A FIFO queue is used to keep track of incoming transactions. When cash account balance is greater
than zero, then each incoming transaction is added to the FIFO queue. For outgoing transactions,
the rows in the FIFO queue are consumed to compensate the outflow amounts.

EXAMPLE:

Currency Rate Calculation Method —
Handling of Negative balances

Two step -
. Amount
Inflow amount in |Inflow curr| .
in acc
trans curr rate

curr

100 4.3 430

150 4 600

200 4.2 840

450 1870

FIFO

Currency Profit/loss

Unchecked

1. Create 3 manual customer invoices as below using 3 different voucher dates, (Example — 18th,

20th, 24th)

Customer ¥ Series ID ¥

D R Y

Date ustomer

Manual Customer Invoices

B v New Manual Customer Invoice

Invoice No : AJIPLN;AJ2PLN v @

Series ID

5/24/2021 PL_CUS-PL_CUS FS
5/20/2021 PL_CUS-PL_CUS FS

5/18/2021 PL_CUS-PL_CUS FS

Invoice No
AJITPLN
AJ2PLN

AJ4PLN

More v O Favorites

Status

PostedAuth

PostedAuth

PostedAuth

Clear Q@

Invoice Type
FS
FS

FS

Invoice
Date

5/24/2021

5/24/2021

5/24/2021

(1]
<

Gross
Currency Amount  Net Amount

usb 100.00 100.00

usbD 150.00 150.00

usb 200.00 200.00

2. Create a mixed payment for each transaction separately, connect

respective voucher date and currency rate and approve.

the created invoice with

Note - Order of voucher dates are important when approving mixed payments. According to the
functionality which ever transaction is approved in the mixed payment will be fetched to the cash
account as the “first in” irrespective of the payment date.

Therefore, according to above example approve mixed payment according to the order 18th, 20th

and 24%h,

Country Solution POLAND 16



3. View cash account.

Note — Unlike in Weighted average method where an average currency rate was calculated, FIFO
method will keep transactions separately with the respective currency rates in the cash account.

Cash Account Queue - AJFIFO - AJFIFO

Original
Currency AMOuUNt In AcC Onginal Amount In Acc Payment
Amount Curr Amount Curr Status Currency Rate Date
200.00 840.00 200.00 840.00 NotCleared 4.2 50202021

150.00 600.00

NotCleared 4

57182021
572472021

If a payment was made through mixed payment, the currency rate should be picked according to the
FIFO method. The first transactions entered should be picked first as the outflow.

4. Create a manual supplier invoice for an amount of 280. Create a mixed payment and connect the
created manual supplier invoice with the currency rate 4.3 and approve.

Transaction Balances

PL_FIFO

Transaction Details

8 View Transactions Notos

Currency Rate Inw'Prepaym No Trams

FIFOAJ!

Cancel Matching

Lumg Sum

Number

Payment Transaction Type Cash Accounrs User Group

1 Enter Supplier Payment ¢

Country Solution POLAND 17
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5. View the postings of the mixed payment.

Mixed Payment Vouchers rincom-202100003-5242021 ¥ 1081
y her Ty cucher O
N-COM N 202 24/2021
21
Voucher Rows
v -\ I
Jebat Amor Cregit Amount Amaunt in Detut A
ran :.VIT- Canversan i Trarmsa hoe m Transaction '.1{1'..1“\!1!:
i PPI3 75030 - Pastive curren UsSD 413 1 0.00 0.00
i PP13 75030 - Pasitive curren usp 413 1 0.00 0.00
HI 21015 - Shart-term da. usp 4.13 1 0.00 0.00 24360
H 2 ) 13010 - Current bankin usD 413 1 280.00 -280.00
HI ] 1015 - Shart-term do. usD 413 1 280.00 280.00 1156.40
Currency rate is calculated as below,
Currency Amount Currency Rate Amount in Accounting Currency
100 4.3 430
150 4 600
30 4.2 126
280 4.13

Cancelling mixed payment

- When FIFO method is used, only last mixed payment can be cancelled.

- When trying to cancel other mixed payments the user will be presented with an error message
which says, “Only last mixed payment can be cancelled when First In First Out method is
used for foreign currency cash account!”

Country Solution POLAND 18
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2.9 FIFO Method — Handling of Negative Balance using Currency Profit/Loss

after each inflow

Currency Profit/Loss after each inflow is one of the calculation methods of Handling of Negative
Balance in the Cash Accounts page, it defines how the calculation is carried out in case the cash

account has a negative balance.

This is when the cash account has a negative balance instead of a positive balance.

How the functionality works - When there is a negative amount in the cash account — Making an

outflow.

1. Cash account is already negative.

Cash Account Queue - FIFO_PL - 123456
= Y 5oV
Original
Currency Amountin Acc Original Amount in Acc Payment
v g Amount Curr Amount Curr  Status Currency Rate Date
-200.00 -1000.00 -200.00 -1000.00  NotCleared 5 6/9/2021

2. Create a manual supplier invoice for an amount of 500, Create a mixed payment and connect the
created supplier invoice with the currency rate 8.

Mixed Payment FIFO_PL-11-6/9/2021 ¥
& @

GENERAL TRANSACTIONS

Transaction Balances

+ /7 ® B v New Transaction Approve

Transaction Details

Y B v + 7 ) 8 v Edit Transactions

Amount = Currency Rate  Inv/Prepaym No

-500.00 8 89

Cash Account Statement N

FIFO_PL 1

Credit Debit Amountin Acc Curr
500.00 0.00

Trans Number

Print Mixed Payment Note:
Remaining Amount
500.00
Credit A
4000.G4
Open Supplier Bills Open Is
Lump Sum
Payment Transaction Type
1 | Enter Supplier Payment
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3. Cash account will get updated as below,

%

S

\

2,

Cash Account Queue - FIFO_PL - 123456
= Y [ v
Original
Currency Amount in Acc Original Amountin Acc Payment
v i Amount Curr Amount Curr  Status Currency Rate Date
-500.00 -4000.00 -500.00 -4000.00  NotCleared 8 6/9/2021
-200.00 -1000.00 -200.00 -1000.00  NotCleared 5 6/9/2021

- Cash account will get updated with the new transaction which will be shown in minus.

How the functionality works - When there is a negative amount in the cash account — Creating an

inflow

1. Cash account is already negative.

Cash Account Queue - FIFO_PL - 123456
= Y [ v
UrEnal
Currency Amountin Acc Original Amount in Acc Payment
v £ Amount Curr Amount Curr  Status Currency Rate Date
-500.00 -4000.00 -500.00 -4000.00 NotCleared 8 6/9/2021
-200.00 -1000.00 -200.00 -1000.00 NotCleared 5 6/9/2021

2. Create a customer payment for an amount of 1000 and connect the invoice using mixed payment

and approve. Use currency rate 4.

3. Cash account is updated as below,

Cash Account Queue - FIFO_PL - 123456

V B v

Original
Currency ~ Amountin Acc Original  Amount in Acc Payment
Amount Curr Amount Curr  Status Currency Rate Date
300.00 1200.00 300.00 120000  NotCleared 4 6912021
0.00 0.00 -500.00 -4000.00 8 6/9/2021
0.00 0.00 -200.00 -1000.00 5 6/9/2021
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2.10 Delimitations

- Functionality is only supported in the accounting currency. When PP79/PP80 postings and
corresponding PP1 postings are created as a result of differences calculated in the
accounting currency in company with parallel currency enabled, amounts in parallel currency
are set to 0.

- You can only select the value in the Currency Rate Calculation Method field if the cash
account is not in accounting currency and there are no transactions for the cash account.

- Cash accounts with a currency rate calculation method defined cannot be used in other
payment windows (i.e.: supplier payment, customer payment, netting, acknowledge
automatic supplier payment, acknowledge direct debiting etc.)

- In case when FIFO method is used, only the last mixed payment can be cancelled.
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3 Standard Audit File-Tax For Poland (JPK)
3.1 Overview Legal Requirement

Since 1st July 2016 all companies in Poland have to comply with an additional reporting requirement,
i.e., to produce a file detailing specific information about the business of the taxpayer and to provide
it electronically to the Polish tax authorities for audit purposes. In other words, this is an XML-based
procedure for the transmission of companies’ transactions to the tax authorities to enable efficient
auditing of taxable transactions.

These files should be provided in specific formats defined by the Polish tax authorities and thus they
are called Standard Audit File for Tax (SAF-T) or Jednolity Plik Kontrolny (JPK) in Polish.

Since 1st of October 2020 Polish Tax Declaration, VAT-7 Report, is also included in the JPK concept.

According to the Notice published by the Polish Tax Authority, based on the Corporate Income Tax
Act and the Personal Income Tax Act, the initial JPK_KR schema was logically divided into two new
schemas as,

. JPK_KR_PD

. JPK_ST_KR

Accordingly, all companies in Poland are obliged to create reports in XML format according to the
following rules:
Mandatory reports to be provided monthly.
¢ In case of reporting for periods starting from October 2020
o Sales & Purchase VAT Registers and Tax Declaration — JPK_V7M
= JPK _V7M (1) — from October 2020 to December 2021
= JPK _V7M (2) — from January 2022
¢ In case of reporting for periods until September 2020 (including corrections for these periods)
o Sales & Purchase VAT Registers — JPK_VAT
o Tax Declaration (VAT-7) reported outside JPK concept

Mandatory reports to be provided annually.
¢ In case of reporting for periods starting from January 2025
o For Accounting Books - JPK_KR_PD
¢ In case of reporting for periods starting from January 2026
o For Fixed Assets and Intangible Assets — JPK_ST_KR

Reports to be provided on demand:

For Inventories - JPK_MAG

For Sales VAT Invoices - JPK_FA
For Mixed Payments - JPK_WB
For Accounting Books - JPK_KR

In the standard functionality, customer/supplier group is not available in the Tax Ledger. In order to
support TP indicator in JPK_V7M (connections between seller and buyer) it was requested to enable
customer/supplier group in the Tax Ledger with similar functionality as tax code and delivery type in
the standard system.
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3.2 Customer/Supplier Group Enhancement in Tax Ledger

3.2.1 SOLUTION

In order to enhance the system with customer/supplier support in the Tax Ledger, the following has
been done:

1. The Customer/Supplier Group and Original Customer/Supplier Group columns have been
added to the Tax Transactions page.

2. The Customer/Supplier Group column have been added to the Details tab on the Tax
Proposal Details page.

3. The Allow Change of Customer/Supplier Group radio button has been added to the Tax
Ledger Parameters page.

4. The Enable Change of Customer Group radio button, Customer Group field, Enable Change
of Supplier Group radio button and Supplier Group field have been added to the Modify
Tax Transactions page under the new Customer/Supplier Group section.

3.2.2 PREREQUISITIES

The company must be set-up to use Polish localization, see the Company Set up chapter. The
“Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and enabled by
default.

3.2.3 ENABLE CHANGE OF CUSTOMER/SUPPLIER GROUP

Open the Tax Ledger Parameters page. In order to enable possibility to update customer/supplier
group in the Tax Ledger, select the Allow Change of Customer/Supplier Group radio button.

If the Allow Change of Customer/Supplier Group radio button is not selected, customer/supplier
group will still be available in the Tax Ledger, but it will not be possible to update.

) 3 3 <, ] AMKA-PLN
Tax Ledger Parameters

Tax Transactions A Tax Proposal

Original v «

Modify Tax Transactions

3.2.4 ENTER INVOICES

Follow IFS Cloud standard processes to enter customer invoices and supplier invoices.
3.2.5 UPDATE VOUCHERS TO GL

Follow IFS Cloud standard process to update vouchers to General Ledger.

3.2.6 FETCH TAX LEDGER INFO

Follow IFS Cloud standard process to update tax transactions with additional information.
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3.2.7 VIEW TAX TRANSACTIONS
Follow IFS Cloud standard process to view tax transactions.

The following new columns are added to the Tax Transactions page.

e Customer/Supplier Group — Customer or supplier group of the party from the ldentity column
and the corresponding Description of the group.

e Original Customer/Supplier Group — Customer or supplier group of the party from the Identity
column. This original value remains unchanged when customer or supplier group is modified
in Tax Ledger. This also includes the Description of the group from the Original
Customer/Supplier Group column.

® > Financials > Tax Ledger > Tax Transactions & Company [ AMKA-PLN
Search  asvanced

I
TaxTransID ¥  TaxID Number ¥  Identity ¥  Accounting Period ¥ TaxCode ¥  Voucher Date ¥  Year Period Key ¥  AccountingYear ¥  More ¥ O Favorites  Clear Q ¢ Settings

Tax Transactions

VYV B v % Calculate Income Amount :: 0
IsPartof  Includein
Supplier/Custo Is Tax Tax TaxBase  TaxBase Curr Original Customer/Supplier
v on  Invoice Type Branch Branch Tax Code Fetched Reported Correcti.. Ledger  Proposal Amount Amount Tax Amount | Customer/Supplier Group Group
HEERES 23 0 o] Yes -813.01 -813.01 -186.99 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
i1 ks 23 m m -406.50 -406.50 -93.50 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 PREPAYDEB 23 o] o] Yes -500.00 -500.00 -115.00 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 PREPAYCRE 23 m m 500.00 500.00 115.00 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 CUSTORDDES 23 0 o] Yes -450.00 -100.00 10350 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 CUSTORDCOR 23 m m -540.00 -120.00 -124.20 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 CUSTORDCOR 23 o] o] Yes 450.00 100.00 103.50 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
HE >4 WNT23 m m 100.00 100.00 23,00 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
|1z WNT23 0 o] Yes -100.00 -100.00 -23.00 | 0- Domestic Associated Unit 0 - Domestic Assodiated Unit
i 1Rz WNT23 m m m -200.00 -200.00 -46.00 | SUPPLIERGROUP1 - Supplier 1 SUPPLIERGROUP1 - Supplier

3.2.8 MODIFY TAX TRANSACTIONS FROM TAX TRANSACTIONS

If customer or supplier group needs to be changed, update the value on the Tax Transactions page.
If you want to update the value for multiple tax transactions, select the Modify Tax Transactions
command to open the Modify Tax Transactions page. If you want to update customer group, enable
the Enable Change of Customer Group radio button, and enter value in the Customer Group field. If
you want to update supplier group, enable the Enable Change of Supplier Group radio button, and
enter value in the Supplier Group field.

Country Solution POLAND 24



Y,
i IFS

In case transaction is already reported, use the Modify Tax Transactions command to update
customer or supplier group. Two new tax transactions will be created according to the same logic as
if tax code or delivery types was changed in the standard system.

X Modify Tax Transactions

Enter Date Add Number of Days

Delivery Type

Enable Change of Delivery Type Delivery Type

Income Type v
Us Specific 1099 Reporting v
Tax Direction v

Customer/Supplier Group

Enable Change of Supplier Group Supplier Group Enable Change of Customer Group

Customer Group

oK Cancel

3.2.9 CREATE TAX PROPOSAL AND VIEW TAX PROPOSAL DETAILS

Follow IFS Cloud standard process to create a new tax proposal in the Automatic Tax Proposal
page. When proposal is created, follow IFS Cloud standard process to view tax proposal details, by
selecting the Details command.

The following new column is added to the Details tab of the Tax Proposal Details page.

. Customer/Supplier Group — Customer or supplier group and description from tax transaction.
@ > sFinancials > #Tax Ledger > #Automatic Tax Proposal > #Tax Proposal Detalls zcompany [ AMKA-PLN
#Tax Proposal Details s:-so21 = #1101 .
| & Q

#Tax Proposal #Creation Date #User ID
32-5021 71242021 Qrvax
#Tax Report #Tax Template
AK S021 - Tax Sales S021 - #Tax Sales (Detailed)
#PARAMETER i
v B~ =
#Tax
Transaction
#TaxID #Tax Number #imvoice Liability #arrival
v i sCorrection Reference  #Trans Code #Tax Book ID #5ubgroup per Tax Code #Tax 1D Type Date Date Date #Customer/Supplier Group
H P4 T8 WNT - Sum for EU Purchase PL 7172021 72021 0 - Domestic Associated Unit
m P4 B WNT - Sum for EU Purchase PL 7n2021 2021 0 - Domestic Associated Unit
H m P4 TB WNT - Sum for EU Purchase PL 22021 71272021 0 - Domestic Assoclated Unit
o P4 8 WNT - Sum for EU Purchase PL 722021 71272021 0 - Domestic Associated Unit
T ——
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3.2.10 MODIFY TAX TRANSACTIONS FROM TAX PROPOSAL DETAILS

If customer or supplier group needs to be changed, select the Modify Tax Transactions command to
open the Modify Tax Transactions page. If you want to update customer group, enable the Enable
Change of Customer Group radio button and enter value in the Customer Group field. If you want
to update supplier group, enable the Enable Change of Supplier Group radio button and enter value
in the Supplier Group field.

X Modify Tax Transactions

Enter Date Add Number of Days

Delivery Type

Enable Change of Delivery Type Delivery Type

Income Type v
US Specific 1099 Reporting v

Tax Direction v

Customer/Supplier Group

Enable Change of Supplier Group supplier Group Enable Change of Customer Group

Customer Group

OK Cancel

3.3 SAF-T For Poland — VAT Report from January 2022 (JPK_V7M (2))

3.3.1 SOLUTION — SAF-T PLV7M

The solution is based on IFS Cloud standard functionality of tax reporting including tax transactions
and the corresponding tax proposal and audit interface functionality.

In order to support the requirement for the SAF-T PL V7M report, the following has been done:

1. New report type SAF-T added to the Audit Formats page.

2. In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

3. In Audit Interface Assistant page 2/3, new Audit Type field has been added to select
relevant SAF-T report. In page 3/3 additional Proposal ID field specific for the SAF-T V7M
has been added.

4. New external file type and new external file template were added to support SAF-T V7M.

5. List of values is added for the Reference Number column for vouchers of function group M
to have additional invoice information in tax transactions.
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Process Overview:

« Define Tax Office (Standard functionality)
« Define Person E-Mail and Phone Communication Methods (Standard functionality)
« Define Customer Groups, Voucher Types, Delivery Types (Standard functionality)
Define Company « Define Tax Sub Group Details (Standard functionality)

Basic Data

« Enter Audit Format for Poland
« Enter Audit File Basic Data: Tax Office ID, Person ID, Invoice Series for SAD, Customer Groups, Voucher Types,
Delivery Types used to follow specific transactions
Define Audit File Basic
Data

« Enter transactions in accordance with IFS Cloud standard functionality
« Update vouchers to General Ledger
ULECRe el ° Fetch tax transaction details to Tax Ledger

Tax Ledger J
« Select tax transactions for Tax Disbursed of the reporting period J

Transactions

Create Tax Sales

« Select tax transactions for Tax Received of the reporting period

Create Tax Purchase
S022

« Calculate the subtotals and totals of Tax to pay or Tax to return

Create Tax Summary
Report S106

* Run Audit Interface Assistant

« Select country as Poland

« Enter report type SAF-T and audit type JPK_V7M(2)

(O LR\ =R lVa4Y I ° Select file type JPK_V7M2, template, date / period range and VAT-7 Proposal ID
XML File
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e The company must be set-up to use Polish localization, see the Company Set up chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and
enabled by default.

e Itis recommended to create the company using Standard Polish Template (STD-PL).

3.3.3

3331

DEFINE COMPANY BASIC DATA

Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define Tax
Office for Poland — one from the list published on tax authority’s website. For example
‘02027, “10107, “3030” ...

@ > Application Base Setup » Enterprise >

Search  advanced

Tax Office «

sortby -

0202
Name: PL Tax Office Dan

Address
Communication Method

Tax Report

Mame:PL% ~ @

Tax » Tax Office »

CreationDate ¥ More ¥

Tax Office ox2-pL1ax officepan
&« -+ & 0 ® B v

Tax Office

0202

Name

PL Tax Office Dan

2 Favorites

Clear Q

1of1

Default Language
English
Country
POLAND
Creation Date

8/4/2020

! Settings

a

On the Tax Report sub menu, enter the Company and Tax ID Number. Connect the VAT-7 report
used as a base for SAF-T V7M report in the child table.

® > Application Base Setup > Enterprise > Tax > Tax Office > Tax Report £
sortoy v

Tax Report VATPL-VATPL ¥ 1of1
VATPL

& B/
Name: VAT PL
Address
Communication Method Tax Office

VAT PL

Tax Report

Company: AMKA-PLN - AMKA-PLN ¥

Q + | # m )
Company Tax ID Number
AMKA-PLN 202001
te Name
warminsko-mazurskie
Tax Report Info
= v B~ + e

f TaxReport

§ VATTM-VAT7M

VAT PL

varplo1

Electronic Ta

varplo1

D
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3.3.3.2 Define Person E-Mail and Phone Communication Methods

2,

Open the Application Base Setup/Enterprise/Person/Person page General sub menu define
Person ID of person responsible for JPK_V7M reporting. On the Communication Method sub menu
enter E-Mail Communication Method and Phone Communication Method. Select the Default per
Method check box for both methods.

® 5 Application Base Setup > Emerprise > Pers

sortby v

0 AMKALK

Full Name: Amaya Karunaratne
User ID: AMKALK

Address
Communication Method §

Documnents

ans Parson

Communication Method =2

Communication Method AMKALK - Amaya Karunaratne ¥  1of 1

Comm D Name

Full Name

Amaya Karunaratne

Description
1 amaya

2 amaya

3.3.3.3 Define Customer Groups

Communication
Method

E-Mail

Phone

User ID

AMKALK

Default

per
Value Method |Address ID
amaya@amkapln.com

4443553535354

Validity

Default

per

Method

and

Address  Validity Period

Using IFS Cloud standard functionality, define separate customer groups used in order to follow
connections between seller and buyer ((V7M) TP field).

] Financials » Custormner Invoice » Basic Data » Customer Groups k>

Customer Groups

= W [ + &
Use
Collective Default No of
- H Customer Group Description Voucher Invoice Copies
| EE] Domestic Associated Unit m 1 |
N Domestic Mot Associated Unit m 1
| P2 Foreign Associated Unit m 1 |
: |3 Foreign Mot Associated Unit m 1
4 Internal Unit m 1

Note: In brackets you can find the name of the field where the value should be connected in the

Audit File Basic Data/SAF-T Poland Setup tab.

3.3.3.4 Define Voucher Types

Using IFS Cloud standard functionality, define separate voucher types used in order to follow:
e internal documents (WEW field)
e internal summary documents containing sales from cash registers (Sales/RO field).
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® > Accounting Rules > User Related Data > Voucher Type &t

sotey  w

Voucher Type WEW - Internal Documents PL ¥ 1of 1

« 7 m B v New Voucher Type Voucher Series Excluded From IL Translation

Parameter Selection

Automatic
Simulation Vou
nternal Documents PL m
Ledger Selection Use Voucher App 1
Ledger Type Ledger ID Balance Mandatory m
GL, Affect IL *
Use Manual Internal Methods
Function Group Information
re
Single
Optional Voucher Automatic  Function
Auto s Row Group Reference  Allotment  Group
I Function Group Balance  Original Validation — Mandatory Required  Required

t M- Manual vouchers m m m m m m

(I\\

A\,
SVIFS

compzny [ Dan Poland

a

rate User Approval

I
<

Note: In brackets you can find the name of the field where the value should be connected in the

Audit File Basic Data/SAF-T Poland Setup tab.

3.3.3.5 Define Delivery Types

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

e invoices issued on the base of fiscal receipt (Sales/FP field)

¢ invoices from small suppliers who selected cash method for VAT (Purchase/MK field).

® > Financials > Customer Invoice > Basic Data > Delivery Types i
Search  agvanced
Delivery Type: MK ~ @ Description ¥ Include in Invoice Enclosure ¥ More ¥ @ Favorites  Clear
Delivery Types
o + 7
Include in
Invoice
Delivery Type Description
MK Invoices from small suppliers who selected cash method for VAT m

Company | Dan Poland

Enclosure  Invoice Enclosure Series ID

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

e deliveries of alcoholic beverages (GTU_O0L1 field)
deliveries of petroleum products (GTU_02 field)

deliveries of tobacco products (GTU_04 field)
deliveries of waste (GTU_05 field)

deliveries of electronic devices (GTU_06 field)
deliveries of vehicles and car parts (GTU_07 field)

deliveries of heating oil and other oil products (GTU_03 field)

deliveries of precious metals and base metals (GTU_O08 field)

deliveries of medicines and medical devices (GTU_Q09 field)

deliveries of buildings and lands (GTU_10 field)

services in the scope of transferring the right to emit greenhouse gas (GTU_11 field)
selected intangible services (GTU_12 field)

transport and storage services (GTU_13 field).
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L] Financials > Customer Invoice > Basic Data » Delivery Types = company
Search  avances ¥
Delivery Type - GTU% ~ @ Description ¥ Include in Invoice Enclosure *  More ¥ O Favorites  Clear Q & Settings
Delivery Types
(54 = s = v
Include in
Invoice
i Delivery Type Description Enclosure  Invoice Enclosure Series ID
POGTUO Deliveries of alcoholic beverages m
1 GTU_02 Deliveries of petroleum products m
! GTU_03 Deliveries of heating oil and other oil products m
PGTUD4 Deliveries of tobacco products m
i GTU_05 Deliveries of waste m

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

distance EU delivery of goods and provision of telecommunication services, broadcasting
and electronic services ((V7M) WSTO_EE field)

delivery of goods to EU consumers where taxpayer enables electronic platform to non EU
taxpayer and does not use OSS or IOSS procedures ((V7M) IED field)

invoices for tourism services ((V7M) MR_T/(FA) P_106E_2 field)

invoices for secondhand goods and work of art (V7M) MR_UZ/(FA) P_106E_3 field)

EU delivery after import based on import procedure 42 ((V7M) |_42 field)

EU delivery after import based on import procedure 63 ((V7M) 1_63 field)

transfer of a single-purpose voucher made by a taxpayer acting in his own name ((V7M)
B_SPV field)

supply of goods and provision of services to which the single-purpose voucher relates to a
taxable person who issued the voucher ((V7M) B_SPV_DOSTAWA field)

provision of brokering services and other services related to the transfer of multi-purpose
voucher ((V7M) B_MPV_PROWIZJA field).

5 » Suppller involce > BasicData » Dellvery Types & Company Polish company

Search  advanced

Delivery Type : WSTO_EE/IED ~ ] Description ¥ nclude in Invoice Enclosure ¥ More ¥ O Favorites Clear

Delivery Types

W [~ -+ &£ 24

Include in
Invelce
Delivery Type Description Enclosure  Involce Enclosure Serles ID

WSTO_EE Distance EU delivery of goods and pravision of telecommunication services, broadcasting and electronic serv m

IED Delivery of goods to EU consumers where the taxpayer enables electronic platform to non-EU taxpayer and ¢ m

Using IFS Cloud standard functionality, define separate delivery types by which:

transaction value is retrieved and reported in the <K_14> tag ((V7M) K_14/(VAT) K_14 field)
transaction value is retrieved and reported in the <K_35> tag ((V7M) K_35/(VAT) K_38 field)
transaction value is retrieved and reported in the <K_36> tag ((V7M) K_36/(VAT) K_39 field).
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L ] Financials » Custorner Invoice » Basic Data » Delivery Types  r>~

Search  advanced

Delivery Type : K% ~ @  Description ¥  Include in Invoice Enclosure *  More * O Favorites  Clear
Delivery Types
= v L4 =+ &
Include in
Invoice
Delivery Type Description Enclosure
K36 K_36 (Tax Template Field VAT_WNT_PAL SIL)
K 14 K_14 (Tax Template field ART_129_UST) o |
K35 K_35 (Tax Template field VAT_NALEZ_WNT_TRANSP)

>\.\\\|r//
- Z
7N

IFS

Company | Dan Poland

Q

: Settings

Invoice Enclosure Series 1D

Note: In brackets you can find the name of the field where the value should be connected in the

Audit File Basic Data/SAF-T Poland Setup tab.

3.3.3.6 Define Tax Sub Group Details

Using IFS Cloud standard functionality, connect new tax codes to existing tax sub groups in the Tax
Group/Sub Groups Details page for sub groups used for Tax Sales (Details) and Tax Purchase
(Details) reports (Tax groups “KRS” and “KRZ” according to STD-PL company template).

If required, connect new delivery types in the same tab.

® > Financials > Tax Ledger > Basic Data > Tax Group £

sortby v
TaX Gl’oup KRS - Classification of Items in Sales Register ¥
KOO -
& + 4 0} B v
Descri... Classification of reversed charg...
KRS
Descrip... Classification of ltems in Sale. ax Group 1D Description o Grou
KRS Classification of Items in Sales Register
KRZ
Sub Groups

Descri...  Classification of ltems in Purch...

Sub Group Details

Delivery Type

p Selection Base

KUE
Descript... Classification for VAT-UE Dedl.. = B~ || +]7
Currency Code ¥ Sub Group ¥  Tax Code: MPR;23% ~ [] More ¥ © Favorites Clear Q ! Setrngs
| i CurrencyCode | Sub Group Tax Code Delivary Type Delivery Type Exceptions
: | PN SPRZ-KRAJ-22 - Domestic Sales, VAT 22% and 23% 23%, domesti ZLE-DLUGI-VAT-MINUS, ZLE-DLUGI-VAT-PLUS
i PN SPRZ-KRAJ-22-AB3A-U1 - Domestic Sales, VAT 2% and 23 2 23%, domesti... | ZLE-DLUGI-VAT-MINUS...
i PLN SPRZ-KRAJ-22-A839A-U4 - Domestic Sales, VAT 22% and 23 23 - VAT 23%, domesti...  ZLE-DLUGI-VAT-PLUS - ...

3.3.4 DEFINE AUDIT FILE BASIC DATA

3.3.4.1 Enter Audit Format for Poland

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:

e Country as “Poland”
e Report Type as “SAF-T”
[ ]

Audit Files page.

If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed
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3.3.4.2 Enter Audit File Basic Data

Click Audit File Basic Data command to open the Audit File Basic Data page.

- . ~
® > Accounting Rules » Audit Interface » Basic Data » Audit Formats g~

Audit Formats

v B v - s ® o 2 v Audit File Basic Data Audit File Tax Information Audit File Log

. Thousands Megative  Leading
‘lJ Country Report Type  Decimal Symbol  Seperator Format Zeroes Time Format Date Format File Type File Template ID Default
i | POLAND SAFT {point) , lcomma) 39 09 13:59 YY-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.

The new tab SAF-T Poland Setup includes ten sections. For SAF-T V7M report, following sections
are applicable.

® > AccountingRules > AuditInterface > Basic Data > Audit Formats > Audit File Basic Data & Company  Polish company
Audit File Basic Data
/7 @
HEADER STANDARD AUDIT CODE MAPPINGS <« »
7 0]
General Info
Tax Office ID Address ID
0202 v Al -
Misc Parameters
Person ID Invoice Series for SAD
MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

General Info section
e Tax Office ID — Select from list of values; only values from legal list will be accepted by tax
office.

Misc Parameters section

e Person ID — Enter person ID; on list of values there are only persons connected to given
company; The e-mail address and the phone number defined for specified person will be
reported in SAF-T V7M XML file.

e Invoice Series for SAD — Enter invoice series from list of values — to be used for customs
documents registration. When SAF-T V7M XML file is created and invoices with series
entered in the Invoice Series for SAD field exist, it is validated if there are any references
in the Ref Invoice No and Ref Supplier ID fields in the Supplier Invoice Details/General
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tab. If supplier is different from the one on the invoice, XML file will contain mixed data from
two invoices. In particular supplier data will be fetched from the referred invoice. If supplier is
the same or Ref Invoice No is empty — only data from basic invoice will be reported in XML
file.

Voucher/Delivery Types for Document Types (JPK_V7M) section

WEW - Enter voucher type used in order to follow internal documents.

Sales/RO - Enter voucher type used in order to follow internal summary documents
containing sales from cash registers.

Sales/FP - Enter delivery type used in order to follow invoices issued on the base of fiscal
receipt.

Purchase/MK - Enter delivery type used in order to follow invoices from small suppliers who
selected cash method for VAT.

Delivery Types for Goods and Services (JPK_V7M) section

GTU_O01 - Enter delivery type used in order to follow deliveries of alcoholic beverages.
GTU_02 - Enter delivery type used in order to follow deliveries of petroleum products.
GTU_03 - Enter delivery type used in order to follow deliveries of heating oil and other oil
products.

GTU_04 - Enter delivery type used in order to follow deliveries of tobacco products.
GTU_05 - Enter delivery type used in order to follow deliveries of waste.

GTU_06 - Enter delivery type used in order to follow deliveries of electronic devices.
GTU_O07 - Enter delivery type used in order to follow deliveries of vehicles and car parts.
GTU_08 - Enter delivery type used in order to follow deliveries of precious metals and base
metals.

GTU_09 - Enter delivery type used in order to follow deliveries of medicines and medical
devices.

GTU_10 - Enter delivery type used in order to follow deliveries of buildings and lands.
GTU_11 - Enter delivery type used in order to follow services in the scope of transferring the
right to emit greenhouse gas.

GTU_12 - Enter delivery type used in order to follow selected intangible services.

GTU_13 - Enter delivery type used in order to follow transport and storage services.

Delivery Types/Customer Groups for Specific Procedures section

(V7M) WSTO_EE - Enter delivery type used in order to follow distance EU delivery of goods
and provision of telecommunication services, broadcasting and electronic services.

(V7M) IED - Enter delivery type used in order to follow delivery of goods to EU consumers
where taxpayer enables electronic platform to non EU taxpayer and does not use OSS or
IOSS procedures.

(V7M) TP - Enter customer group used in order to follow connections between seller and
buyer.

(V7M) MR_T/(FA) P_106E_2 - Enter delivery type used in order to follow invoices for tourism
services.

(V7M) MR_UZ/(FA) P_106E_3 - Enter delivery type used in order to follow invoices for
secondhand goods and work of art.

(V7M) 1_42 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 42.

(V7M) |I_63 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 63.

(V7M) B_SPV - Enter delivery type used in order to follow transfer of a single-purpose
voucher made by a taxpayer acting in his own name.
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(V7M) B_SPV_DOSTAWA - Enter delivery type used in order to follow supply of goods and
provision of services to which the single-purpose voucher relates to a taxable person who
issued the voucher.

(V7M) B_MPV_PROWIZJA - Enter delivery type used in order to follow provision of brokering
services and other services related to the transfer of multi-purpose voucher.

(V7M) K_14/(VAT) K_14 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_14> tag in the SAF-T V7M XML file.

(V7M) K_35/(VAT) K_38 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_35> tag in the SAF-T V7M XML file.

(V7M) K_36/(VAT) K_39 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_36> tag in the SAF-T V7M XML file.

CHANGE TO MANUAL FIELDS IN JPK_V7M REPORT

Using IFS Cloud standard functionality, update values in the Automatic Tax Proposal/Template
Field Presentation/Modify Manual Fields as presented below.

[ ] Financials > Tax Ledger » Automatic Tax Proposal > Tax Proposal - Template Field Presentation & Company  Palish company

18

Created Simulated
—

Tax Proposal - Template Field Presentation is-zozoipcvma ~ 1ori

® V)
g2 v v

Description: 2022-01 JPK_V7M(2)

ax Proposal Creation Date D
18 -2022-01 JPK_V7M(2) MABEPL
Tax Report Tax Template
JPK_V7M2 - JPK_V7M2 S106 - Tax Sum VAT-7/22 Poland (Data for |PK_V7M(2) reporting, from..

Field Presentation 1

i= W e v Edit Manual Fields 24 2=z R

Field #1 Visible in

Template Field #1 Report Field Field #1 Value
VAT_ZWROT_BEZP - P_54 Wysokos¢ nadwyzki podatku naliczonego nad naleznym do zwrotu na rachunek wskazany przez poc  P_54 0.00
WYBOR_ZWROT_VAT_15 - P_540 Zwrot na rachunek rozliczeniowy podatnika w terminie 15 dni: 1 - tak P_540 -1.00
WYBOR_ZWROT_NA_RACH_VAT - P_55 Zwrot na rachunek VAT podatnika w terminie 25 dni: 1 - tak P_55 -1.00
WYBOR_ZWROT_VAT_25 - P_56 Zwrat na rachunek rozliczeniowy podatnika w terminie 25 dni (art. 87 ust. 6 ustawy): 1 - tak P_56 -1.00
WYBOR_ZWROT_VAT_40 - P_560 Zwrot na rachunek rozliczeniowy podatnika w terminie 40 dni: 1 - tak P_560 -1.00
WYBOR_ZWROT_VAT_60 - P_57 Zwrot na rachunek rozliczeniowy podatnika w terminie 60 dni: 1 - tak P_57 -1.00

For an example, P_63 and P_64 manual fields should be edited as “1” if any invoices for tourism
services or secondhand goods and work of arts exist in the reporting period respectively.

3.3.6

CREATE SAF-T V7M XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML

file.

On Task Options in Audit Interface Assistant page, select one of the below options.

Start Now: This option enables user to instantly create an audit file.

Schedule: This option enables user to create an audit output file as a background job. (Refer
IFS Cloud Documentation for more details).
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Specify the following and Click Next:
e Company: The company you want to generate SAF-T V7M file.
e Country: “Poland”
e Report Type: “SAF-T” - the value will be prompted per default Audit Formats settings for
Poland.

e Audit Type: “UPK_V7M (2)"

e Period From and Period Until: The year and month range to be covered in SAF-T V7M report.
e File Type: Select JPK_V7M2 structure from list of values.

o File Template: Will show up automatically after File Type is specified.

Audit Interface Assistant

.— Task Options —O— SAF-T PL Additional Parameters w Schedule Schedule Options

Start Option

(@) Start now

(D) schedule
Parameters
Company Country Report Type
MABEPL-PL - Polish company ¥ | | POLAND ¥ | |SAF-T -
Audit Type Audit Source Ledger ID

JPK_VTM(2) -

File Type File Template

JPK_V7TM2 ¥ | [ JPK_VTM2_TEMPLATE -

Selection

Period/Date Range From Unt

() Date 2022 1 2022 1
'i Period

b Next Cancel

On SAF-T PL Additional Parameters in Audit Interface Assistant page specify the Tax Proposal
ID, the VAT-7 proposal ID that was created for the period. Use the list of values to search for the
correct proposal. Click Finish button to generate the SAF-T V7M XML file. The file will be named as
<Audit Type>_ <Time stamp(yyyymmddhhmmss)>.XML

e.g. JPK_V7M2_20220712162006.XML

Audit Interface Assistant

O— Task Options —.— SAF-T PL Additional Parameters == Schedule Schedule Options
3-V/M -
4 Previous Finish Cancel

3.3.6.1 Reporting of Bad Debt Corrections for Tax Disbursed
Use IFS Cloud standard functionality of manual voucher to register tax amount correction in
connection to bad debts for domestic sales.
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o If tax dishursed is to be decreased, use tax code and delivery type connected to subgroup
SPRZ-KRAJ-22-A89A-Ul, SPRZ-KRAJ-7-A89A-Ul or SPRZ-KRAJ-3-A89A-U1 in the Tax
Group/Subgroup Details page (tax code 5, 8 or 23 and delivery type ZLE-DLUGI-VAT-
MINUS, according to default setup).

o If tax disbursed is to be increased, use tax code and delivery type connected to subgroup
SPRZ-KRAJ-22-A89A-U4, SPRZ-KRAJ-7-A89A-U4 or SPRZ-KRAJ-3-A89A-U4 in the Tax
Group/Subgroup Details page (tax code 5, 8 or 23 and delivery type ZLE-DLUGI-VAT-
PLUS, according to default setup).

e In the New Voucher page, register manual voucher to correct tax amount. Enter series of
original invoice in the Reference Series field and use list of values to select number of
original invoices in the Reference Number field.

In case tax disbursed is decreased, <TerminPlatnosci> tag (due date) is automatically set to date
from the Current Due Date field of the first invoice installment. If other date should be reported in
the <TerminPlatnosci> tag, use the Text field in the New Voucher/Voucher Postings section to enter
required date.

In case tax disbursed is increased, <DataZaplaty> tag (payment date) is automatically set to latest
payment date (within the reported period) for the invoice. If other date should be reported in the
<DataZaplaty> tag, use the Text field in the New Voucher/Voucher Postings section to enter required
date.

The text can have the following format ‘<any text>: YYYY-MM-DD’. For example
o ‘Korekta z tytutu faktury z terminem ptatnosci: 2022-01-01’
‘Korekta z tytutu faktury zaptaconej: 2022-01-01’

3.3.7 CREATE SAF-T V7M XML CORRECTION FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML
correction file.

On page 1/3 and 2/3, select the same information as when generating the ordinary file. On page 3/3
specify the proposal identity of VAT-7 correction report and continue in the same way as when
generating the ordinary file. The new XML file will be created. The XML tag <CelZlozenia> will
indicate a correction file with value 2 as follows,

<CelZlozenia poz="P_7">2</CelZlozenia>

If only information in manual fields of VAT-7 was changed comparing to the previous report
e <Deklaracja> block is created in the XML file.
e <Ewidencja> block is not created in the XML file.

If only transaction related information was changed/added comparing to the previous report with no
impact on total amounts in VAT-7
e <Deklaracja> block is not created in the XML file.
e <Ewidencja> block is created in the XML file and contains final information from all
documents.
e For each document changed comparing to the original report, <Ewidencja> block additionally
contains.
o Original information about the document
o Reversal information about the document (with reversed signs in the amount fields)

If both transaction related information is changed and VAT-7 information is changed
e <Deklaracja> block is created in the XML file.
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<Ewidencja> block is created in the XML file and contains final information from all
documents.
For each document changed comparing to the original report, <Ewidencja> block additionally
contains.

o Original information about the document

o Reversal information about the document (with reversed signs in the amount fields)

DELIMITATION

JPK_V7K (quarterly variant of JPK_V7M for small companies) is not supported.

Reporting of fiscal registers and invoices based on fiscal registers is not supported.

In case of correction instant invoices for which debit lines are not required, standard
functionality allows to set quantity to 0 (as for CO invoices) or remove the debit lines
completely. Scenario in which debit lines are removed is not supported by JPK_V7M.

3.4 SAF-T For Poland — VAT Report from October 2020 until December 2021
(JPK_V7M (1))

3.4.1

SOLUTION — SAF-T PLV7M

The solution is based on IFS Cloud standard functionality of tax reporting including tax transactions
and the corresponding tax proposal and audit interface functionality.

In order to support the requirement for the SAF-T PL V7M report, the following has been done:

6.
7.

8.

10.

New report type SAF-T added to the Audit Formats page.

In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

In Audit Interface Assistant page 2/3, new Audit Type field has been added to select relevant
SAF-T report. In page 3/3 additional Proposal ID field specific for the SAF-T V7M has been
added.

New external file type and new external file template were added to support SAF-T V7M.
List of values is added for the Reference Number column for vouchers of function group M
to have additional invoice information in tax transactions.
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Process Overview:

« Define Tax Office (Standard functionality)
« Define Person E-Mail and Phone Communication Methods (Standard functionality)
« Define Customer Groups, Tax Codes, Voucher Types, Delivery Types (Standard functionality)
I Nel o1 * Define Tax Sub Group Details (Standard functionality)
Basic Data

« Enter Audit File Basic Data: Tax Office ID, Person ID, Invoice Series for SAD, Customer Groups, Tax Codes, Vouche

Types, Delivery Types used to follow specific transactions
Define Audit File » v P P

Basic Data

< Enter Audit Format for Poland J
r

« Enter transactions in accordance with IFS Cloud standard functionality
« Update vouchers to General Ledger
U[CECNelBER == © Fetch tax transaction details to Tax Ledger

Tax Ledger
Transactions

« Select tax transactions for Tax Disbursed of the reporting period

Create Tax Sales
S021

Create Tax Purchase
S022

« Calculate the subtotals and totals of Tax to pay or Tax to return

Create Tax Summary
Report S098

* Run Audit Interface Assistant

« Select country as Poland

« Enter report type SAF-T and audit type JPK_V7M(1)

(OIS R4 - Select file type JPK_V7M, template, date / period range and VAT-7 Proposal ID
XML File

« Select tax transactions for Tax Received of the reporting period J
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e The company must be set-up to use Polish localization, see the Company Set up chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and
enabled by default.

e Itis recommended to create the company using Standard Polish Template (STD-PL).

3.4.3

3.4.3.1

DEFINE COMPANY BASIC DATA

Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define Tax
Office for Poland — one from the list published on tax authority’s website. For example
‘02027, “10107, “3030” ...

® > Application Base Setup » Enterprise > Tax

Search  advancec
Tax Office = Name:PL% ~ @ Creation Date ~ Mare * 2 Favorites
sortoy v -
Tax Office ox2-pLraxofficenan
0202 .
« T & (i ® 8B
Name: PL Tax Office Dan
Address Tax Office
Communication Method 0202
Tax Report Name

Tax Office >~

PL Tax Office Dan

Clear Q i Semings

1of1

Default Language
English
Country
POLAND
Creation Date

8/4/2020

€]

On the Tax Report sub menu, enter the Company and Tax ID Number. Connect the VAT-7 report
used as a base for SAF-T V7M report in the child table.

sortoy v

® > Application Base Setup » Enterprise
VAT PL

Name: VAT PL

Address

Communication Method

Tax Report §

. . . ~
ax » Tax Office » Tax Report &

Tax Report VATPL-VATPL ¥ 1of1

& B v

Tax Office

VAT PL

Company: AMKA-PLN - AMKA-PLN ™

a + 4 @m B
Company Tax ID Number
AMKA-PLN 202001

State Name

warminsko-mazurskie

Tax Report Info

VAT PL
Our Identity Electronic Tax
varplo1 varplo1

1D State Code
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3.4.3.2 Define Person E-Mail and Phone Communication Methods

Open the Application Base Setup/Enterprise/Person/Person page General sub menu define
Person ID of person responsible for JPK_V7M reporting. On the Communication Method sub menu
enter E-Mail Communication Method and Phone Communication Method. Select the Default per
Method check box for both methods.

® 5 Application Base Setup > Emerprise > Pers

sortby v

0 AMKALK

Full Name: Amaya Karunaratne
User ID: AMKALK

Address
Communication Method §

Documnents

ans Parson

Communication Method =2

Communication Method AMKALK - Amaya Karunaratne ¥  1of 1

Full Name

Amaya Karunaratne

Communication

Comm D Name Description Method

1 amaya E-Mail

2 amaya Phone

3.4.3.3 Define Customer Groups

User ID Validity

AMKALK

Default

per

Method

and

Address  Validity Period

Default

per
Value Method |Address ID
amaya@amkapln.com

4443553535354

Using IFS Cloud standard functionality, define separate customer groups used in order to follow
connections between seller and buyer ((V7M) TP field).

Financials * Customer Invoice > Basic Data » Customer Groups

=
L=

Customer Groups

= W [ + &
Use
Collective Default No of
- i | Customer Group Description Voucher Invoice Copies
| HE Domestic Associated Unit m 1 |
N Domestic Mot Associated Unit m 1
| |2 Foreign Associated Unit m 1 |
: 3 Foreign Not Associated Unit m 1
4 Internal Unit m 1

Note: In brackets you can find the name of the field where the value should be connected in the

Audit File Basic

Data/SAF-T Poland Setup tab.

3.4.3.4 Define Tax Codes

Using IFS Cloud standard functionality, define separate tax code used in order to follow invoices
which are a subject to the mandatory split payment mechanism ((V7M) MPP/(FA) P_18A field).
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® > Accounting Rules > Tax > Tax Codes
Search  agvances
Tax Code: MPP ~ @ Description ¥ Tax (%) * More * © Favorites Clear
Tax Codes
= ¥V B + 4
Tax
~ i |TaxCode  Description Tax Type (%)  Deductible (%)
MPP VAT 23%, Mandatory Spli - Tax 23 100

>\.\\\|r//
- Z
7N

IFS

company [ Dan Poland

Q Settings
H
Tax Amount
Limit in
Tax Method Tax  Tax Methed Tax  Tax Amount at Invoice Accounting
Valid From Valid To Received Disbursed Printout Currency
1/1/2020 12/31/2049 Invoice Entry Invoice Entry  Separate from Price

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.4.3.5 Define Voucher Types

Using IFS Cloud standard functionality, define separate voucher types used in order to follow

e internal documents (WEW field)

¢ internal summary documents containing sales from cash registers (Sales/RO field).

@ > Accounting Rules > User Related Data > Voucher Type i

sorthy v

WEW

& 7 m B2~ New Voucher Type
Descripti..  Internal Documents...
Des n
nternal Documents PL
Ledger Selection
Ledger Type Ledger ID
GL, Affect IL
Use Manual Internal Methods
Function Group Information
=V Bv |2
Optional
Auto Store
i Function Group Balance

¢ M- Manual vouchers

Voucher Type WEW - Internal Documents PL ¥ 10f1

Voucher Series

Woucher
RowGroup Reference  Allotment  Group
Original  Validation ~ Mandatory Required

Excluded From IL Translation

Parameter Selection

Automatic Allotment

Single
Automatic  Function

Required

company [ Dan Poland

3

Single Function Group

rate User Approval

]
<

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.4.3.6 Define Delivery Types

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

e invoices issued on the base of fiscal receipt (Sales/FP field)

¢ invoices from small suppliers who selected cash method for VAT (Purchase/MK field).
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® > Financials > Customer Invoice > Basic Data > Delivery Types e Company
Search  advanced &
Delivery Type - MK ~ @ Description ¥  Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q i Setings
Delivery Types
] + & =~
Include in
Inveice
i Delivery Type Description Enclosure  Invoice Enclosure Series ID
MK Invoices from small suppliers who selected cash method for VAT m

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:
e deliveries of alcoholic beverages (GTU_OL1 field)

deliveries of petroleum products (GTU_02 field)

deliveries of heating oil and other oil products (GTU_03 field)

deliveries of tobacco products (GTU_04 field)

deliveries of waste (GTU_O05 field)

deliveries of electronic devices (GTU_06 field)

deliveries of vehicles and car parts (GTU_07 field)

deliveries of precious metals and base metals (GTU_08 field)

deliveries of medicines and medical devices (GTU_09 field)

deliveries of buildings and lands (GTU_10 field)

services in the scope of transferring the right to emit greenhouse gas (GTU_11 field)

selected intangible services (GTU_12 field)

transport and storage services (GTU_13 field).

L ] Financials > Customer Invoice > Basic Data > Delivery Types E:f Company | Dan Poland
Search  advanced R

Delivery Type : GTU% ~ @ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q i Semings
Delivery Types

i1 + &

I
<

Include in

Invoice
I Delivery Type Description Enclosure  Invoice Enclosure Series ID
1 GTUO Deliveries of alcoholic beverages
t GTU_02 Deliveries of petroleum products

OETU03 Deliveries of heating oil and other oil products

i GTU_D4 Deliveries of tobacco products

: GTU_05 Deliveries of waste

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

mail orders ((V7M) SW field)

telecommunication services, broadcasting and electronic services ((V7M) EE field)

invoices for tourism services ((V7M) MR_T/(FA) P_106E_2 field)

invoices for secondhand goods and work of art (V7M) MR_UZ/(FA) P_106E_3 field)

EU delivery after import based on import procedure 42 ((V7M) |_42 field)

EU delivery after import based on import procedure 63 ((V7M) |_63 field)

transfer of a single-purpose voucher made by a taxpayer acting in his own name ((V7M)

B_SPV field)

e supply of goods and provision of services to which the single-purpose voucher relates to a
taxable person who issued the voucher ((V7M) B_SPV_DOSTAWA field)
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e provision of brokering services and other services related to the transfer of multi-purpose
voucher ((V7M) B_MPV_PROWIZJA field).

[ ] Financials > Customer Invoice > Basic Data > Delivery Types 23' Company
Search  advancec bl
Delivery Type : %SW%;%EE% ~ €@ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q. i Semings
Delivery Types
= W AR + e = v
Include in
Invoice
Delivery Type Description Enclosure  Invoice Enclosure Series ID
EE Telecommunications services, broadcasting and electronic services m
sw Mail Orders m

Using IFS Cloud standard functionality, define separate delivery types by which:
e transaction value is retrieved and reported in the <K_14> tag ((V7M) K_14/(VAT) K_14 field)
e transaction value is retrieved and reported in the <K_35> tag ((V7M) K_35/(VAT) K_38 field)
e transaction value is retrieved and reported in the <K_36> tag ((V7M) K_36/(VAT) K_39 field).

® > Financials > Customer Invoice > Basic Data > Delivery Types Company
Search  advanced
Delivery Type - K% ~ @  Description ¥  Include in Invoice Enclosure *  More * © Favorites  Clear Q, I Sedings
Delivery Types
= W B + =~
Include in
Invoice
Delivery Type Description Enclosure  Invoice Enclosure Series 1D
K 36 K_36 (Tax Template Feld VAT _WNT_PAL SIL) =T
K14 K_14 (Tax Template field ART_129_UST) m
K_35 K_35 (Tax Template field VAT_NALEZ_WNT_TRANSP) W

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.
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3.4.3.7 Define Tax Sub Group Details

Using IFS Cloud standard functionality, connect new tax codes to existing tax sub groups in the Tax
Group/Sub Groups Details page for sub groups used for Tax Sales (Details) and Tax Purchase
(Details) reports (Tax groups “KRS” and “KRZ” according to STD-PL company template).

If required, connect new delivery types in the same tab.

® > Financials > Tax Ledger > Basic Data » Tax Group £

sortby  w
TaX Group KRS - Classification of Items in Sales Register ¥
KOO =
« + 7 I B v
Descri... Classification of reversed charg...
KRS
Tax Group ID Description Tax Group Selection Base
Descrip... Classification of Items in Sale..
KRS Classification of Items in Sales Register Delivery Type -
KRZ
T M . Sub Groups
Descri..  Classification of ltems in Purch...
Sub Group Details
KUE

Descript... Classification for VAT-UE Decl.. LI s e

Currency Code ¥ SubGroup ¥  TaxCode:MPPR23% ¥ @ More ¥ © Favorites Clear Q i Serrings

~ 1 CurencyCode  SubGroup Tax Code Delivery Type Delivery Type Exceptions

: | PN SPRZ-KRAJ-22 - Domestic Sales, VAT 22% and 23% esti % ZLE-DLUGI-VAT-MINUS, ZLE-DLUGI-VAT-PLUS

i PN SPRZ-KRAJ-22-AB3A-U1 - Domestic Sales, VAT 22% and 23 esti... | ZLE-DLUGI-VAT-MINUS...

i |PIN SPRZ-KRAJ-22-A89A-U4 - Domestic Sales, VAT 22% and 23 23 - V) esti.. | ZLE-DLUGI-VAT-PLUS - ...

3.4.4 DEFINE AUDIT FILE BASIC DATA

3.4.4.1 Enter Audit Format for Poland

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:
e Country as “Poland”
e Report Type as “SAF-T”
e [f the audit file is run on batch mode, the XML can be downloaded from the Batch Processed
Audit Files page.

3.4.4.2 Enter Audit File Basic Data

Click Audit File Basic Data command to open the Audit File Basic Data page.

- . ~
® > Accounting Rules > Audit Interface > Basic Data > Audit Formats &

Audit Formats

Voo v + & ] o} B v Audit File Basic Data Audit File Tax Information Audit File Log

Thousands Negatve  Leading

L Country Report Type Decimal Symbol | Seperator Format Zeroes Time Format Date Format File Type File Template ID Default
i | POLAND SAFT -{paint) , lcomma) 9 09 13:59 YY-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.

The new tab SAF-T Poland Setup includes ten sections. For SAF-T V7M report, following sections
are applicable.
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Accounting Rules > Audit Interface > Basic Data > Audit Formats> Audit File Basic Data & Company Polish company

Audit File Basic Data

4

HEADER

7 o}
General Info
Tax Office ID Addr

0202 v Al v
Misc Parameters

MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) N
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

]

STANDARD AUDIT CODE MAPPINGS EETURRJe]RUPES:358) 4 4 »

General Info section

Tax Office ID — Select from list of values; only values from legal list will be accepted by tax
office.

Misc Parameters section

Person ID — Enter person ID; on list of values there are only persons connected to given
company; The e-mail address and the phone number defined for specified person will be
reported in SAF-T V7M XML file.

Invoice Series for SAD — Enter invoice series from list of values — to be used for customs
documents registration. When SAF-T V7M XML file is created and invoices with series
entered in the Invoice Series for SAD field exist, it is validated if there are any references
in the Ref Invoice No and Ref Supplier ID fields in the Supplier Invoice Details/General
tab. If supplier is different from the one on the invoice, XML file will contain mixed data from
two invoices. In particular supplier data will be fetched from the referred invoice. If supplier is
the same or Ref Invoice No is empty — only data from basic invoice will be reported in XML
file.

Voucher/Delivery Types for Document Types (JPK_V7M) section

WEW - Enter voucher type used in order to follow internal documents.

Sales/RO - Enter voucher type used in order to follow internal summary documents
containing sales from cash registers.

Sales/FP - Enter delivery type used in order to follow invoices issued on the base of fiscal
receipt.

Purchase/MK - Enter delivery type used in order to follow invoices from small suppliers who
selected cash method for VAT.

Delivery Types for Goods and Services (JPK_V7M) section

GTU_O01 - Enter delivery type used in order to follow deliveries of alcoholic beverages.
GTU_02 - Enter delivery type used in order to follow deliveries of petroleum products.
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GTU_03 - Enter delivery type used in order to follow deliveries of heating oil and other oil
products.

GTU_04 - Enter delivery type used in order to follow deliveries of tobacco products.
GTU_05 - Enter delivery type used in order to follow deliveries of waste.

GTU_06 - Enter delivery type used in order to follow deliveries of electronic devices.
GTU_07 - Enter delivery type used in order to follow deliveries of vehicles and car parts.
GTU_08 - Enter delivery type used in order to follow deliveries of precious metals and base
metals.

GTU_09 - Enter delivery type used in order to follow deliveries of medicines and medical
devices.

GTU_10 - Enter delivery type used in order to follow deliveries of buildings and lands.
GTU_11 - Enter delivery type used in order to follow services in the scope of transferring the
right to emit greenhouse gas.

GTU_12 - Enter delivery type used in order to follow selected intangible services.

GTU_13 - Enter delivery type used in order to follow transport and storage services.

Delivery Types/Customer Groups for Specific Procedures section

(V7M) TP - Enter customer group used in order to follow connections between seller and
buyer.

(V7M) MR_T/(FA) P_106E_2 - Enter delivery type used in order to follow invoices for tourism
services.

(V7IM) MR_UZ/(FA) P_106E_3 - Enter delivery type used in order to follow invoices for
secondhand goods and work of art.

(V7M) I_42 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 42.

(V7M) |_63 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 63.

(V7M) B_SPV - Enter delivery type used in order to follow transfer of a single-purpose
voucher made by a taxpayer acting in his own name.

(V7M) B_SPV_DOSTAWA - Enter delivery type used in order to follow supply of goods and
provision of services to which the single-purpose voucher relates to a taxable person who
issued the voucher.

(V7M) B_MPV_PROWIZJA - Enter delivery type used in order to follow provision of brokering
services and other services related to the transfer of multi-purpose voucher.

(V7M) K_14/(VAT) K_14 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_14> tag in the SAF-T V7M XML file.

(V7M) K_35/(VAT) K_38 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_35> tag in the SAF-T V7M XML file.

(V7M) K_36/(VAT) K_39 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_36> tag in the SAF-T V7M XML file.

(V7M) SW - Enter delivery type used in order to follow mail orders.

(V7M) EE - Enter delivery type used in order to follow telecommunication services,
broadcasting and electronic services.

Tax Codes for Specific Procedures section

(V7M) MPP/(FA) P_18A - Enter tax code used in order to follow invoices which are a subject
to the mandatory split payment mechanism.
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3.45 CHANGE TO MANUAL FIELDS IN JPK_V7M REPORT

Using IFS Cloud standard functionality, update values in the Automatic Tax Proposal/Template Field
Presentation/Modify Manual Fields as presented below.

@ > Financials > Tax Ledger > Automatic Tax Proposal » Tax Proposal - Template Field Presentation &> company [ AMKA-PLN
sartoy - - -
"~ Tax Proposal - Template Field Presentation ».vmzzs ~ 1o O —
25
« B v

Description: v7m 2021/6

User ID
@ AMKALK

5098 - Tax Sum VAT-7/21 Poland (Data for JPK_V7M reporting)

B v i
Field #1 Visible
H Template Field #1 in Report Field Field #1 Value
i | VAT ZWROT_BEZP - P_54 Wysokosé nadwyzki podatku naliczoneg  P_54 0.00
| WYBOR_ZWROT_NA_RACH_VAT - P_55 Zwrot na rachunek VAT, o | P_55 -1.00
i WYBOR_ZWROT_VAT_25 - P_56 Zwrot w tarminie, o kedrym mowa  P_56 -1.00
i | WYBOR_ZWROT_VAT_60 - P_57 Zwrot w terminie, o kiérym mowa  P_57 -1.00
i WYBOR_ZWROT_VAT_180 - P_58 Zwrot w terminie, @ ktorym mow  P_58 -1.00
| WYBOR_ZWROT_PRZYSZ_ZOB_VAT - P_59 Zaliczenie zwrotu podat P_59 -1.00
| VAT_PRZENIES - P_62 Wysokost nacwyzki podatku naliczonego n:  P_62 0.00
| WYBOR_ART_119_USTAWY - P_63 Podatnik wykonywat w okresie | P_63 -1.00
| WYBOR_ART_120_USTAWY_UST_4_5 - P_64 Podatnik wykonywat v P_64 -1.00
| WYBOR_ART_122_USTAWY - P_65 Podatnik wykonywat w okresie | P_65 -1.00

For an example, P_63 and P_64 manual fields should be edited as “1” if any invoices for tourism
services or secondhand goods and work of arts exist in the reporting period respectively.

3.4.6 CREATE SAF-T V7M XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML
file.

On Task Options in Audit Interface Assistant page, select one of the below options:
Start Now: This option enables user to instantly create an audit file.

Schedule: This option enables user to create an audit output file as a background job. (Refer
IFS Cloud Documentation for more details).

Specify the following and Click Next:
o Company: The company you want to generate SAF-T V7M file.
e Country: “Poland”

e Report Type: “SAF-T” - the value will be prompted per default Audit Formats settings for
Poland.

Audit Type: “‘UPK_V7M (1)”

Period From and Period Until: The year and month range to be covered in SAF-T V7M report.
File Type: Select JPK_V7M structure from list of values.

File Template: Will show up automatically after File Type is specified.
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[ ] Accounting Rules » Auditinterface » Audit Interface Assistant Company  Polish company

Audit Interface Assistant

.— Task Options —O— SAF-T PL Additional Parameters wm Schedule Schedule Options

Start Option

(@ start now

() schedule
Parameters
Company Country Report Type
MABEPL-PL - Polish company ¥ | POLAND ¥ | | SAF-T -
Audit Type Audit Source Ledger ID

JPK_VTM(T) -
File Type File Template

JPK_VTM - | | JPK_V7M_TEMPLATE -
Selection

Period/Date Range From Unt

() Date 2021 1 2021 1
" Period

b Mext Cancel

On SAF-T PL Additional Parameters in Audit Interface Assistant page specify the Tax Proposal
ID, the VAT-7 proposal ID that was created for the period. Use the list of values to search for the
correct proposal. Click Finish button to generate the SAF-T V7M XML file. The file will be named as
<Audit Type without brackets> <Time stamp(yyyymmddhhmmss)>. XML

e.g., JPK_V7M1_20200712162006.XML

@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

O— Task Options —.— SAF-T PL Additional Parameters w= Schedule Schedule Options
3-V7IM -
4 Previous Finish Cancel

3.4.7 CREATE SAF-T V7M XML CORRECTION FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML
correction file.

On page 1/3 and 2/3, select the same information as when generating the ordinary file. On page 3/3
specify the proposal identity of VAT-7 correction report and continue in the same way as when
generating the ordinary file. The new XML file will be created. The XML tag <CelZlozenia> will
indicate a correction file with value 2 as follows,

<CelZlozenia poz="P_7">2</CelZlozenia>

If only information in manual fields of VAT-7 was changed comparing to the previous report
e <Deklaracja> block is created in the XML file.

Country Solution POLAND 49



N\,
';

N

IFS

Il‘ ! h\\\

e <Ewidencja> block is not created in the XML file.

If only transaction related information was changed/added comparing to the previous report with no
impact on total amounts in VAT-7
e <Deklaracja> block is not created in the XML file.
e <Ewidencja> block is created in the XML file and contains final information from all
documents.
e For each document changed comparing to the original report, <Ewidencja> block additionally
contains:
o Original information about the document
o Reversal information about the document (with reversed signs in the amount fields)

If both transaction related information is changed and VAT-7 information is changed
e <Deklaracja> block is created in the XML file.
e <Ewidencja> block is created in the XML file and contains final information from all
documents.
¢ For each document changed comparing to the original report, <Ewidencja> block additionally
contains:
o Original information about the document
o Reversal information about the document (with reversed signs in the amount fields)

3.4.8 DELIMITATIONS

¢ JPK V7K (quarterly variant of JPK_V7M for small companies) is not supported.

o Reporting of fiscal registers and invoices based on fiscal registers is not supported.

e In case of correction instant invoices for which debit lines are not required, standard
functionality allows to set quantity to 0 (as for CO invoices) or remove the debit lines
completely. Scenario in which debit lines are removed is not supported by JPK_V7M.

3.5 SAF-T For Poland — VAT Report until September 2020 (JPK_VAT)

3.5.1 SOLUTION — SAF-T PL VAT

The solution is based on IFS Cloud standard functionality of tax reporting including tax transactions
and the corresponding tax proposal and audit interface functionality.

Since 2018 a new schema for this report has been introduced, thus in this document the latest
version, named JPK_VAT3, will be described.

In order to support the requirement for the SAF-T PL VAT report, the following has been done:

1. New report type SAF-T added to the Audit Formats page.

2. In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

3. On Task Options in Audit Interface Assistant page, new Audit Type field has been added
to select relevant SAF-T report. And SAF-T PL Additional Parameters in Audit Interface
Assistant page, Tax Proposal ID field add to specify the tax proposal ID.

4. In Audit File Log page, a new column Correction Number column has been added.

5. New external file templates were added to support specific SAF-T reports.

6. List of values is added for the Reference Number column in New Voucher page when using
the function group M, this is to add additional invoice information for tax transactions.
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Process Overview:

« Tax Office (Standard functionality
« Define Person and e-mail address (Standard functionality)

Define Company | Define delivery types (Standard functionality)

Basic Data

« Enter Audit Format for Poland

 Enter general SAF-T PL data: Tax Office ID, Person ID and Invoice Series for SAD

Define Audit File
Basic Data

« Create VAT-7 report for the company for the SAF-T VAT reporting period (Standard functionality)

Create VAT-7
report

« Enter report type SAF-T and audit type JPK_VAT

(OCEICISTV NN - Select file type JPK_VAT_3, template, date / period range and VAT-7 Proposal ID
XML File

» Compare the data of generated SAF-T VAT XML file with Poland VAT-7 report (Manual operation)
Compare SAF-T
VAT XML with
VAT-7 Report

» Manually change the values of fields K_14, K_38 and K_39 in VAT-7 report
« After doing manual changes, there should be no difference in values of SAF-T PL XML and VAT-7 report

Change Values in
VAT-7 Report

» Once all manual modifications are done in VAT-7 report, create the original SAF-T VAT XML file again.

Regenerate SAF-T
VAT XML File

* Run Audit Interface Assistant
* Select country as Poland
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Note: VAT-7 report has no direct impact on the SAF-T VAT report. However, the SAF-T VAT report
is used to verify the VAT-7 report content. An additional step to the creation of SAF-T Vat report is
added to compare the results of the two reports. If the results do not match, user need to adjust the

VAT-7 report content manually.

3.5.2 PREREQUISITES

e The company must be set-up to use Polish localization, see the Company Set up chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and

enabled by default.

o VAT-7 report should be created for the reporting period (standard functionality) before the

SAF-T VAT XML is created.

e Itis recommended to create the company using Standard Polish Template (STD-PL).

3.5.3 DEFINE COMPANY BASIC DATA

3.5.3.1 Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On the General sub menu, define
Tax Office for Poland — one from the list published on tax authority’s website. For example

‘02027, “10107, “3030” ...

® > Application Base Setup » Enterprise » Tax » Tax Office » =

Search  advanced

Tax Office * MName:PL% ~ @ Creation Date ¥ More ¥ © Favorites
sorthy v

Tax Office o202-piLax office an +
0202

MName: PL Tax Office Dan

& T & ] B B v

Address ax Office

1 0202
Communication Method

Tax Report Name

PL Tax Office Dan

1of1

Default Language
English
Country
POLAND
Creation Date

8/4/2020

: Settings

G

On the Tax Report sub menu, enter the Company, Tax ID Number and Our Identity. Our identity is
company ID for the specific tax office. Connect the VAT-7 report that should be compared with the

SAF-T VAT report in the child table.
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® > Application Base Setup > Enterprise » Tax »

sortoy

VAT PL

MName: VAT PL

Address
Communication Method

Tax Report &

Tax Office > Tax Report £

Tax Report VAT PL-VATPL ¥

1of1
« 82 v
Tax Office MName
VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ¥

Q + | # m o]

Company Tax ID Number Our Identity

AMEKA-PLN PL 2337684748 123456789

State Name

warminsko-mazurskie

Tax Report Info

= v [ v + 4

Tax Report

VAT-2020 - Vat 2020

VATM - VATTM

3.5.3.2 Define Person E-Mail Communication Method

Electronic T

varplo

_5\\\!5

ax D State Code

WN -

On Enterprise/Person/Person page General sub menu define Person ID of person responsible for
JPK_VAT3 reporting. On Communication Method tab enter E-Mail Communication Method and
select Default per Method. Enter valid dates.

@ > Application Base Setup > Enterprise > Person » Person

sortoy

Communication Methed

I
(5

Communication Method oasik-panusnkaamis ~  10r1

@ DAALLK

& B v
Full Name: Danushka Alwis
User ID: DAALLK
Address Persan
Communication Method & DAALLK

Documents

Full Name
Danushka Alwis
B~ + rd
Communication
CommID Name Description Method value
1 Dan E-Mail
2 Dan Phone

3.5.3.3 Define delivery types

User ID

DAALLK

dan@ifs.com

+48000000000

Default
per

Method  Address ID

Validity

Default

per

Method

and

Address  Validity Period

B  1/12020-9112029

Using IFS Cloud standard functionality, define separate delivery types to be reported under K_14,
K_38, K_39 fields in SAF-T VAT XML file.
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3 Company | Dan Poland

® > Financials > Customer Invoice > Basic Data > Delivery Types &
Delivery Types

=V B v +

Include in
Invoice
Delivery Type Description Enclosure  Invoice Enclosure Series ID
EE Telecommunications services, broadcasting and electronic services m
GTU_01 Deliveries of alcoholic beverages m
GTU_02 Deliveries of petroleum products m
GTU 03 Deliveries of heating oil and other oil products m
GTU_04 Deliveries of tobacco products m
GTU_05 Deliveries of waste m
K 14 K_14 (Tax Template field ART_129_UST) m
K 35 K_35 (Tax Template field VAT_NALEZ WNT TRANSP) m PW
K 36 K_36 (Tax Template Field VAT_WNT_PAL_SIL) m W
MK Invoices from small suppliers who selected cash method for VAT m

3.5.4 DEFINE AUDIT FILE BASIC DATA

3.5.4.1 Enter Audit Format for Poland

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:
o Country as “Poland”
e Report Type as “SAF-T”
e Ifthe audit file is run on batch mode, the XML can be downloaded from the Batch Processed
Audit Files page.

3.5.4.2 Enter Audit File Basic Data
Select Audit File Basic Data command to open the Audit File Basic Data page.

® > Accounting Rules > Audit Interface > Basic Data > Audit Formats <o company [ AMKA-PLN

Audit Formats

¥V oB o~ + 7/ B B 2~ Audit File Basic Data Audit File Tax Information Audit File Log I

Thousands Negative  Leading
M5 | county ReportType  Decimal Symbal | Seperatar Format  Zeroes  Time Format Date Format Fils Type File Template ID Default
i | POLAND SAF-T - (point) , (comma) -9 0.9 1359 Y¥Y-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.

The new tab: SAF-T Poland Setup includes ten sections. For SAF-T VAT report, the following
sections applicable.
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Rules > AuditInterface > BasicData > Audit Formats > Audit File Basic Data &

Audit File Basic Data

V4 0]

HEADER

7 o}
General Info
Tax Office ID Addr

0202 v Al v
Misc Parameters

MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) N
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

t Fi
STANDARD AUDIT CODE MAPPINGS EETURRJe]RUPES:358) 4 4 »

Misc Parameters section

Person ID — specify person ID; on list of values there are only persons connected to given
company; the e-mail address defined for specified person will be reported in SAF-T VAT XML
file. This field is optional.

Invoice Series for SAD — enter invoice series from list of values — to be used for customs
documents registration.

When SAF-T VAT XML is created and invoices with series entered in Invoice Series for SAD
exist, it is validated if there is any Ref Invoice No in Supplier Invoice Details/General. If the
Supplier ID is different there — in XML file lines with supplier invoices with invoice series equal
to Invoice Series for SAD, there will be mixed data from two invoices. If the Supplier ID is the
same or Ref Invoice No is empty — only data from basic invoice will be reported in XML file.

Delivery Types/Customer Groups for Specific Procedures section

3.5.5

(V7M) K_14/(VAT) K_14, (V7M) K_35/(VAT) K_38 and (V7M) K_36/(VAT) K_39 - Enter the
delivery types that should be reported under each field K_14, K 38 and K_39.
If required, you can define more than one delivery type using semicolon as a separator.

CREATE VAT-7 REPORT

Use IFS Cloud standard functionality to generate VAT-7 report for the SAF-T reporting period in the
company. More information on creating VAT-7 report is available in IFS Cloud documentation.

3.5.6

CREATE SAF-T VAT XML FILE

On Task Options in Audit Interface Assistant page, select one of the below options:

Start Now: This option enables user to instantly create an audit file.

Schedule: This option enables user to create an audit output file as a background job. (Refer
IFS Cloud Documentation for more details).
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o Company: The company you want to generate SAF-T VAT file.

e Country: “Poland”

e Report Type: “SAF-T” - the value will be prompted per default Audit Formats settings for

Poland.
Audit Type: “UPK_VAT”

® > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

.= Task Options =O

Start Option

‘Q‘ Start now
() schedule
Parameters
CCIWDEW'.-‘ Coul ntry Report T‘;.-‘DE‘
DAN POLAND - Dan Poland ~ | | POLAND v | SAF-T
Audit Type Audit Source Ledger ID
JPK_VAT -
File T‘:JDE File Template
JPK VAT 3 v | | JPK_VAT 3 TEMPLATE -
Selection
Period/Date Range From Undil
() Date 2020 8 2020
@‘ Period
1 Pre > Next Fi Cancel

Period From and Period Until: The year and month range to be covered in SAF-T V7M report.
File Type: Select JPK_VAT structure from list of values.
File Template: Will show up automatically after File Type is specified.

Company | Dan Poland

On SAF-T PL Additional Parameters, specify the Tax Proposal ID, the VAT-7 proposal ID that was
created for the period. Use the list of values to search for the correct proposal. Click Finish button to
generate the SAF-T VAT XML file. The file will be named as <Audit Type without brackets>_<Time

stamp(yyyymmddhhmmss>. XML

e.g., JPK_VAT_20170914150743.XML

@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

O= Task Options =-.= SAF-T PL Additional Parameters = Schedule

Tax Proposal ID

4-VAT -

4 Previous » Next Finish Cancel

Schedule Options
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3.5.7 COMPARE SAF-T VAT XML WITH VAT-7 REPORT

Both the SAF-T VAT and the VAT-7 reports are legal documents relating to the same business
transactions of a company and hence both reports should produce identical data once the reports
are generated.

Due to the current functionality of VAT-7 (Standard) report, it always requires some manual input
from the user to generate the report with correct values. SAF-T VAT XML file is an automatically
generated file which does not require any manual input. When generating the SAF-T VAT file, IFS
Cloud will always crosscheck the values with the corresponding data fields in VAT-7 report. If there
is a difference, IFS Cloud will trigger a warning message. These warning messages can be viewed
in the Audit File Log page.

® > Accounting Rules > Audit Interface > Basic Data > Audit Formats » Audit File Log < company
Audit File Log
IR B
FilelD:1770 ~ @ AuditType ¥ FromDate ¥ More ¥ © Favorites Clear O § Serings
File|D AuditType From Date  ToDate Timestamp Correction Number Warning Text
1770 JPK_VAT  ©/1/2019 ©/30/2019  2021-08-16-00:02:22 0 | Tax Proposal ID is not in Reported/Valid status; |

From the Audit Formats page, use the Audit File Log command to open the Audit File Log page.

® > Accounting Rules > Audt Interface > Basic Data > Audit Formats &> company | AMKA-PLN
Audit Formats
T IR + | 7 ® B B v Audit File Basic Data Audit File Tax Information Audit File Log m
nousands Neg: Leading
i | Country ReportType  Decimal Symbol  Seperator Format Zeroes  Time Format Date Format File Type File Template ID Default
: | POLAND SAFT  (point) , (comma) =) 09 13:59 ¥Y-MM-DD

3.5.8 CHANGE VALUES IN VAT-7 REPORT

Check all the warning messages displayed on Audit File Log. If there are differences related to
manual Fields in VAT-7 report, the values in VAT-7 should be manually updated with values reported
in JPK_VAT3 XML (Automatic Tax Proposal/Template Field Presentation/Modify Manual Fields).

The current functionality of VAT-7 (Standard) report assumes that summarized tax amounts to be
reported in the P_14 tag, P_35 tag and P_36 tag are specified manually by the user. On the other
hand delivery types specified in the (V7M) K_14/(VAT) K_14 field, (V7M) K_35/(VAT) K_38 field and
(V7M) K_36/(VAT) K_39 field in the SAF-T PL Parameters tab are used to select detailed
transactions to be reported with values in the corresponding K_14 tag, K_35 tag and K_36 tag.

In order to make sure that values have been correctly specified manually, IFS Cloud will always
crosscheck the totals of K_14 tags, K_35 tags and K_36 tags with tax template fields from VAT-7
report used to fill P_14 tag, P_35 tag and P_36 tag. If there is a difference, IFS Cloud will trigger a
warning message. These warning messages can be viewed in the Audit File Log page.
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3.5.9 RECREATE SAF-T VAT XML FILE

Once all the manual modifications are done in VAT-7 report, generate SAF-T VAT XML file again
using Audit Interface Assistant. On Audit File Log page, the Correction Number will beset to O for
created original SAF-T VAT XML.

@ > Accounting Rules > Audit Interface > Basic Data > Audit Formats > Audit File Log & Company [ AMKA-PLN|
Audit File Log
Correction
FilelD Audit Type = From Date To Date Output File Directory Timestamp /Numher ‘Warning Text
63 JPKIVAT  1/1/2019  1/31/2019 2021-05-18-16:14:30 0 TaxProposal ID is not in
175 JPKVAT | 3/1/2019 | 3/31/2019 2021-06-01-16:31:29 0 | Tax Proposal ID is not in
41 JPKVZM 17172019 1/31/2019 2021-05-14-15:37:13 Tax Proposal ID 2 is not i
42 PKVZM 17172019 1/31/2019 2021-05-14-15:49:39 Tax Proposal ID 2 is not i
83 JPKVZM  2/1/2019 2/28/2019 2021-05-19-14:53:05 Tax Proposal ID 7 is noti
103 JPKVZM  3/1/2019 3/31/2019 2021-05-20-17:43:08 Tax Proposal ID 9 is noti

Note:

By default, the XML file generated using Audit Interface Assistant will be created as Original XML.
The Correction Number will be hence set to 0 in Audit File Log.

Recreate XML File context menu option is available only for Correction Number is not 0. This value
must be changed manually to create correction of SAF-T VAT3 XML. The value of XML tag
<CelZlozenia> (i.e., the option to indicate whether the file is submitted for the first time or if it is an
adjustment of a previously transmitted file) will be copied from Correction Number.

3.5.10 CREATE CORRECTION SAF-T VAT XML FILE

In case if there are errors or issues with SAF-T VAT XML that the company has already submitted
to Polish Tax Office, the company must correct the errors in the file and send the corrected XML
back. It is possible to create multiple corrections - changing the Correction Number to next number,
save and select the Recreate XML File context menu option in Audit File Log. Value of Correction
Number will be copied to <CelZlozenia> tag in SAF-T VAT XML file. Value of this tag cannot be
repeated in one period.

3.5.11 DELIMITATIONS

None.
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3.6 SAF-T For Poland — Accounting Books (JPK_KR_PD)

3.6.1 SOLUTION — SAF-T PLACCOUNTING BOOKS

JPK_KR_PD file is the Standard Audit File which is a uniform control file for Accounting Books.
This is mandatory to be filed annually from the tax year 2025.

For capital groups and CIT taxpayers whose revenue exceed 50 million Euros in the previous tax
year, the requirement of filing these audit files is mandatory from January 1, 2025. For other
taxpayers, the requirement is mandatory from January 1, 2026.

The solution is based on IFS Cloud standard functionality of Accounting Journal, Turnover and
Balance Report, GL Voucher Rows Analysis, and the Audit Interface functionality.

In order to support the requirement for the SAF-T PL JPK_KR_PD report, the following has been
done:
¢ In Audit File Basic Data page, a new sub section JPK_KR_PD parameter in SAF-T Poland
Setup has been added to handle JPK_KR_PD specific data.
¢ New Audit Type JPK_KR_PD added to the Audit Interface Assistant.

» Create an Audit Format for Country Poland for Report Type : SAF-T
« Define Code Part Attributes and Connect Attribute Values
« Define Audit File Basic Data under JPK_KR_PD Parameters in SAF-T Poland Setup tab

Define Basic Data

~N
 Enter business Transactions
Enter
Transactions
J
I
» Update General Ledger
Update GL
J

» Navigate to Audit Interface Assistant
* Select country as "Poland"
Create « Enter report type SAF-T and audit type JPK_KR_PD
BN < VIM ° Select date or period range
File
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Z-IFS

The following prerequisites should be satisfied to generate SAF-T PL Accounting Books xml file for

auditing purposes.

e The company must be set-up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by default.

e |tis recommended to create the company using Standard Polish Template (STD-PL).

o All transactions from the period being of subject of XML file must be updated into General
Ledger and Accounting Journal for the same period must be defined and created.

3.6.3 DEFINE COMPANY BASIC DATA

3.6.3.1 Define Company Address Details (Standard functionality)

Open the Application Base Setup/Enterprise/Company page. On the Address submenu, click the
command View Detailed Address. The following fields must have values:

e Street

e House: Numberl/Number2 format, where Numberl is house number and Number2 is
apartment number
Community

e District

Street

Edit Detailed Address

House No Community

Dawson

‘ | 85/2 Krakow

District

| Piaski

OK

Cancel
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3.6.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define the
Tax Office for Poland, based on the information published on Polish Tax Authority website. For
example,

“0202”, “1010”, “3030” ...

® > Application Base Setup » Enterprise > Tax > TaxOffice > TaxReport &
Tax Report
Q Search
Sortby - -
: « 0202 - Poland Tax office ¥

uTo 4 @
Name: UK Tax Office
FA Tax Office Name
Name: Finanzamt Erlangen 0202 Poland Tax office
M Company: CRPLLTD - CR Poland Ltd ™~
Name: Bundeszentralamt fur Steuern

@ AF Z W
NL
Name: Tax Office NL

Company CIS Reporting Tax ID Number Our Identity Electronic Tax ID

CRPLLTD ! ) 777777 CR8%654328
AT
Name: Finanzamt Salzburg Account Office Legal Address ID State Code State Name

- -

0202

User Name Password
Name: Poland Tax office
Address

) Tax Report Info

Communication Method
Tax Report & Y + @ v 24 v =

On the Tax Report submenu, enter values for the Tax ID Number and Our Identity fields after
selecting the relevant company. The field ‘Our Identity’ is used to enter the National Business
Registry Number of the company and will be copied in tag <REGON> in the xml file.

3.6.3.3 Define Journal ID (Standard functionality)

To create the xml file JPK_KR_PD at least one Accounting Journal (General Ledger/Accounting
Journal) must be defined and created.

In case when more than one Accounting Journals are defined all of them must be created
(Accounting Journal/Create Accounting Journals) and information from all journals will be
included in the created JPK_KR_PD file.
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@ > Financials > General Ledger > Accountingjournal > Create Accounting Journals & Company CRPoland Ltd
Create Accounting Journals
Q Search
Y + Va ]E Q ~ Create Accounting Journals | Accounting Journals f:é} ~ e v 24~ S
‘:‘ Accounting Year  Sort By Sequence Number per
2022 Sequence No Voucher Row
2023 Sequence No Voucher Row
2024 Sequence No Voucher Row
B 2025 Sequence No Voucher Row
2026 Sequence No Voucher Row
2027 Sequence No Voucher Row
2028 Sequence No Voucher Row
2029 Sequence No Voucher Row
2030 Sequence No Voucher Row
2031 Sequence No Voucher Row

3.6.3.4 Define Code Part Attributes and Connect Attribute Values

According to the values published by the Polish Tax Authority for S_12 1, S 12 2, and S_12 3
tags, the user needs to define Code Part Attribute IDs and Attribute Values to map the chart of
accounts.

These three tags are printed under the ‘ZQis section’ of the xml file.

Note: The Appendix section contains values published by the PL Tax Authority for tags S _12 1,
S 12 2,and S_12_ 3. These values can be manually entered on the Code Part Attributes page or
imported using the data migration option.

In accordance with the JPK_KR_PD schema, the S_12_1 tag is mandatory for the ZOis7 section but
optional for the ZOis8 section. The S_12 2 and S_12_3 tags are optional for both the ZOis7 and
Z0is8 sections.

Note: If the Compliant with IFRS parameter is set to false, the S_12_1 tag must be defined, and
the ZOis7 section is included in the XML file.

Navigate to Accounting Rules/Code String/Code Part Attributes.
Define Code Part Attributes and Attribute Values. Then connect Attribute Values against the relevant
chart of accounts.
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Q Search

Y o+ Z m A4
m Artribute
v

BILANS
RZIS1
P52

551252

5123

@® > AccountingRules > Code String > Code Part Attributes &

Code Part Attributes

v Attribute Value || Connect Attribute

Description Code Part Name

Bilans Account

Rachunek zyskéw i strat..  Account
5121 (Zois 7) Account
512 2(Zois7) Account
S 12 3(Zois7 &8) Account

Copy to Companies

Company CR Poland Ltd

8o~ 2~ 24w ®m v

Note: The schema published by the Polish Tax Authority includes attribute values with some
lowercase characters. Since the Attributes Value field supports only uppercase characters, users
must specify the correct attribute value to be printed in the xml file using the “< >” symbol in the
Description column. This adjustment is required only for attribute values that contain lowercase
characters. For example:

Attribute value as
per the schema

Attribute value
in IFS Cloud

Description in IFS Cloud

Value printed in
xml file

B6ABIII_ipw_W

B6ABII_IPW_W

<B6ABIII_ipw_W>
AKTYWA | Aktywa
obrotowe | Inwestycje
krétkoterminowe | Inne
papiery wartosciowe

B6ABIII_ipw_W

Attribute Value
Q Search (1)
-
5121 n

Description: 5_12_1 (Zois 7)
Code Name: Account

s

v

® > Accounting Rules > Code String > Code Part Attributes > Aurioute Value &

S$12.1-512.1(Z0ois7) ¥ 10of1

Connect Attribute

m 4~

Attribute

2.1-5.12_1 (Zois 7)

Code Part Attribute Values

Y + 7

Auribute Value  Description

Code Part Name

Account

Company  CR Poland Ltd

& v B~ 24v BEv

| Wobec pozostalych jednostek | Zobowiazania wekslowe

BAAINEW | <BAAllTe_W> AKTYWA | Aktywa trwate | Rzeczowe aktywa trwate | Srodki trwate | Inne Srodki trwate

BAAII_W AKTYWA | Aktywa trwate | Rzeczowe aktywa trwate | Srodki trwate w budowie

BPBII3D <BPBII3d> PASYWA | Zobowiazania | rezerwy na zob | via diugotermin

BPBINI3H <BPBIII3h> PASYWA | Zobowiazania i rezerwy na zobowiazania | Zobowiazania krétkoterminowe | Wobec pozostatych jednostek | Z tytutu wynagrodzeri
RPEI WYNIKOWE | Koszty dziatalnosci operacyjne] | Amortyzacja
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3.6.3.5 Define JPK_KR_PD Parameters

Navigate to Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data
and define JPK_KR_PD parameters under the SAF-T Poland set-up tab.

® > Accounting Rules > Audit Interface > Basic Data > Audit Formats & Company CRPoland Ltd

Audit Formats

Q Search

Y + 7 IE[ Q ~ Audit File Basic Data | Audit File Tax Information  Audit File Log {:o:s ~ P~ 24~ B v

Thousands Negstive  Leading File

C) Country Report Type Decimal Symbol Seperator Format Zeroes Time Format Date Format Extension  File Type File Template ID Default

i POLAND SAF-T - (point) , (comma) 9 0.9 1zEs) YY-MM-DD Yes

@ > Accounting Rules > Auditinterface > BasicData > AuditFormats > Audh File BasicDau 2

Audit File Basic Data

Company  CR Poland L)

/s 0

HEADER STANDARD AUDIT CODE MAPPING RSN  TT 4«

4

General Info
Tax Office 1D Address 1D

0202 - WARSAW -

Mise Parameters

Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types

LR SRR SR S SR SRR S SN Y

Inventory Transaction Report Type Mappings

JPK_KR_PD Parameters

Compliant with IFRS 5121 5122 5123 K. K2 K3 .4
5121 v 5122 > s123 ~ 5500000 35200.00 25463.00 26987 24
S K6 K7 (]

23654.00 28700.00 296323 8965.77

JPK_ST_KR General Parameters

3.6.4 CREATE SAF-T JPK_KR_PD XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On the Start Option section select Online or Schedule.
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And specify the following:
e Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for
Poland.
o Audit Type: “JPK_KR_PD” selected from List of Values.
o Date From and Date Until: The start and end dates of the period to be covered in
SAF-T JPK_KR_PD report (xml can be created for one period or more but only from one year)
or:
e Period From and Period Until: The year and month range to be covered in SAF-T
JPK_KR_PD report.

Press the button Finish and the file will be saved.
If the audit file is run in batch mode, the xml can be downloaded from the Batch Processed Audit
Files page.

@ > AccountingRules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

.— Task Options = Schedute Schedule Options

Start Option

(@ Start now

(O schedule

Parameters

Company * Country * Report Type * Audit Type
CRPLLTD - CR Poland Ltd - POLAND - SAF-T - JPK_KR_PD -

Audit Source Ledger ID

Selection

Period/Date Range From until

ODbate 2024 1 2024 12

(@ Period
4 Pre P Next Finish = Cancel

Please refer chapter Appendix to view the mapping of IFS data to XML tags.

3.6.5 DELIMITATIONS

None
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3.7 SAF-T For Poland — Fixed Assets and Intangible Assets (JPK_ST_KR)

3.7.1 SOLUTION — SAF-T PL FIXED ASSETS AND INTANGIBLE ASSETS

JPK_ST KR file is the Standard Audit File for Fixed Assets which is a uniform control file for the
records of fixed assets and intangible assets. This is mandatory to be filed annually from the tax
year 2026.

For capital groups, CIT taxpayers, and others whose revenue exceeded 50 million Euros in the
previous tax year, the requirement of filing these audit files is mandatory from January 1, 2026.

The solution is based on the IFS Cloud standard functionality of Fixed Assets and the Audit
Interface functionality.

T

‘Naglowek

JPK |-
(:E_— tn=:Podmiot1 [

| L

I
1
m'

ST_KR

=

ilz podmiots . 1.=

In order to support the requirement for the SAF-T PL JPK_ST_KR report, the following has been

done:

Object class change details log introduced on the server side to record any Object Class
change done on the Fixed Asset Object page.

In the Object Classes page, a new column Tax Depreciation Rate has been added to add
the annual tax depreciation rate for each object class.

In the Audit File Basic Data page, new sub-sections in SAF-T Poland Setup have been
added to handle JPK_ST_KR specific data.

New Audit Type JPK_ST_KR added to the Audit Interface Assistant.

Country Solution POLAND 66



Define a Code String for FA Accounting Code Part Function
Def Enable Write Method Change Log parameter in Company/Fixed Assets/Depreciation Parameters section.
Cori;)r;iy Define Tax Depreciation Rate in Object Classes page
e e Define Fixed Asset Property Codes to add OT and LT numbers )
~
Create an Audit Format for Country Poland for Report Type : SAF-T
Enter Audit File Basic Data: Tax Office ID and Address ID
LWL Define sections provided for JPK_ST_KR in SAF-T Poland Setup tab
Basic Data
J
~
Enter Fixed Asset and Intangible Asset related transactions
Enter
Transactions J
~
Update General Ledger
Update GL
J
. . . A
Navigate to Audit Interface Assistant
Select country as "Poland"
Create Enter report type SAF-T and audit type JPK_ST_KR
VS GSIINGE Select date or period range
XML File J

7z IFS

Define Tax Office (Standard Functionality) )

3.7.2 PREREQUISITES

The following prerequisites should be satisfied to generate SAF-T PL Fixed Assets and Intangible
Assets xml file for auditing purposes.

The company must be set up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by
default.

It is recommended to create the company using Standard Polish Template (STD-PL).

It is required to have a code part defined for the FA Accounting Code Part Function.

All fixed assets transactions of the selected period of XML file must be updated into
General Ledger.

The following filters were applied to recognize the fixed asset objects that should be printed in the
JPK_ST_KR file for a given period.

JPK_ST_KR file should include all the assets in the fixed asset ledger that are of “Normal”
and “Right-of-Use” object types. However, ROU Assets created via Operating Lease Type
will be excluded from the XML file.

Assets acquired during the reporting period are accurately identified by verifying the event
date of their initial acquisition transaction.

When generating the JPK_ST_KR file for a specific financial year, assets disposed before
the "From Date" or the initial reporting date will be excluded.

Example: when the file is ordered for the financial period 01.01.2025 till 12.31.2025, the fixed assets
disposed prior to 01.01.2025 will not be included.
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o Fixed asset objects in the Registered, Import, and Investment states will be excluded from
the XML file.
3.7.3 DEFINE COMPANY BASIC DATA
3.7.3.1 Define Company Address Details (Standard Functionality)
Open the Application Base Setup/Enterprise/Company page. On the Address submenu, click the

command View Detailed Address. The following fields must have values:
e Street

e House: Numberl/Number2 format, where Numberl is house number and Number2 is
apartment number

¢ Community
District

x Edit Detailed Address

Street House No Community

Community 1

Street 1 ‘ ‘ 536/78

District

District 1 ‘

OK Cancel

3.7.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define the Tax
Office for Poland, based on the information published on the Polish Tax Authority website. For
example,

“0202”, “10107, “3030” ...
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@ > Application Base Sewp > Encerprise > Tax > TaxOffice > TaxReport &

Tax Report
Q Search (1)
sy - « 0202 - Poland Tax office ¥ 1of1
0202 o V)

Name: Poland Tax office

Address
Communication Method Tax Office Name

0202 Poland Tax office
Tax Report &

Company: STDPOLAND - STDPOLAND Co ¥

a + @ 7 m

Company CIS Reporting Tax ID Number our Identity Electronic Tax 1D
STDPOLAND "‘) 123-555-3333-1 11223344
Account Office Legal Address ID State Code State Name
- -
User Name Password

On the Tax Report submenu, enter values for the Tax ID Number and Our Identity fields after
selecting the relevant company. The field ‘Our Identity’ is used to enter the National Business
Registry Number of the company and will be copied in tag <REGON> in the xml file.

3.7.3.3 Define Write Method Change Log (Standard functionality)

Depreciation method change information will be generated by the system when information relevant
to depreciation calculation is modified in the Books tab of the Fixed Asset Object page when this
option is enabled in Application Base Setup/Enterprise/Company/Company/Fixed Assets sub-
menu.

® > Application Base Setup > Enverprise > Company > Company > Fixed Assets 2
Fixed Assets
Q Search (1) Advanced 11

Company: STOPOLAND ~ X Name ¥  AssociationNo ¥ More ¥ © Favorites Clear

Saved Searches

STDPOLAND
Name: STDPOLAND Co

Address

Communication Method

Message Setup

Employees
Accounting Rules o
Acquisition Parameters
Tax Control
Allow Multiple Acquisition Code Strings Reduction by Cash Discount
Invoice » »
Payment
Fixed Assets & Inventory Parameters Depreciation Parameters
Periodical Cost Allacation ST TR Write Depreciat

Supply Chain Informaton » «©

Localization Contrel Center Physical Location Mandatary Write Method Change Log

Shaw less » [ @

Whenever the Depreciation Method is changed in the Books tab for the Fixed Asset Book for Tax
Depreciation, the Tax Depreciation Mapping value for Old Value will be reflected in E_9_1 tag and
the Tax Depreciation Mapping value for New Value will be reflected in the E_9_2 tag respectively.
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@ > Financials > Fixed Assets > Reconciliation/Year-end > Depreciation Method Change Details & Company STDPOLAND Co

Depreciation Method Change Details

Q Search
V Cleanup of Depreciation Method Change Details {§} v e v 24 v :: S
v Bock Object Date Changed User Column Name Old Value New Value
PODATEK - Tax Depreciation CM1 - Change method 11/28/24,12:57 PM ML MANLLK} METHODID LINIOWA2I1/2PNO LINIOWAZ20PODATK

3.7.3.4 Define Tax Depreciation Rate in Object Classes

The Classification of Fixed Assets is used in statistical reporting and in the accounting records of
fixed assets. The Classification of Fixed Assets (KST) was introduced by the regulation of the Council
of Ministers on 10 December 2010 (Journal of Laws No. 242, item 1622).

The KST Classification codes should be defined in the Financials/Fixed Assets/Object Basic
Data/Object Classes page and then defined in the Financials/Fixed Assets/Fixed Asset Object
page in the Object Class field. The classification defined in the field will be printed in the E_8 tag.

@ > Finandials > Fixed Assets > Fixed Asset Object & Company STDPOLAND ({
Fixed Asset Object
Q Search (1) Advanced 5
Status ¥  Object: ML1 ¥ X  Description ¥  Object Group ¥ ObjectType ¥ More ¥ O Favorites Clear Saved Searches ~
Sortby = .
« ML1-Object1 ¥ 1of1 Scrapped CEEE—
MLt + Z W L +  ViewHold Information  Objectinventory +  Other ~ Q
Description: Object 1
Object Description Replaced/split Object
ML1 Object 1
Object Type *
Normal -
@ USER DEFINED BASE VALUES ~ BOOKS PREPOSTING  INVENTORY ~PROPERTIES DISPOSAL  RENTAL ASSETS 4« »
General Details
Object Group * valid * Object Class
7 - Vehicles w  1/1/2024-12/31/2049 774-741 - Cars -
Supplier Object Owner External ID
-
Attributes Notes. Rotable Pool Object

In Poland, the tax depreciation rates are specified in the "Wykaz rocznych stawek
amortyzacyjnych," a schedule issued by the Ministry of Finance. These rates indicate the annual
percentage at which different types of fixed assets can be depreciated for tax purposes. Each tax
rate corresponds to KST.

Hence, the Tax Depreciation Rate column in the Financials/Fixed Assets/Object Basic
Data/Object Classes page is given to define the rates issued by the tax authority. This field is
controlled by the Poland Localization. The rate defined here will be printed in E_10A tag.
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® > Financials > Fixed Assets > Object Basic Data > Object Classes & Company STDPOLAND Cq
Object Classes
Q Search
v o+ 7 &y By 24v B
v Object Class Description Tax Depreciation Rate
001-010 Agricultural lands
002-020 Farests
007-070 Water regions 2.856
110101 Industry buildings 25512
110-105 Office buildings 2.56
220-201 Power-stations 45
222-221 Railway lines 10
331-311 Steam boilers 7
334-349 Nuclear reactors 14
441-415 Grinding machines 14

Note: When the actual depreciation factor is different than the Tax Depreciation Rate given for an
object, the E_11 tag will be printed. It is taken from the Fixed Assets/Depreciation Basic
Data/Depreciation Method/Factor% field. For instance, if the factor exceeds 100%, such as a
1200% rate for recording a one-time depreciation, the E_11 and E_25A tags will display the value
100.

3.7.3.5 Define Fixed Asset Properties

Inthe E_5 tag, it is required to specify the document number (OT) based on which the fixed asset or
intangible asset was introduced. Similarly, it is required to specify the number (LT) of the document
confirming deletion from the register in the E_30 tag.

To record these OT and LT numbers, you can use the existing functionality of Fixed Asset Property
Codes. Property Codes by names OT and LT should be defined in the Financials/Fixed
Assets/Object Basic Data/Fixed Assets Property Codes page with Data Type String.

@ > Financials > FxedAssets » ODJect BasicData > Fixed Assels Propery Codes O Company  STDPOLAND Co

Fixed Assets Property Codes

Q Search

® > Finenclals > Fired Assets > Fixed

company  STDPOLAND Co

Fixed Asset Object

Qsearch (1) Advanced :
Saws:Sold ¥ X Object ¥  Description ¥  ObjectGroup ¥ ObjectType ¥  More ¥ @ Faverites Clear SavedSearches
T « SALE-Sold object ¥ 1of1 Sold e—
SAlE + /# W [ ~ ViewHoldInformation  Objectinventory ~ = Other - Q

Description: Sold object

Object Description Replaced/Split Object Object Type
SALE Sold object Normal -
GENERAL USER DEFINED BASE VALUES  BOOKS PREPOSTING  INVENTORY DISPOSAL RENTAL ASSETS 4 »
¥ + /  AddProperty Codes from Template S By 24v =v
property cod_ Suring value Number value Datevalue  Value Description Reference
:  OT-OT Document 7896
: LT-LTDocument 2023001
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3.7.3.6 Object Class Changes
It is required to print 1 (Yes) and 2 (No) respectively in the E_32 tag if a change is done in the KST

classification shown in the Object Class on Fixed Asset Object page. Therefore, a server-side
implementation was done to record the changes.

3.7.4 DEFINE AUDIT BASIC DATA

Navigate to Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data and
define JPK_ST_KR basic data under the SAF-T Poland Setup tab.

® > Accounting Rules > Auditinterface > BasicData > AudicFormass Company  STDPOLAND Co
Audit Formats
Q Search
Y o+ / W L - || AuditFile Basic Data  [Rudit File Tax Information  Audit File Log &~ B~ 24v B
e
country Report Type Decimal symool Time Format Date Format Extension  Flle Type File Template 1D Default
H POLAND SAF-T (point) . (comma) 9 09 1359 YY-MM-DD Yes

3.7.4.1 Define JPK_ST_KR General Parameter

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST KR General Parameters, define the fixed asset book used to record depreciation
for tax purposes in Fixed Asset Book for Tax Depreciation field and define the fixed asset book
used to record depreciation for internal accounting purposes in Fixed Asset Book for Accounting
Depreciation field.

Based on business practice, users can connect different fixed asset books or the same book in these
fields.

@ > Accountng Rules > Audit Interface > Sasic Data > AuditFormats > AucitFile Sssic Dsts (7 Company  STDPOLAND Col

Audit File Basic Data

s o

HEADER STANDARD AUDIT CODE MAPPING [ETNRR TN o

7 W
General Info
Misc Parameters
Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)
Delivery Type for Delivery Goods and Services
Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures
Invoice Type Mappings
SAF-T PL Inventory Transaction Report Types

Inventory Transaction Report Type Mappings

< < < KK K< <K

PK_KR_PD Parameters
s ——

PK_ST_KR General Parameters
Fixed Asset Book for Tax Depreciation Fixed Asset Book for Accounting Deprediation

PODATEK - Tax Depreciation ~  BILANS - Balance Depreciation -

JPK_ST_KR Intangible Object Groups
JPK_ST_KR Acquisition Reason Mapping

JPK_ST_KR Disposal Reason Mapping

< < <K

JPK_ST_KR Tax Depreciation Mapping
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3.7.4.2 Define Intangible Object Groups

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR Intangible Object Groups, define the object groups that will be used to create
Intangible Assets in the Fixed Asset Object page.

This is required to identify which tag E_2 or E_3 to be printed to show the date of acquisition/creation
of a fixed asset in the JPK_ST_KR file.

@ > Accounting Rules > Audit Interfoce > Basic Data > AuditFormats » Audlt Flle Basic Dotz &2 Company  STDPOLAND C

Audit File Basic Data

7 1

HEADER STANDARD AUDIT CODE MAPPING [ETSRELTINLE Ry “

IC}
General Info
Misc Parameters
Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)
Delivery Type for Delivery Goods and Services
Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures
Invoice Type Mappings
SAF-T PL Inventory Transaction Report Types
Inventory Transaction Report Type Mappings

JPK_KR_PD Parameters

LS S G S A O A O O S G AR A G IR

JPK_ST_KR General Parameters

JPK_ST_KR Intangible Object Groups

esearch and Development Costs

¢ W2- Goodwil

I W3-Other Intengible Assets

3.7.4.3 Define Acquisition Reason Mapping

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR Acquisition Reason Mapping, define the following.

e Transaction Reason (Acquisition Type) - Transaction reason applicable for the acquisition or
the acquisition value adjustment of a fixed asset object.

o Document Type - Select the type of document confirming the acquisition of the asset,
provided by the Poland Tax Authority which should be mapped to an acquisition reason in
IFS Cloud Transaction Reasons. This will be printed in the E_6 tag.

Document Type Description

S Sales Agreement

D Donation Agreement
N Non-cash contribution
W

F

I

Production/Manufacturing
VAT invoice
Other
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¢ Qualifying Reason - Select the option if, the Transaction Reasons are qualifying for tax and
accounting initial value changes of assets according to Article 15(5) and Article 31(3) of the
Corporate Income Tax Act in Poland. This will affect E_13 to E_15 tags for the Tax
Depreciation Book and E_22 to E_24 tags for the Accounting Depreciation Book.

® > AccountngRules > Audiinterface » BasicData » Audit Farmats

Audit File Basic Data

Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types
Inventory Transaction Report Type Mappings
JPK_KR_PD Parameters

JPK_ST_KR General Parameters

JPK_ST_KR Intangible Object Groups

JPK_ST_KR Acquisition Reason Mapping

i APORT - Contribution in kind

BUDOWA - Construction of new buildings

RABAT GOTOWKOWY - Cash Discount

i ZAKUP -Purchase

Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

AuditFlle Basic etz O

Delivery Types/Customer Groups for Specific Procedures

F - VAT invoice

W - Production/Manufacturing

D - Donation Agreement

D - Donation Agreement

S - Sales Agreement

I-Other

N - Non-cash contribution

S - Sales Agreement

-
.
.
.
.
.
.
.
.
.

) A W~ B

o

o

o

[ o]

company  STDPOLAND C

3.7.4.4 Define Disposal Reason Mapping

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR Disposal Reason Mapping, define the following.

e Transaction Reason (Disposal Type) - Transaction reason applicable for the disposal of a
fixed asset object.

e Document Type - Select the type of document confirming the disposal of the asset, provided
by the Poland Tax Authority which should be mapped to a disposal reason in IFS Cloud
Transaction Reasons. This will be reflected in the E_29 tag.

Document Type

Description

Reclassification to another asset group

Sale

Identification of shortage

Theft

Donation

Z|O|X X |0 |>

Non-cash contribution

Other
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® > AccountngRules > Auditinterface » Basic Data > AuditFormats > AuditFile Basic Data <

Audit File Basic Data

Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types

Inventory Transaction Report Type Mappings

JPK_KR_PD Parameters

JPK_ST_KR General Parameters

JPK_ST_KR Intangible Object Groups

JPK_ST_KR Acquisition Reasan Mapping

JPK_ST_KR Disposal Reason Mapping

Transacion Reasen Document Type

onstruction of new buildings K-Theft

D - Donation

|- Other

X - Identification of shortage

A~ Reclassification to another asset Eroup

I WNIP - Write off of intangible fixed assets N - Non-cash contribution

i WYCOFANIE - Withraw object from using 5-Sale

3.7.4.5 Define Tax Depreciation Mapping

ompany

STDPOLAND (]

LI G G AE GHEE GRER GR AR SRR SR GL AR R A QNI

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST KR Tax Depreciation Mapping, define the following.

o Depreciation Method — Identity of the depreciation method.

e Tax Depreciation Method - Select the Tax Depreciation Method, provided by the Poland Tax
Authority which should be mapped to IFS Cloud Depreciation Method. This is reflected in
E 9 1and E_9 2 tags.

Tax Depreciation Method Description

D Declining Balance
L Straight-line

J One-time

I Other

X No depreciation

o Frequency of Depreciation - Select the Frequency of depreciation, provided by the Poland
Tax Authority which should be mapped to IFS Cloud Depreciation Methods. This is reflected
in E_17 tags.
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Frequency

Description

Monthly

Quarterly

Annual

One-time

i« |RIZ

Seasonal

Other

No deduction

® > Accounting Rules > AuditInterface > BasicData > Audit Formats

Audit File Basic Data

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types
Inventory Transaction Report Type Mappings
JPK_KR_PD Parameters

JPK_ST_KR General Parameters

JPK_ST_KR Intangible Object Groups
JPK_ST_KR Acquisition Reason Mapping
JPK_ST_KR Disposal Reason Mapping

JPK_ST_KR Tax Depreciation Mapping

Depreciation Metnod

:  DEGR17PNO - Decline,

7%, beg.of next period

¢ LINIOWA20PODATK - i

PNO - Straight Line

traight Line, 30%, beg.of ne

Straight Line 7%, beginning of period

Z45 - RemValue/RemManths

r Line/onetime depreciation

Str.Line/onetime depreciation

- strLine/adju

SOYD3 - Sum of year digits - 3 years

sudit Flle Basic Dat 2

i DEGR14PO - Decline, 14%-ratio2, beginning of period

traight Line, 200 from tax base w

beginning of period

Tax Depreciation Metned

D - Declining Balance

D - Declining Balance

L - Straight-line

L - Straight-line

L- Straight-line

L- Straight-line

|- Other

J-One-time

] - Qne-time

L - Straight-line

X - No depreciation

Frequency of Depreciation

M- Monthly

M- Monthly

M-Monthly

M- Monthly

M- Monthly

R- Annual

I-Other

|- One-time

] - One-time

K- Quarterly

X - No deduction

company  STDPOLAND C

& v By 2av B v

3.7.5 CREATE SAF-T JPK_ST_KR XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.

On the Start Option section select Online or Schedule.

And specify the following:
e Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for

Poland.

JPK_ST_KR report.

Audit Type: “JPK_ST_KR” selected from List of Values.

Date From and Date Until: The start and end dates of the period to be covered in
SAF-T JPK_ST_KR report or:
Period From and Period Until: The year and month range to be covered in the SAF-T

Press the button Finish and the file will be saved.
If the audit file is run in batch mode, the xml can be downloaded from the Batch Processed Audit

Files page.
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® 5 ACcountingRules > Auditinterface > AUDI Imterface Assistant

Audit Interface Assistant

._ Task Options ==

Start Option

@ Start now

(O Schedule

STDPOLAND - STOPOLAND Co ~ || POLAND | | saRT ~ || JPKSTRR -

2026 1 2026 12

Please refer chapter Appendix to view the mapping of IFS data to XML tags.

3.7.6 DELIMITATIONS

None

3.8 SAF-T For Poland - Inventory Report (JPK_MAG)

3.8.1 SOLUTION — SAF-T PL INVENTORY

The solution is based on Audit Interface functionality in standard IFS Cloud.

In order to support the requirement for the SAF-T PL Inventory report, the following has been done:

1. New report type SAF-T added to the Audit Formats page.

2. In Audit File Basic Data page, a new tab SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

3. Task Options in Audit Interface Assistant page, new field Audit Type has been added to
select relevant SAF-T report. In SAF-T PL Additional Parameters, additional fields specific
for the SAF-T MAG have been added.

4. New external file templates were added to support specific SAF-T reports.

Process Overview
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» Define Company Address Details (Standard functionality)

» Define Tax Office (Standard functionality)

« Define Inventory Transaction Report Types (Standard functionality)

» Connect inventory transaction codes to report types (Standard functionality)

Define Basic
Data

\
* Enter Audit Format for Poland
» Enter general SAF-T PL data - Tax Office ID, Address ID and Journal ID
DISEVAUGM - Map inventory transaction report types to SAF-T PL inventory transaction report types
File Basic Data
J
\
»Update the General Ledger after entering invoices relating to inventory
[ EICRElREN ] © Fetch tax ledger information.
Fetch Tax
Ledger Info J
*Run Audit Interface Assistant (Standard functionality) A
« Specify Report Type, Audit Type
« Specify File Type
Create XML file -Spec!fy D_ate From - Date Until or Period Frorm - Period Until
* Specify Site, Warehouse )

3.8.2 PREREQUISITES

Following prerequisites should be satisfied in order to generate SAF-T PL Inventory xml file for
auditing purposes.

e The company must be set-up to use Polish localization, see the Company Set up chapter.

e The functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by
default.

e |tis recommended to create the company using Standard Polish Template (STD-PL).

3.8.3 DEFINE BASIC DATA

3.8.3.1 Define Company Address Details

Open the Application Base Setup/Enterprise/Company page. On the Address sub menu use Edit
Detailed Address command button. The following fields must have values:
e Street
e House: Numberl/Number2 format, where Numberl is house number and Number2 is
apartment number
o Community
e District
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X Edit Detailed Address

Street House No Community

Lopuszanksal 123 | Okecie

District

‘Wiochy

oK Cancel

3.8.3.2 Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On General tab define Tax Office

for Poland — one from the list published on tax authority’s website. For example
‘02027, “10107, “3030” ...

® > Application Base Setup > Enterprise > Tax » Tax Office > s
Search advanced B
Tax Office * Name:-PL% ~ @ Creation Date ¥ Mare ¥ 0 Favorites  Clear Q Settings
sartby v
Tax Office o2 pLraxofficenan ¥ 10f1
0202
L + 7 m [c] B~ Q
Name: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 EI'Ig“SI'I e
Tax Report Name Country
PL Tax Office Dan POLAND A
Creation Date
8/4/2020
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On the Tax Report sub menu connect the company, relevant tax ID number and specify our identity.
Our identity is company ID for the specific tax office.

@ > Application Base Setup > Enterprise > Tax > Tax Office » Tax Report =
Sort by
Tax Repo Ft varpL-vareL ¥ 10f1
VATPL
&« B v
Mame: VAT PL
Address
Communication Method Tax Office Mame
Tax Report & VAT PL VAT PL
Company: AMKA-PLN - AMKA-PLN ¥
Q + I m B
Company Tax ID Number Qur Identity Electronic Tax ID State Code
AMKA-PLN PL 2337684748 123456789 vatplol WN A
State Name

warminsko-mazurskie

Tax Report Info

= Nl [~ + i
- i TaxReport
VAT-2020 - Vat 2020

VAT7M - VAT7M

3.8.3.3 Define Inventory Transaction Report Types

Go to the Inventory/Transaction History/Report/Inventory Transaction Report Basic Data
page. On the Report Types tab define report types used for inventory transactions.

= @ > warehouse Management > Transaction History > Report > Inventory Transaction Report Basic Data

Search  Asvanced ¥

Company ¥ More ¥ O Favorites  Clear Q Settings

Inventory Transaction Report Basic Data oanroiano ~

» R v Copy To Company Q
CG\"TDBH‘J'
DAN POLAND
REPORT GROUPS  REPORT TYPE FOR TRANSACTION CODES  REPORT TYPE NUMBER SERIES 4 13
=Y B v t 4 Translation = v
Report
Type
v i ReportType Report Type Description Direction
s Consignment Stock
Pz External Receipt +
RT-.INVM-COIN RT-.INVM-COIN +
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On Report Type For Transaction Codes tab, connect the defined report types to the transaction
codes. All inventory transactions to be considered in JPK_MAG report should be assigned to one of
defined report types. Note: internal transfer must be reported in one type “MM” in JPK_MAG XML,
while in IFS Cloud it is handled with two transactions (issue and receipt) — so only issue transaction
should be mapped (to report type “MM-).

= @ > warehouse Management > Transaction History > Report » Inventory Transaction Report Basic Data

[
Search  Advanced ¥
Company ¥  More ¥ © Favorites  Clear Q i Sett ngs
Inventory Transaction Report Basic Data oavroiano ~
» ’ B v Copy To Company Q
Company
DAN POLAND
REPORT TYPES ~ REPORT GROUPS REPORT TYPE NUMBER SERIES 4
=Y B v - = v
v i Transaction Code Direction Report Type
INVM-IN - Internal Transf + RT-.INVM-IN - RT-.INVM-II
INVM-ISS - Internal Trans - RT-.INVM-ISS - RT-.INVM-
INVM-COIN - Inter Site Tr + RT-.INVM-COIN - RT-.INV?
INVM-OUT - Inter Site Tre - RT-.INVM-OUT - RT-INVIV

3.8.4 DEFINE AUDIT FORMAT BASIC DATA

Go to Accounting Rules/Audit Interface/Basic Data /Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:

o Select the Country as “Poland”,
o Report Type as “SAF-T”
If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed
Audit Files page.

Select the Audit File Basic Data command to open the Audit File Basic Data page.

® > Accounting Rules > Audit Interface > Basic Data > Audit Formats &2 company [ AMKA-PLN

Audit Formats

L3 + 7 @ B B Audit File Basic Data Audit File Tax Information Audit File Log B
Thousands Negative  Leading
l Coumry ReportType  Decima | Symbol tor Format Zeroes Time Format Date Format File Type File Template ID Default
: | POLAND SART {point) , (comma) 9 09 13:59 YY-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page.
The new tab: SAF-T Poland Setup includes ten sections.

For SAF-T Inventory report below sections are applicable:

e General Info
e SAF-T PL Inventory Transaction Report Types
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¢ Inventory Transaction Report Type Mappings

General Info
On SAF-T Poland Setup tab General Info section applicable to all SAF-T report types are entered.

To generate JIPK_MAG xml file, General Info group fields must have values:
e Tax Office ID - Select from list of values; only values from legal list will be accepted by tax
office.

e Address ID - Specify company address ID. The address should be defined with all details.

® > AccountingRules > AuditInterface > BasicData > AuditFormats> Audit File BasicData & Company  Polish company

Audit File Basic Data

s~ o
HEADER STANDARD AUDIT CODE MAPPINGS 4 »
7 o]
General Info
Tax Office ID Address ID
0202 v Al v
Misc Parameters
Person ID Invoice Series for SAD
MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services N
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

Country Solution POLAND 82



SAF-T PL Inventory Transaction Report Types Section

™
Zi IFS

SAF-T PL Inventory Transaction Report Types section contains a list of inventory transaction report
types required by JPK_MAG to be reported in xml file in relevant blocks with their English description.

® > AccountingRules > Audit Interface > BasicData > Audit Formats > Audit File Basic Data &

Audit File Basic Data

4 o

HEADER STANDARD AUDIT CODE MAPPINGS
m

General Info

Misc Parameters

Voucher/Delivery Types for Document Types (JPK_V7M)

Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures

Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventery Transaction Report Types

E= A4 B~ 24 ~

JPK Inventory Report Type Description

MM Inventory Movement

PZ External Reciept

RW Internal Issue

WZ External Issue

Inventory Transaction Report Type Mappings

Inventory Transaction Report Type Mappings Section

Company Polish company

1< <]K

<X«

On the Inventory Transaction Report Type Mappings section, all inventory transaction report types
to be reported in JPK_MAG, should be connected to one of SAF-T PL report types. SAF-T report
types are listed on the SAF-T PL Inventory Transaction Report Types section. The mapping should
be done for required inventory transaction report types, defined in IFS Cloud in the Inventory
Transaction Report Basic Data page. Hence IFS Cloud inventory transaction report types should
be mapped against the SAF-T inventory transaction report types with correct direction.
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Audit File Basic Data

ra [
HEADER STANDARD AUDIT CODE MAPPINGS LT Ey W1 RSV

General Info

Misc Parameters

Voucher/Delivery Types for Document Types (JPK_V7M}
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types

Inventory Transaction Repert Type Mappings
AT A +

SAF-TPL Inventory Transaction  INVentory Transaction Report
Report Type Type Direction

MM cs

Pz Pz

Pz RT-INVIM-COIN

MM RT-INVI-IN 0
MM RT-INVIM-I55 0

With this mapping, the user can specify which inventory transaction reports with assigned
transactions will be reported in JPK_MAG xml file and in which block PZ, WZ, RW or MM.
The data from mapped transactions, quantity and value, will be reported with specified sign assigned

to SAF-T PL Inventory Transaction Report Type in Direction.

“0” direction should be assigned to “MM” SAF-T PL Inventory Transaction Report Type, so that “MM”

report type will show both the source and destination.
3.8.5 CREATE SAF-T INVENTORY (JPK_MAG) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On Start Option section select Online or Schedule.

And specify following:

o Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for

Poland
o Audit Type: “UPK_MAG”

o Date From and Date Until: The start and end dates of the period to be covered in

SAF-T MAG report or:

e Period From and Period Until: The year and month range to be covered in SAF-T MAG report.
e File Type: select the file type for JPK_MAG xml structure from List Of Values. To have

Inventory transactions correctly reported in xml file, “JPK_MAG” file type must be selected.
o File Template will show up automatically after File Type is specified.
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

.= Task Options =Q= SAF-T PL Additional Parameters == Schedule Schedule Options

Start Option

(C) Start now

() schedule
Parameters
Company Country Report Type
DAN POLAND - Dan Poland ¥ | POLAND v | SAF-T -
Audit Type Audit Source Ledger ID
JPK_MAG -
File Type File Template
JPK_MAG v | | JPK_MAG_TEMPLATE -
Selection
Period/Date Range From until
(O bate 2020 8 2020 8
@' Period
4 Previous » Next Finish Cancel

On SAF-T PL Additional Parameters specify:
e Site — enter one of the sites connected to the company — use list of values.

¢ Warehouse — enter a warehouse connected to the selected site — use list of values. Enter %
to include all warehouses connected to site in the report.

Click Finish button to generate the SAF-T Inventory XML file. The file will be named as:
<Audit Type without brackets>_<Time stamp(yyyymmddhhmmss>.XML

e.g., JIPK_MAG_20170914154614. XML

The generated XML file must be submitted to Polish Tax Office.

{3 Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

O= Task Options =.= SAF-T PL Additional Parameters = Schedule Schedule Options

Site Warehouse
PL * | PL hd
4 Previous » Next Finish Cancel

3.8.6 DELIMITATION

None.
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3.9 SAF-T For Poland — VAT Invoices Report (JPK_FA)

3.9.1 SOLUTION — SAF-T PL VAT INVOICES
The solution is based on Audit Interface functionality in IFS Cloud core.

In order to support the requirement for the SAF-T PL VAT Invoices report, the following has been
done:

1. New report type SAF-T added to the Audit Formats page.

2. Onthe Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has
been added to handle SAF-T Poland specific data.

3. Task Options in Audit Interface Assistant page, new field, Audit Type, has been added to
select relevant SAF-T report. In SAF-T Additional Parameters, additional fields specific for
the SAF-T VAT Invoices report (JPK_FA) have been added.

4. New external file template is added.

Process Overview

» Define Company Address Details )
» Define Tax Office
« Define Delivery Types
: : * Define Invoice Texts
PEINCERERIAPEIEY . Define Correction Reasons
J
\
« Enter Delivery Types for Specific Procedures
» Connect Customer Invoice Types
Define Audit
Format Basic Data
J
)
» Update the general ledger after entering customer invoices
O EICNEIEIEI « Fetch tax ledger information
Ledger and Fetch
Tax Ledger
Information J
. . )
* Run Audit Interface Assistant
« Specify report Type, Audit Type
* Specify File Type
* Specify Date From - Date Until or Period From - Period Until
CICEICPAIRIER . Specify Currency, Selection Date )

3.9.2 PREREQUISITES

e The company must be set-up to use Polish localization, see the Company Setup chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization parameter is mandatory and
enabled by default.
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It is recommended to create the company using Standard Polish Template (STD-PL).
e |tis recommended to use “Prepayment Based Invoice” as Method For Invoicing Prepayment
in company setup.

3.9.3 DEFINE BASIC DATA

3.9.3.1 Define Company Address Details

Open the Application Base Setup/Enterprise/Company page. On the Address sub menu click the
View Detailed Address. The following fields must have values:
e Street
e House: Numberl/Number2 format, where Numberl is house number and Number2 is
apartment number
¢ Community

District
X Edit Detailed Address
Street House No Community
Lopuszanksd 123 Okecie
District
Wiochy
oK Cancel

3.9.3.2 Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On the General section define Tax
Office for Poland — one from the list published on tax authority website. For example
“0202”, “10107, “3030”

@ > Application Base Setup > Enterprise » Tax » Tax Office » (5
Search  advanced 7
Tax Office ¥ Name:PL% ¥ @ CreationDate ¥ More ¥ 0 Favorites  Clear Q Settings

sortby

Tax Office o2 taxofficepan v 10f1
0202

€« + & m (0] B v O
MName: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 English v
Tax Report Name Country
PL Tax Office Dan POLAND -

Creation Date

8/4/2020
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On the Tax Report sub menu connect the company, relevant tax ID number and specify our identity.
Our identity is company ID for the specific tax office.

B > Application Base Setup > Enterprise » Tax > Tax Office » Tax Report 5

VAT PL

Name: VAT PL

Address

Communication Method

Tax Report

-

Tax Report VAT PL-VATPL ¥ 1of1

& B~

Tax Office
VAT PL
Company: AMKA-PLN - AMKA-PLN ¥

Q + | / m (gl

Company

AMEKA-PLN

Tax ID Number

PL 2337684748

Mame

VAT PL

Our Identity Electronic Tax ID
123456789 vatpl01

State Name

warminsko-mazurskie

Tax Report Info

= v B~ + &
Tax Report
VAT-2020 - Vat 2020

VAT7M - VATTM

3.9.3.3 Define Delivery Types

State Code

WN -

Go to the Financials/Customer Invoice/Basic Data/Delivery types page. Define Delivery Types
to be used as selection criteria in P_20, P_21, P_22, P_106E_2 and P_106E_3 fields of XML
JPK_FA report — according to XSD schema provided by tax authorities.

@ > Financials > Customer Invoice > Basic Data » Delivery Types &>

Delivery Types

[
<

Delivery Type

P_106E_3

P_106E_2

P_22

P_21

P_20

EE

GTU_D

Description

P_106E_3

P_106E_2

P_22

P_21

P_20

Telecommunications services, broadcasting :

Deliveries of alcoholic beverages

Include in
Invoice

company | Dan Poland

Ml
<

Invoice Enclosure

Enclosure Series D
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3.9.3.4 Define Invoice Texts

Go to the Financials/Customer Invoice/Basic Data/Invoice Texts page. Define Texts to be used
on invoices with corresponding delivery types specified on Delivery Types for Specific Procedures
section P_20, P_21 or P_22 fields. The invoice texts should be defined as follows.

Delivery Type Invoice Text Format

P 20 <Text1>:<collector's name>, <Text2>:<collector’s address>

P_21 <Text1>:< representative’s name>, <Text2>:<representative’s address>,
<Text3>:<representative’s ID>

P 22 <Textl>:< registration date>, <Text2>:<mileage>, <Text3>:<working hours>

If the invoice is created with one of the above delivery types, additional information is required and
must be entered in invoice text. The required information must be defined with relevant Tax ID to be
reported correctly in corresponding XML tag. For invoices with tax code meeting specific criteria,
tags P_19A, P_19B and P_19C contain the texts defined with the same Tax Ids.

For P_20A, P_20B, P_21A, P_21B, P_21C, P_22A, P_22B and P_22C fields text defined in basic
data can be used — as well as can be entered using the Invoice Text command. To be reported
correctly in XML, the text must be defied in specified format with colons and commas as delimiters.

® > Financials > Customer Invoice > Basic Data > Invoice Texts £ company | Dan Poland

Invoice Texts

= Y B v 7 E v
Ending
v : TextID Text Text
P_19C ZwohienE na prodstawie: Art 43 Ustawy Ordynacja podatkowa m
P_198B Zwohiene na podstawie: Artr_ 100 dyreRywy 2006/112AVE m
P_19A Zwohiene na podstawie: Artr.34 uSt. 1-9 Ustawy o podatku Od towaréw | m
p_22 <Textl=:< registration date><Text2>:<mileage=><Text3=<working hours= m
P_21 Przedstawicél podatkowy: FOKUS, adres: 25-908 Reszow ULZEnuwt 12, m
P_20A <Text1>:<collector's name=> <Text2><collector's address> m

3.9.3.5 Define Correction Reasons

Go to the Financials/Customer Invoice/Basic Data/lnvoice Correction Reason page. Define
correction reasons to be used on correction invoices.

If the correction invoice is created, information about reason of the correction is required and must
be entered in Correction Reason field on invoice details tab. Correction reasons defined in basic
data can be used — as well as can be entered in the field on invoice details tab.
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@ > Financials > Customer Invoice > Basic Data > Invoice Correction Reasons &> Company
Invoice Correction Reasons
= Y | B v t 4 = v
Correction
v H Reason ID Correction Reason Vahnl\ry
INVTAX Invalid Tax Active
ERR Error Active

3.9.4 DEFINE AUDIT FORMAT BASIC DATA

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows. Click New, select the Country
as “Poland”, Report Type as “SAF-T” and save. If the audit file is run on batch mode, the XML can
be downloaded from the Batch Processed Audit Files page.

Click the Audit File Basic Data command to open Audit File Basic Data page.

® > Accounting Rules > Audit Interface > Basic Data > Audit Formats

Audit Formats

iz v © v + Vs & B B v Audit File Basic Data Audit File Tax Information Audit File Log B v

Thousands Negative  Leading

"t | counmy ReportType  Decimal Symbol | Seperator Format  Zeroes  Time Format Dare Format File Type File Template 1D Default
: | POLAND SART (point) , (comma) -9 09 13:59 YY-MM-DD

This opens Audit File Basic Data page. The new tab, SAF-T Poland Setup is added with ten
sections. For JPK_FA below sections are applicable:

® > AccountingRules > AuditInterface > Basic Data > Audit Formats> Audit File Basic Data & Company  Polish company

Audit File Basic Data

4 o}
HEADER STANDARD AUDIT CODE MAPPINGS <«
7 o]
General Info
Tax Office ID Address ID
0202 v Al v
Misc Parameters
Person ID Invoice Series for SAD
MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v
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General Info section
e Tax Office ID - select from list of values; only values from legal list will be accepted by tax
office.
e Address ID - specify company address ID. The address should be defined with all details.

Delivery Types for Specific Procedures (JPK_FA) section
e P_20, P_21, P_22 — enter delivery types to be used as selection criteria for the invoices to
be reported in corresponding XML file fields; use list of values; multiple values can be entered
for each field.
e VAT on Cash — enable this radio button, if there are invoices with cash basis method used in
tax operations.

Delivery Types/Customer Groups for Specific Procedures section
o (V7IM)MR_T/(FA) P_106E_2 and (VIM) MR_UZ/(FA) P_106E_3 — enter delivery types to be
used as selection criteria for the invoices to be reported in the corresponding <P_106E_2>
tag and <P_106E_3> tag of the XML file; use list of values; multiple values can be entered
for each field.

Invoice Type Mappings section
In the Invoice Type Mappings section, connect the invoice types and series. Only the invoice types
connected are reported in JPK_FA.
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® Accounting Rules > AuditInterface > Basic Data > Audit Formats > Audit Flle Basic Data

Audit File Basic Data

Ve ®

HEADER STANDARD AUDIT CODE MAPPINGS
/7 m

General Info

Tax Office ID Address ID

0202 v Al >

Misc Parameters

Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

Involce T

ype nvolce Series

CUSTCOLCOR - Customer  KF - Customer Order Cort
CUSTORDDEB - Customet  ZK - Customer Order Invc
FP - Instant Customer Inv  FP - Instant Customer Inv
KP - Correction Instant C.~ KP - Correction Instant Ct

PREPAYDEB - Prepaymen  ZK - Customer Order Invc

PRJINV - Project Invoice PJ - Project Invoice

PRJINVCOR - Project Corrt  PJ - Project Invoice

Company Polish company

24 ~

]

3.9.5 CREATE SAF-T VAT INVOICES (JPK_FA) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.

On Start Option section select Online or Schedule.

And specify following:

_5\\\!5

e Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for

Poland.
o Audit Type: “JPK_FA”.

o Date From and Date Until: The start and end dates of the period to be covered in

SAF-T VAT Invoices report or:

e Period From and Period Until: The year and month range to be covered in SAF-T VAT

Invoices report.

o File Type: select the file type as “JPK_FA”

o File Template will show up automatically after File Type is specified.
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

.= Task Options =O= SAF-T PL Additional Parameters = Schedule Schedule Options

Start Option

@ start now

() schedule
Parameters
Company Country Report Type

DAN POLAND - Dan Poland ~ | POLAND ~ | SAF-T -
Audit Type Audit Source Ledger ID

JPK_FA -
File Type File Template

JPK_FA v | | JPK_FA_TEMPLATE -
Selection
Period/Date Range From Until

() Date 2020 8 2020 8
(@) Period

4 Previous b Next Finish Cancel

Click Next.

On SAF-T PL Additional Parameters specify:

e Selection Date — enter a criteria date to select invoices to be reported. Possible values are:
“Voucher Date”,” Invoice Date”, “Tax Liability Date” and Delivery Date”. “Voucher date” will
be prompted as default.

e Customer ID — enter a customer id to select invoices to be reported. Possible customer ids
will be listed in the List of Values.

e Customer Group — enter a customer group to select invoices to be reported. Possible
customer groups will be listed in the List of Values.

@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

O= Task Options =.= SAF-T PL Additional Parameters = Schedule Schedule Options

Date Type Customer Id Customer Group
Tax Liability Date * | % v | % -
4 Previous b Next Finish Cancel

Click Finish to generate the SAF-T VAT Invoice (JPK_FA) XML file. The file will be named as:
<Audit Type without brackets>_<Time stamp(yyyymmddhhmmss>.XML
e.g. JPK_FA_20170906124804.XML

The generated XML file is submitted to Polish Tax Office.
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3.9.6 INVOICE REPORTING IN XML

The transactions are classified in the XML using the Tax Group functionality in IFS Cloud. Tax Group
“KRS” is used for this purpose. The net amount and tax amount in invoice header (faktura) are shown
in below tags as per the classification.

Transaction Tax Tax Sub Group | Net Tax Value in
Rate Amount Amount <pP_12>
Domestic Sales 23% or | SPRZ-KRAJ-22 | P_13 1 P 14 1 23
22%
Domestic Sales 8% or | SPRZ-KRAJ-7 |P_13 2 P 14 2 8
7%
Domestic Sales 5% or | SPRZ-KRAJ-3 |P_13 3 P_14 3 5
3%
Domestic Reverse Charge | 0% NABPOD- P 13 4 P 14 4 00
DOST
Sales of Goods and | 0% ZAG P_13 5 P_14 5 np
Services - Taxable Outside ZAG-UE
Country ZAGB
ZAGB-UE
Domestic Sales 0% 0% SPRZ-KRAJ-0 P 13 6 N/A 0
Export EKSP-TOW
EU Delivery of Goods WDT
Tax Free Sales — Exempted | 0% SPRZ-KRAJ- P 13 7 N/A Zw
ZW
Tourism Services, Second | 0% SPN N/A N/A N/A
Hand Goods and Work of Art

Following transactions are specifically handled in XML.

3.9.6.1 Correction invoices

Following customer invoice types are considered as correction invoice in JPK_FA and identified by
“‘KOREKTA” value in <RodzajFaktury> tag.

e Customer Order Correction Invoice

e Customer Order Collective Correction Invoice

e Correction Instant Invoice

e Customer Order Rebate Credit Invoice

3.9.6.2 Prepayment invoices

Following customer invoice types are considered as prepayment invoice in JPK_FA and identified
by “ZAL” value in <RodzajFaktury> tag.

e Prepayment Based Debit Invoice

e Prepayment Based Credit Invoice

Additionally, delivery invoices matched with a prepayment-based invoices are considered as
prepayment invoices (ZAL) in JPK_FA.

Following amounts in invoice header (faktura), are fetched from customer order for prepayment
invoices.

e NetAmount (P_13_1,P_13 2,P_13 3,P_13 4,P_13 5,P_13 6,P_13 7)
e TaxAmount (P_14_1,P_14 2,P_14 3,P_14_4,P_14 5)
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Foreign currency transactions are recalculated to accounting currency using tax currency rate in
relevant invoice.

Il‘ ! h\\\

For all other invoices, the information is fetched from invoice.

3.9.6.3 Invoices with tax exempt transactions

For invoices with tax exempt transactions (belonging to tax sub group SPRZ-KRAJ-ZW) the
information in P_19A, P_19B and P_19C XML tags, is fetched from Invoice Texts with corresponding
Tax ID defined in basic data.

3.9.6.4 Invoices issued by Tax Collectors

Invoices issued by Tax Collectors are identified by delivery type specified in P_20 field in Delivery
Types for Specific Procedures (JPK_FA) section. The Invoice Text entered in invoice header will be
shown in P_20A and P_20B tags.

3.9.6.5 Invoices issued by Tax Representatives

Invoices issued by tax representatives are identified by delivery type specified in P_21 field Delivery
Types for Specific Procedures (JPK_FA) section. The Invoice text entered in invoice header, is show
as below in the XML.

P_21A: Tax Representative

P_21B: Address of the Tax Representative

P_21C: Tax ID number of Tax Representative

3.9.6.6 Invoices related to delivery of new means of transport

Invoices related to delivery of new means of transport in EU are identified by delivery type specified
in P_22 field in Delivery Types for Specific Procedures (JPK_FA) section.

Invoice text entered in invoice header, is show as below in the XML.
P_22A: Date of Registration

P_22B: Course of transport

P_22C: No of hours spent

3.9.6.7 Invoices related to secondhand goods or work of art
Invoices related to secondhand goods or work of art are identified by delivery type specified in the
(V7M) MR_UZ/(FA) P_106E_3 field in the Delivery Types/Customer Groups for Specific Procedures

section. The additional information is required in P_106E_3A XML tag. This information is fetched
from specified Delivery Type Description.

3.9.6.8 Invoices related to tourism services

Invoices related to tourism services are identified by delivery type specified in the (V7M) MR_T/(FA)
P_106E_2 field of the SAF-T PL Parameters tab.

3.9.7 DELIMITATIONS

None
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3.10 SAF-T For Poland — Mixed Payment Report (JPK_WB)

3.10.1 SOLUTION — SAF-T PL MIXED PAYMENTS

The solution is based on IFS Cloud standard functionality of Mixed Payments and the Audit Interface
functionality.

In order to support the requirement for the SAF-T PL Mixed Payment report, the following has been
done:

New report type SAF-T added to the Audit Formats page.

¢ In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

e In Task Options on Audit Interface Assistant page, new Audit Type field has been added to
select relevant SAF-T report. In SAF-T PL Additional Parameters in Audit Interface
Assistant page Short Name field specific for the SAF-T WB has been added.

¢ New external file template JPK_WB_TEMPLATE has been added to support specific SAF-T
reports.

Process Overview

« Enter JPK General Info - Tax Office ID and Company Address ID

Define Basic Data

» Mixed Payments with Approved state should be present
» Update General Ledger
UJOEN eI« Fetch the tax ledger information

Ledger and Fetch
Tax Leder Info

* Run "Audit Interface Assistant"

* Select country as "Poland"

« Enter report type SAF-T and audit type JPK_WB
« Select date or period range

OICECNIE QNI - Select Cash Account Short Name

3.10.2 PREREQUISITES

Following prerequisites should be satisfied in order to generate SAF-T PL Mixed Payments xml file
for auditing purposes.

. The company must be set-up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by default.
. It is recommended to create the company using Standard Polish Template (STD-PL).
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. Mixed Payments with status Approved must exist in company.
3.10.3 DEFINE COMPANY BASIC DATA

3.10.3.1 Define Company Address Details (Standard functionality)

Open the Application Base Setup/Enterprise/Company page. On the Address sub menu click the
View Detailed Address command. The following fields must have values:
e Street
e House: Numberl/Number2 format, where Numberl is house number and Number2 is
apartment number
¢ Community

e District
X Edit Detailed Address
Street House No Community
Lopuszanksa| 123 Okecle
District
Wiochy
oK Cancel

3.10.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/Tax Office page. On the General sub menu, define
Tax Office for Poland — one from the list published on tax authority’s website. For example
‘02027, “1010”, “3030” ...

® > Application Base Setup » Enterprise » Tax » Tax Office » =
Search agvanced R
Tax Office * Name:PL% ~ @ CreationDate ¥ More ¥ @ Favorites  Clear Q } Semings

Sort by

Tax Office oz02-pimaxofficenan ¥ 101
0202

« + 72 ® B m- ©
Name: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 English h
Tax Report Name Country
PL Tax Office Dan POLAND v

Creation Date

8/4/2020
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On the Tax Report sub menu, enter the Company, Tax ID Number and Our Identity. Our identity is
a National Business Registry Number of company and will be copied in tag <REGON> in XML file.

@ > Application Base Setup » Enterprise > Tax > Tax Office » Tax Report =
sortoy v

Tax Repo Ft varpL-vareL ¥ 10f1
VAT PL

« B o~
MName: VAT PL
Address
Communication Method Tax Office Narme
Tax Report £ VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ¥

Q + | / m ]
Company Tax ID Number Qur Identity Electronic Tax ID State Code
AMKA-PLN PL 2337684748 123456789 vatplol WN hd

State Name

warminsko-mazurskie

Tax Report Info

Tax Report

VAT-2020 - Vatr 2020

Other parameters from General Info (Journal ID and Person ID) will not be used in JPK_WB file.
3.10.4 ENTER AUDIT FILE BASIC DATA

Click the command Audit File Basic Data to open Audit File Basic Data page.

N o ~
® > Accounting Rules > Audit Interface > Basic Data > Audit Formats &

company [ AMKA-PLN

Y Bmv + /£ E B B-v AuditFile BasicData | Audit File Tax Information  Audit File Log =,
Thousands Negotive  Leading
"/‘ Country ReportType  Decimal Symbol  Seperator Format  Zeroes  Time Format Date Format File Type File Template 1D Default
I | POLAND SAF-T  (point) . (comma) 9 09 13:59 YY-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.

The new tab, SAF-T Poland Setup contains ten sections. For SAF-T_WB report only data from
General Info should be defined.

e Tax Office ID
e AddressID
Data from the rest of group boxes are not used in creation of JPK_WB file.
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Audit File Basic Data

HEADER STANDARD AUDIT CODE MAPPINGS EETURRJe]RUPES:358) 4 4 »

7 o}
General Info
Tax Office ID

0202 v Al v
Misc Parameters
Person ID

MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) N
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

3.10.5 CREATE SAF-T MIXED PAYMENTS (JPK_WB) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On Start Option section select Online or Schedule.

And specify following:
o Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for
Poland.
e Audit Type: “JPK_WB” selected from List of Values.
o Date From and Date Until: The start and end dates of the period to be covered in
SAF-T WB report (XML can be created for one period or more or even for one day) or:
e Period From and Period Until: The year and month range to be covered in SAF-T WB report.
e File Type: select the file type for JPK_WB from List of Values.
e File Template will show up automatically after File Type is specified.
After entering all needed data select button Next.
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

.= Task Options =-O= SAF-T PL Additional Parameters = Schedule Schedule Options

Start Option

@) Start now

() schedule
Parameters
Company Country Report Type

DAN POLAND - Dan Poland - POLAND w | |SAF-T -
Audit Type Audit Source Ledger ID

JPK_WB -
File Type File Template

JPK_WB ~ | |JPK_WB_TEMPLATE -
Selection
Period/Date Range From Uniil
() Date 2020 9 2020 9
(@ Period

4 Pre S » Next Finish Cancel

On SAF-T PL Additional Parameters specify:
e Short Name: select Cash Account Short Name from List of Values
e Currency — will be changed automatically for Cash Account Currency (default value is
accounting currency)

@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company | Dan Poland

Audit Interface Assistant

O= Task Options =-.= SAF-T PL Additional Parameters = Schedule Schedule Options

Currency Short Name
PLN ¥ | | BRE-PLN -
4 Previous » Next Finish Cancel

Press the button Finish and file will be saved.
If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed Audit
Files page.

In created XML file values in tags like Opening Balance or Transaction Amount are fetched from
approved Mixed Payments created for Cash Account selected in Audit Interface Assistant.

3.10.6 DELIMITATIONS

None
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3.11 SAF-T For Poland — Accounting Books (JPK_KR)

3.11.1 SOLUTION — SAF-T PLACCOUNTING BOOKS

The solution is based on IFS Cloud standard functionality of Accounting Journal, Turnover and
Balance Report, GL Voucher Rows Analysis, and the Audit Interface functionality.

In order to support the requirement for the SAF-T PL KR report, the following has been done:

o New report type SAF-T added to the Audit Formats page.

¢ In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data. For generation of JPK_KR only values from
group box General Info will be used.

o Task Options in Audit Interface Assistant page, new Audit Type field has been added to
select relevant SAF-T report.

~

« Enter JPK General Parameters - Tax Office ID, Company Address ID and Journal ID

Define Basic Data

)

~

* Run "Audit Interface Assistant"

« Select country as "Poland"

« Enter report type SAF-T and audit type JPK_KR
» Select date or period range

Create JPK XML File

3.11.2 PREREQUISITES

Following prerequisites should be satisfied in order to generate SAF-T PL Accounting Books xml file
for auditing purposes.

e The company must be set-up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by default.

e Itis recommended to create the company using Standard Polish Template (STD-PL).

o All transactions from period being of subject of XML file must be updated into General Ledger
and Accounting Journal for the same period must be defined and created.

e In XML file there are tags <TypKonta>, <KodZespolu> and <OpisZespolu> which can be
filled only with manually added two new attributes in Accounting Rules/Code Part Attributes
(ID-s of attributes are hard coded):
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o ZESPOL connected with Account.

o TYP_KONTA connected with Account.

&5 @ > Accounting Rules > Code String > Code Part Attributes Company | Dan Poland

Code Part Attributes

= ¥V B v | /

o I Attribute . Description Code Part Name
ZESPOL ZESPOL Account
TYP_KONTA TYP_KONTA Account
RZIS1 Rachunek zyskéw i strat-  Account

¢ BILANS Bilans Account

A,
7\\\ IFS

There are recommendations to use the following values for above attributes.

1. ZESPOL

=2 @ > Accounting Rules > Code String > Code Part Attributes > Attribute Value Company | Dan Poland

Attribute Value zsroL-zespor v 10f1

»> | g ] Fo N Connect Attribute

Attribute

ZESPOL - ZESPOL

Code Part Name

Account

Code Part Attribute Values

=Y | B v f 7

s i Attribute Value Description
9 Konta statystyczne
i 8 Kaptab' whsne
i7 Przychody i koszty ich uzyskania
L Produkty i rozliczenia miedzyokresowe
i 5 Koszty w ukhdzie kalkulacyjnym
14 Koszty wedaug rodzajow
i3 Materiab' i towary
:2 Rozra ch Oki i roszczenia
LI In westy cje krotkotermino we
FE] Aktywa trwale
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2. TYP_KONTA

I

=> @ > Accounting Rules > Code String > Code Part Attributes > Attribute Value ~ Company
Attribute Value e xonma-tvekonma v 1of1

> } w R~ Connect Attribute Q

Attribute

TYP_KONTA - TYP_KONTA

Code Part Name

Account

Code Part Attribute Values

= Y oRB v } 7 = v
v i Atribute Value Description
. WYNIKOWE Konta wynikowe
ROZLICZENIOWE Konta rozliczeniowe
i POZABILANSOWE Konta pozabilansowe
BILANSOWE Konta bilansowe

The Attribute ZESPOL must be created because the tag <KodZespolu> is obligatory in XML. If such

Attribute does not exist or some Account used in transactions is not connected with this Attribute —
the XML is created with errors.

If Attribute TYP_KONTA is not created, or some used Account is not connected with Attribute in tag
<TypKonta> - in XML values from Accounting Rules/Code String/Account Types connected with
used account will be selected. So, the user can choose to use an Attribute or Account Type.

3.11.3 DEFINE COMPANY BASIC DATA

3.11.3.1 Define Company Address Details (Standard functionality)

Open the Application Base Setup/Enterprise/Company page. On the Address submenu, click the
command View Detailed Address. The following fields must have values:
e Street
e House: Numberl/Number2 format, where Numberl is house number and Number2 is
apartment number
e Community
e District
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X Edit Detailed Address
Street House No Community
Lopuszanksa{ 123 Okecie
District
Wiochy

oK Cancel

3.11.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define Tax

Office for Poland — one from the list published on tax authority’s website. For example
“02027, “10107, “3030” ...

. » Application Base Setup > Enterprise » Tax » Tax Office » Tax Report 9

Sortby
Tax Report VATPL-VATPL ¥ 1of1
VAT PL
€ B v
Name: VAT PL
Address
Communication Method Tax Office Mame
Tax Report £ VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ¥

Q + & ] B

Company Tax ID Number Our Identity Electronic Tax IO State Code

AMKA-PLN PL 2337684748 123456789 vatplo1 WN A

State Name

warminsko-mazurskie

Tax Report Info

=Y B v + 7
s i TaxRepor
(] & WVAT-2020-Var 2020

[ 3 VATIM-VATIM

On the Tax Report sub menu, enter the Company, Tax ID Number and Our Identity. Our identity is
a National Business Registry Number of company and will be copied in tag <REGON> in XML file.
3.11.3.3 Define Journal ID (Standard functionality)

In order to create XML file JPK_KR at least one Accounting Journal (General Ledger/Accounting
Journal) must be defined and created.
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In the case when more than one Accounting Journal are defined all of them must be created
(Accounting Journal/Create Accounting Journals) and all of them will be included in created JPK_KR
file.

3.11.4 CREATE SAF-T MIXED PAYMENTS (JPK_KR) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On Start Option section select Online or Schedule.

And specify following:
e Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for
Poland.
e Audit Type: “JPK_KR” selected from List of Values.
e Date From and Date Until: The start and end dates of the period to be covered in
SAF-T KR report (XML can be created for one period or more but only from one year) or:
e Period From and Period Until: The year and month range to be covered in SAF-T KR report.

[ ] Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

.— Task Options == Schedule Schedule Options

Start Option

@‘ Start now

"C:" Schedule
Parameters
Company Country Report Type

POLCOM - POLCOM - POLAND - SAF-T A4
Audit Type Audit Source Ledger ID

JPK_KR. -
Selection

Period/Date F:EH@:" From unti

(O Date 2023 8 2023 8
@‘ Period

Finish ~ Cancel

Press the button Finish and file will be saved.
If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed Audit

Files page.

In order to check if values in XML tags are correct a Turnover and Balance Report should be created
for the same period and values from this report should be compared with values in block ZOiS.
Values from block Dziennik should be compared with values in Journal Report created for the same
period. Values in block KontoZapis can be compared with values in General Ledger Report.
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3.11.5 DELIMITATIONS

None
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4 Reposting of Currency Difference on Tax
4.1 Overview Legal Requirement

According to Polish Income Tax Law there are two ways for handling currency rate differences:

e Directly according to Income Tax Law (art. 15a)

e Following the Accounting Law (art. 9b ust. 1 pkt 2)
First method is the default and most of companies use this method. When using this method,
currency differences at payment are considered as revenue/cost for income tax only in part related
to net amount and non-deductible tax amount. Currency differences related to deductible VAT are
not considered as revenue/cost.

4.2 Solution

Standard solution is used in order to create currency differences postings (PP12 and PP13), that is,
differences related to gross amount.

In addition, the following new postings are added for differences related to deductible vat amount:
e PP81 - Currency Loss, Tax Related Difference
e PP82 - Contra Account, Currency Loss, Tax Related Difference
e PP83 - Currency Profit, Tax Related Difference
e PP84 - Contra Account, Currency Profit, Tax Related Difference

4.2.1 OVERVIEW PROCESS

Enter Supplier
Define Basic Invoice/ Enter

and Approve

Data Create and Print Payment

Customer Invoice

4.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set Up chapter. The
parameter “Reposting of Currency Difference on Tax” should be enabled.

4.4 Define Basic Data

Follow the IFS Cloud standard process to define basic data:
¢ Inthe Payment Terms page, define payment terms. Note that the value selected in the Tax
Distribution field affects the calculation logic.
e In the Posting Control page, make sure to have standard posting types PP12 and PP13
defined.

4.4.1 NEW POSTING TYPES

New posting types PP81, PP82, PP83 and PP84 are available in the Posting Control page.
e PP81 - Currency Loss, Tax Related Difference
e PP82 - Contra Account, Currency Loss, Tax Related Difference
e PP83 - Currency Profit, Tax Related Difference
o PP84 - Contra Account, Currency Profit, Tax Related Difference
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The new posting types are used according to the following rules:

In case of PP12 Currency Loss (debit)
e PP81 is used to repost currency difference related to deductible tax amount (debit)
o PP82 is used to clear currency difference related to deductible tax amount from PP12
account (credit)

In case of PP13, Currency Profit (credit)

e PP83is used to repost currency difference related to deductible tax amount (credit)
o PP84 is used to clear currency difference related to deductible tax amount from PP13
account (debit)

Follow the IFS Cloud standard process to define new posting types in the Posting Control page.

4.5 Enter Supplier Invoice/Create and Print Customer Invoice

Follow the IFS Cloud standard process to enter foreign currency supplier invoices.
Follow the IFS Cloud standard process to create and print foreign currency customer invoices.

4.6 Enter and Approve Payment

Follow the IFS Cloud standard process to enter and approve payment in the Mixed Payment page
or other payment page.

Amounts to be reposted with the new posting types depend on the tax distribution.

Tax Distribution Installment | Reposting Logic
ID
Even All Amount to be reposted considers

deductible tax as evenly distributed on
all installments.

First Installmentonly Tax | 1 Amount to be reposted considers
deductible tax as fully included in the first
instaliment.

First Installment only Tax | Other than 1 | No amount is reposted.

All Tax on First Installment | 1 Amount to be reposted considers

deductible tax as fully included in the vat
portion of the first installment.
All Tax on First Installment | Other than 1 | No amount is reposted.
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Example 1: Tax distribution “Even” and currency loss calculated

\\\\

Invoice type customer invoice

Net amount 100

Deductible tax amount 23

Currency rate at invoice entry 4

Currency rate at payment 3.5

Payment Posting Method field on the | Gross

Company/Payment/General tab

Currency difference (123 * 4) - (123 * 3.5) = 492 - 430.50 =
61.50

Currency difference related to net

61.50 * (100/123) = 61.50 * 0.81300813 =
50

Currency difference related to tax

61.50 - 50 = 11.50

M28, Taxable Sales

| 100,00 USD (4) 400,00

Purple color: New posting types.
Green color:  Net balance on the currency different account.
P2, Customer Claims
(1) Invoice 123,00 USD {4) 492,000 123,00 USD(3,5) 430,50 (2) Payment
Entry
0,00 USD(3,5) 61,50 (2) Payment
PP12, Currency Loss
2) 0,00 USD(3,5) 61,50

Payment

P4, Tax Disbursed, Invoice

| 23,00 USD(4) 92,00

(1) Invoice
Entry

(1) Invoice
Entry

PP82, Contra Account, Currency Loss, Tax Related Difference
| 0,00 USD(3,5) 11,50{(2)

| Additional

PP81, Currency Loss, Tax Related Difference

2) 0,00 USD(3,5) 11,50]
Additional

Example 2: Tax distribution “Even” and currency profit calculated

the
tab

Company/Payment/General

Invoice type customer invoice
Currency rate at invoice entry 4

Currency rate at payment 4.5

Payment Posting Method field on | Gross

Currency difference

(123 * 4) - (123 * 4.5) = 492 - 553.50 = -61.50

Currency difference related to net

-61.50 * (100/123) = -61.50 * 0.81300813 = -50

Currency difference related to tax

-61.50 - (-50) = -11.50

Purple color:
Green color:

New posting types.

Net balance on the currency different account.

IFS
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1P2, Customer Claims

(1) Invoice 123,00 USD (4) 492,00 123,00 USD (4,5) 553,50
Entry
(2) Payment 0,00 USD (4,5) 61,50

PP13, Currency Profit

0,00 USD (4,5) 61,50

(2) Payment

(2) Payment

2,

M28, Taxable Sales

100,00 USD(4) 400,00 (1) Invoice
Entry

IP4, Tax Disbursed, Invoice

23,00 USD(4) 92,00 (1) Invoice
Entry

PP84, Contra Account, Currency Profit, Tax Related Difference

(2) 0,00 USD (4,5) 11,50
Additional

PP83, Currency Profit, Tax Related Difference

0,00 USD(4,5) 11,50 (2)
Additional

4.7 Delimitations

When specific tax currency rates are enabled for the company, and the tax code used for the
transaction has tax method as payment entry, the tax currency difference is handled through PP61
(Tax Currency Loss) /PP62 (Tax Currency Profit) postings in core application. In that case, if any
duplication of entries arises with the above functionality, those have not been specifically handled.
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5 Currency Rate Date and Voucher Date Extended
Capabilities for Outgoing Invoices

5.1 Overview Legal Requirements

According to legal regulations in countries like Hungary, Czech Republic, Slovakia or Poland, date
of posting of debit sales invoices, as well as currency rates used for posting, should be based either
on invoice date or on delivery date, depending on type of transaction.

Also, according to legal regulations in Poland, prepayment based invoices should be posted with the
date of the payment which is the base for the invoice.

5.2 Solution Overview

Process Overview
Standard invoicing flow is used in the solution:

Create

Modify

Define Basic Print and Post

Customer
Invoice

Customer
Invoice

Data Invoice

Solution Summary
New field Delivery Date is added to handle delivery dates on project invoices.

Handling of default value of the Latest Ship Date field on prepayment based invoices is modified,
so that payment date could be the base for posting of the invoice.

New fields Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added to
define base for voucher date, currency rate and tax currency rate for invoices. The fields are added
on customer order invoices, instant invoices and project invoices. Either invoice date or delivery date
can be the base for voucher date and currency rates.

New fields are added on company and customer level as sources of default values for new fields on
invoices mentioned above.

5.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set up chapter and the
“Currency Rate Date and Voucher Date Extended Capabilities for Outgoing Invoices” parameter
must be enabled on the Company/Localization Control Center tab.

5.4 Set up Basic Data

Settings on Company level
New field Outgoing Invoice Voucher Date Base is added on the Company/Invoice/General tab.
Available values are: “Invoice Date” and “Delivery Date”.

Country Solution POLAND 111



IFS

7/\\\

Invoice swei-swee v 1on

L@ B
Company Name
SW-PL SW-PL
W DEFAULT INVOICE TYPES PO MATCHING ~ DOCUMENT MANAGEMENT
s W

Posting Parameters
Create Posting at Invaice Entry Same No Preliminary and Final Supplier Invoice

Accepted Invoice Voucher Difference in Accounting Currency Accepted Invoice Rounding Difference in Invoice Currency

Miscellaneous Parameters

Planned Payment Date Calculation Base Urigue Supplier Invoice No Per

Pay. Term Base Date ~  Supplier

Ltgoing Invoice Voucher Date Base pplier Invoice Authorization Only by Separate Function

elivery Date -

nvoice Date ique Payment Reference Validation
Delivery Date
||

Invoice Payment Reference No
Custamer Invoice Creation Method Supplier Invoice Validation Method
Not Used ~ Not Used -~

Attachments

vl
Assaciation No Created By
SASGLK
4
Same Date Preliminary and Final Supplier Invoice Use Posting Propasal
Incoming Invoice Currency Rate Base Outgoing Invoice Currency Rate Base
Invoice Date ~  Delivery Date -

Cash Discount Based on Gross Amount Set Invoice Date to Current Date When Printing Outgaing Invoices

Credit

Company Credit Limit

New field Tax Sell Currency Rate Base is added in the Company/Accounting Rules/Currency
Rate Type Information tab. The field is enabled when the Allow Specific Currency Rates for Tax
Transactions option is enabled. Available values are “Invoice Date” and “Delivery Date”.

Accounting Rules swei-swe ~ 1011

« P B~
Compariy Name
SW-PL SW-PL
i

Default Buy Currency Rate Type
1-Normal

Default Currency Rate Types for TAX

Allow Specific Currency Rates for Tax Transactiens

Buying Currency Rate for Tax

1- Normal

————
Tax Sell Currency Rate Base

Delivery Date -

nvoice Date

Delivery Date

Created By

SASGLK

Association No

Default Sell Currency Rate Type

- 1 - Normal

Selling Currency Rate for Tax

- 1 - Normal

Note: Apart from new fields mentioned above, the standard Outgoing Invoice Currency Rate Base
field on the Company/Invoice/General tab is used in this solution and it has to be set according to

the needs.
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Settings on Customer level

Following fields are added on Customer/Address/Delivery Tax Information tab: Voucher Date
Base, Currency Rate Base, Tax Currency Rate Base. Available values for these fields are “Invoice
Date”, “Delivery Date” and “Specified on Company”.

Address customersweL-customER sWPLe ¥ 161

L8P B~ Q
Customer Name Association No
CUSTOMER SWPL CUSTOMER SWPLe

Address ID: CUSPL ¥
+ | 2| W

End Customer

Customer's Own Address ID Customer Name End Customer Address Identity

GENERAL ADDRESS INFORMATION JMNVIZ:VRTVRUTRe /ATl DOCUMENT TAX INFORMATION |~ SALES ADDRESS INFORMATION 1)

Company: SW-PL-SW-PL ¥

/J Wl | B IPD Tax Information
Tax Withholding Tax Rounding Method Tax Rounding Level foucher Date Base
Blocked + Round 1o the Nearest ~  Specified on company « | [epedified on Company a
JCurrency Rate Base Tax Currency Rate Base Invoice Date
Del Ivery Date ~ Invoice Date -
Delivery Date
Specified on Company
Supply Country: POLAND ¥

PN |

5.5 New Fields on Invoices

Customer Order Invoice
New fields: Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added on

Customer Invoice/General tab. Available values for these fields are “Invoice Date” and “Delivery
Date”.

Note: In customer order invoice the Latest Ship Date field plays role of delivery date. “Delivery Date”
setting means that value of the Latest Ship Date field will be taken as a base for voucher date or
currency rate.

The Currency Rate and Tax Currency Rate fields are based on value of either the Invoice Date or

Latest Ship Date fields, depending on setting of the Currency Rate Base and Tax Currency Rate
Base fields.
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H Posted Auth
Customer INVOICe customer swpL - CUSTOMER SWPLe - 200700004 - CUSTORDDES - D550344 ¥ 5 of 24+
LK 7 B v Share v Credit/Correction Invoice v Posting Installment Plan and Discounts Notes Q
Customer No Customer Address Na_. ~ Series ID Invoice No Company Site Invoice Created Order Created
.CUSTOMER ... CUSTOMER SWPLe ZK 200700004 SW-PL SWPL 17/07/2021 17/07/2021
Amounts
Currency Gross Amt Net Amt Tax Amt Currency Rate Tax Currency Rate
usD 293.30 279.33 13.97 7.6 7.16
LINES HISTORY 4 4
Indicators
Invoice Type Price Adjustment Advance/Prepayment Invoice
CUSTORDDEB - Customer Order Invoice, Debit m m
Invoice Address Invoice Date Use Price Incl Tax Notes
@ CuspPL 17/07/2021 o o]
Printed Date Preliminary Invoice No Correction Exist Correction Invoice
17/07/2021 204701 m m
Our Reference Customer Reference
Correction Reason 1D Correction Reason
O nicowas Lecterca -
Customer Reference Name Branch
Customer Branch Jinsui Status
Non Jinsui
Payment Delivery
Pay Term Base Date Due Date Delivery Address Latest Ship Date
17/07/2021 27/07/2021 © cuspL 01/09/2021
Payment Terms Payment Reference Wanted Delivery Date Ship Via
10-10 Days 02/09/2021, 02:00 IFS APPLICATIONS
Delivery Terms Description Delivery Terms Location
IFS APPLICATIONS
Forwarder ID Label Note
References v | Invoice Text %
T R T T T T
Voucher Date Base Currency Rate Base Tax Currency Rate Base
Delivery Date Invoice Date Invoice Date

Instant Invoice

New fields Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added on
the Instant Invoice/General tab. Available values for these fields are “Invoice Date” and “Delivery

Date”.

The Currency Rate and Tax Currency Rate fields are based on value of either the Invoice Date or
Delivery Date fields, depending on setting of the Currency Rate Base and Tax Currency Rate

Base fields.
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H PostedAuth

Instant Invoice - 200700000 ~ —

& & } 7 1T} B~ More Information Installment Plan and Discounts Pre Posting Reprint Original Reprint Modified H Q
Customer Invoice Type Series ID Invoice No Project ID TRVOICE Date

. CUSTOMER SWPL - CUSTOMER ... FP FP 200700009 01/08/2021

Delivery Date Invoice Address Delivery Address Notes Advance Invoice Invoice Fee Correction Invoice Correction Exists
01/09/2021 CUSPL cusPL [ o] [ o] [ no | [ o] [ no |

Preposting Currency Currency Rate Voucher Date Base Currency Rate Base

m usD 9.1 Delivery Date Delivery Date

Tax Currency Rate Base Gross Amount Net Amount Tax Amount

Delivery Date 3622.50 3450.00 172.50

Payment and Tax Information

Pay Term Base Date Payment Terms Due Date Payment Method Payment Address ID
01/08/2021 10 - 10 Days 11/08/2021 -
Supply Country Tax Liability
POLAND TAX
Lines
Payment Reference Payer Language
| ‘ b CUSTOMER SWPL - CUSTOMER... ~ ‘ English -
Transfer Status Tax Currency Hate Our Reference
703 |
Customer Reference Creator Reference Signature
QOrder Date QOrder No Ref Invoice Series ID
Ref Invoice Mo Correction Reason ID Correction Reason
Branch Customer Branch Deduction Group
Deduction Amount Invoice Text ID Invoice Text

| -

Additional Reference

Cancel

Project Invoice

New field Delivery Date is added on Project Invoice/General tab. When invoice is created the field
gets the same value as Invoice Date. It can be modified when invoice is in state “Preliminary”.

New fields: Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added on
Project Invoice/General tab. Available values for these fields are “Invoice Date” and “Delivery
Date”.
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The Currency Rate and Tax Currency Rate fields are based on value of either the Invoice Date or
Delivery Date fields, depending on setting of the Currency Rate Base and Tax Currency Rate
Base fields.

H H Posted Auth

PI’O] ect Invoice » 20070002 ~ o——

& 72 B~ Notes Printout Credit Entire Invoice Create Carrection Invaice Customer Installment Plan q
Customer Customer Name Project nvoice Series

CUSTOMER SWPL CUSTOMER SWPLe PJ

Invoice No Invoice Period Start Invoice Period End Notes Invoice Text
200700032 01/07/2021 01/07/2021 o] o]

Amounts

CUI’I’EI“C}“ Gross Amount Net Amount Tax Amount

usD 2160.00 2000.00 160.00

LINES m PRE POSTING =~ ACCOUNTING 4 M

Invoice Information

Invoice Date Voucher Date Base Currency Rate Base Tax Currency Rate Base

01/08/2021 Delivery Date Invoice Date Delivery Date

Invoice Type series Reference Invoice Number Reference ey Rate

PRJINV 8.1

Our Reference Customer Ref Order No Tax Currency Rate
80.1

Voucher Type Voucher No Correction Invoice Correction Reason ID

F 2021000106 o]

Correction Reason Correction Exist Div Factor Currency

o] 1 uUsD

Customer Information

Invoice Address Delivery Address Payment Address Media Code
CUsPL CUSPL
Pay Term Base Date Due Date elivery Date Payment Terms
01/08/2021 11/08/2021 19/08/2021 10-10 Days
Branch Site Payment Method Supply Country Customer Branch

DOl AND

Tax ID Number

214234234

5.6 Process Invoices

General

New functionality to define the base for voucher date and currency rates is added for following types
on invoices:

e Customer order invoices — normal debit invoices (invoice type CUSTORDDEB), collective
debit invoices (invoice type CUSTCOLDEB) and prepayment based debit invoices.

¢ Instant invoices — normal instant debit invoices (invoice type INSTINV).

e Project invoices — debit invoices (invoice type PRJINV).
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For all other invoices currency rates and voucher date are handled in a standard way. In particular
for correction invoices, as well as for credit customer order and project invoices, the Voucher Date
Base, Currency Rate Base and Tax Currency Rate Base fields are always set to hidden.

Create Invoice

When debit customer invoice (customer order invoice, instant invoice, and project invoice) is created
then the Voucher Date Base, Currency Rate Base and Tax Currency Rate Base fields get default
values based on settings on customer level. Fields which are set to “Specified on Company” on
customer level get values based on settings on company level.

Note: When the Currency Rate Base field on customer level is set to “Specified on Company” then
the Currency Rate Base field on invoices for this customer will get default value based on setting
of the standard Outgoing Invoice Currency Rate Base field for company.

When prepayment based invoice is created then the Latest Ship Date field gets default value equal
to date of payment. In standard solution this field is empty when invoice is created.

Modify Invoice
Values of the Voucher Date Base, Currency Rate Base and Tax Currency Rate Base fields can
be modified when debit invoice is in the “Preliminary” state with following exceptions:

e The Tax Currency Rate Base field can be modified only when the Allow Specific Currency
Rates for Tax Transactions option for company is enabled.

¢ On instant invoice the Currency Rate Base and the Tax Currency Rate Base fields can be
modified only before invoice line is entered.

Whenever the Currency Rate Base or the Tax Currency Rate Base fields get modified, values in
the Currency Rate or the Tax Currency Rate fields are updated accordingly.

Print and Post Invoice
When invoice gets printed then it will be posted with voucher date based on value in the Voucher
Date Base field. If the Voucher Date Base field is set to “Invoice Date” then voucher date will be
equal to value of the Invoice Date field. If the Voucher Date Base field is set to “Delivery Date” then
voucher date will be equal to value of the Delivery Date field (or the Latest Ship Date field in
customer order invoice).

Note: Value of the Voucher Date Base field has no impact on voucher date of invoices in following
cases:

o When invoice is printed from the Print Invoice page with the Use Voucher Date option
enabled.

¢ When invoice is processed from the Customer Invoices with Errors page with the Use
Voucher Date option enabled.

e When invoices are processed from the Create Collective Vouchers page.

5.7 Delimitations

¢ Manual customer invoices are not handled.
e Qutgoing supplier invoices are not handled.

Country Solution POLAND 117



2,
Z-IFS

6 Discounted Price Rounding

6.1 Overview Legal Requirement

According to Polish VAT regulations, the invoices have to include price discounts. The discounted
price must be rounded to two decimals and net amount must be calculated as discounted price
multiplied by quantity. Currently, in IFS Cloud standard version, the net amount is calculated as price
* guantity, then discounts are applied, and the discounted price is rounded. The difference in
calculations in Standard and the Polish localization result in slightly different values.

6.2 Solution

In order to comply with the Polish VAT regulations, and business practice, the calculation has been
changed accordingly to fit Polish requirements.
e The percentage (%) is recalculated in such a way, so that the standard algorithm for net
amount calculation becomes usable for Polish customers.

e The calculation on the net amount is not changed.

The rounded discounts are presented on sales quotation line, customer order line and customer
invoice line in as follows:
e Discount

e Group Discount
e Additional Discount

New discount calculation is used on customer invoice report and when invoice postings are created.

6.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set up chapter and the
‘Discounted Price Rounded’ parameter must be enabled.

6.4 Comparison

In IFS Cloud standard version, the net amount is calculated as price * discount * quantity and the
result is rounded to two decimals: round (price * (1-discount %) * quantity, 2).

According to the Polish requirements the net amount should be calculated as rounded discounted
price multiplied by quantity, according to the following formula: round(round(price * (1-discount %),2)
* quantity, 2).
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Net amount calculation
STANDARD way
round(1,2*0,99*1000; 2)

2,

Polish way

round(round(1,2*0,99; 2) *1000; 2)

Net Amount 1188 Net Amount 1190
Discounted Price 1,188 Discounted Price 1,19
Detailed Standard Algorithm Example
o 1 Apply Order Line Discount

Discounted Price: 2,77 * (1 - 0,10) = 2,493

e 2a Apply Group Discount

Discounted Price: 2,493 * (1 - 0,10) = 2,2437
e 2Db Apply

Discounted Price: 2,493 * (1 - 0,05) = 2,36835

Final Discounted Price: 2,77 - 0,28 - 0,2493 - 0,12465 = 2,11905
e Expected Net Amount: round(2,11905 * 1000; 2) = 2119,05

Net amount rounding in standard:

Customer Order oo v 202

» & + & ® B v Status v Share w Operations v Freight Invoice Related Pagas Copy Order o]/

Order No Customer Site QOrder Type Wanted Delivery Date/Time

03030 €HY HP-SEK-ECUST1 - Customer HP-S5EK-ECU HPS1 HP1 2021-06-08 00:00

Order Amounts

Total Net Amount/Base Total Contribution Margin...  Contribution Margin{%) Total Net Amount/Curr Total Tax Amount/Curr Total Gross Amount/Curr
(™ 2119,05000 SEK 1119,05000 SEK 52,81 ™ 2119,05000 SEK [ 529,76000 5EK ™ 2648,81000 SEK
RENTAL LINES  ORDER DETAILS CHARGES INVOLVED PARTIES
Vo o + &
Sales Part Group Additional = Tetal Order Line Discount Met
- : # | Sales Part Mo Description Sales Quy Price/Base  Discount (%) Discount (%) Discount (%) Discount (%) ~ Amount/Curr  Amount/Base
& | HP-SEK-NONTRACKED | Non tracked 1000 2.77000 10 10 5 235 277,00000  [2119,05000

Additional Discount
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Detailed Polish Algorithm Example

o 1 Apply Order Line Discount
Discounted Price: round(2,77 * (1 - 0,10); 2) = 2,49

e 2a Apply Group Discount
Discounted Price: round(2,49 * (1 - 0,10); 2) = 2,24

e 2b Apply Additional Discount

Discounted Price: round(2,49 * (1 - 0,05); 2) = 2,37
e Final Discounted Price: 2,77 - 0,28 - 0,25 - 0,12 =2,12
e Expected Net Amount: round(2,12 * 1000; 2) = 2120

Net amount rounding in the Polish localization:

Customer Order oz v 142

> & + & ® 2 v Status Share Operations Freight ~ nvoice Related Pages v Copy Order Ordern

Order No Customer Site Order Type

03031 BN HP-PLCUST - HP-PLCUST HPPL1 NO

Order Amounts

Total Net Amount/Base Total Contribution Margin Contribution Margin(3)

(™ 530,00000 EUR ®= 2650,00000 EUR

™= 2120,00000 EUR 1120,00000 EUR 52,83
RENTAL LINES = ORDER DETAILS CHARGES INVOLVED PARTIES
Y B v + 4
Sales Part Group Additional | Total Order Line Discount Net
- H # | sales Part No Description Sales Quy Price/Base Discount (%) = Discount (%) Discount (%) Discount (%) ~ Amount/Curr = Amount/Base
& | HP-POLISHPART HP Palish part 1000 277000 10 10 5 235 280,00000 2120,00000

6.5 Group Discount & Additional Discount

Group Discount and Additional Discount are added together but are compound (not simply added
percent) with Order Line Discount. This is standard functionality and is not changed by the Polish
functionality. See standard calculation below:

Price * (1-discount%) * (1 - (group_discount% + additional_discount% ) ) * quantity
The functionality is adding rounding at every discount type calculation. The discounted price

(technically discount amount) is rounded after each discount type is applied. The rounded value after
Order Line Discount is used as a calculation basis both for Group Discount and Additional Discount.

Example 1
Assume that Line Discount, Group Discount and Additional Discount are set to 1 %; the calculation
basis (sales price) equals 1,20.

The net amount and discounted price is calculated as follows:

1. Applying Order Line Discount
Discounted Price: round(1,20 * 0,99, 2) = 1,19
(discount amount = 0,01)
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Applying Group Discount
Discounted Price: round(1,19 * 0,99, 2) = 1,18

(discount amount = 0,01)

Applying Additional Discount
“Discounted Price”: round(1,19 * 0,99, 2) = 1,18 (final price is 1,17)

(discount amount = 0,01).

Note: Base calculation for both Group Discount and Additional Discount is the same.

Final Discounted Price: 1,20 -0,01-0,01-0,01=1,17

Expected Net Amount should be calculated as “final” discount price times quantity
Net Amount; round(1,17 * 1000, 2) = 1170
If each discount is recalculated in the described way then the net amount is calculated
properly by using the existing algorithm.

%

Example 2:

Assume that

Line Discount = 10%
Group Discount = 10%
Additional Discount = 5%
Sales price = 2,77
Quantity = 1000

The net amount and discounted price is calculated as follows:

1.

2.

3.

4.
5.

Applying Order Line Discount

Discounted Price: round(2,77 * 0,90, 2) = 2,49
(discount amount 2,77 - 2,49 = 0,28)

Applying Group Discount

Discounted Price: round(2,49 * 0,90, 2) = 2,24
(discount amount 2,49 - 2,24 = 0,25)

Applying Additional Discount

“Discounted Price”: round(2,49 * 0,95, 2) = 2,37
(discount amount 2,49 - 2,37 = 0,12)

Final Discounted Price: 2,77 - 0,28 - 0,25 - 0,12 =2,12
Expected Net Amount: round(2,12 * 1000, 2) = 2120

The discount entered by the user in Customer Order Line Discount assistant, in the Additional
Discount field or fetched from Discount Group settings are stored in the three new columns which
have been added to Sales Quotation, Customer Order and Customer Invoice: Original Discount,
Original Additional Discount and Original Group Discount and displayed in existing columns:
Discount, Additional discount and Group Discount.

6.6 Delimitations

When Price Including Tax is selected then standard method of discount calculation is used on sales
guotation, customer order and invoice.
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7 Specific Data for Customer Invoice Reports

7.1 Overview Legal Requirement

The invoice layouts released with IFS Cloud standard version meet all the legal requirements for
Poland. There are some additional data which are typically printed on the invoices generated by
Polish companies that does not exist in the standard layouts.

7.2 Solution

The additional data fields are added to customer invoice report definition files (.RDF). This allows to
define new invoice report layouts according to requirements from Poland. Example data added are
company addresses, company tax id, information regarding VAT and gross amount. Also, some
changes in the existing functionality, e.g., presenting delivery address on collective invoices. New
Tax Character field is added to the Tax Codes page to group the tax types.

The following invoices reports are affected:

e Customer Order Invoice

e Customer Order Collective Invoice
e Prepayment Based Invoice

e |nstant Invoice

Note
Generated xml file can be extracted from the Print Manager page. Select the relevant report RMB,
“save xml Data” will facilitate you to download xml to the local machine.

The major changes are:

* Company payment and document addresses are added to the report header

» Tax amount and gross amount are added to the report lines

* Company Tax ID is presented differently depending on whether the goods are delivered to a
domestic or a foreign customer

* Translatable texts TF or NT are added to invoice line depending on tax character attribute of tax
code (in Polish ZW, NP).

» Customer delivery address is added to the header of the collective invoice report when the address
is the same on all the invoiced orders. Otherwise, it will be presented in each invoice line separately

7.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set up chapter and the
“Specific Data for Customer Invoice Reports — Poland” parameter must be enabled.
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7.4 Set Up Basic Data Accounting Rules

The new column Tax Character is added to the Tax Codes page. The allowed values are “Normal”,
“Tax Free”, “No Tax” and “Export”. The value is set to “Normal” by default.

Tax Codes
Y B v t 4 ot B &8 Tax Texts per Tax Code Copy to Companies Translation Y

Tax Amount

Limitin

Tax Method Tax Tax Method Tax Tax Amount at Invoice ACCDUHUI‘Tg

{l] (%) Deductible (%) Valid From valid To Received Disbursed Printout (LH’I'EHC}’ Tax Repomng (ategmy Tax Character|

0 100 1/1/2020 12/31/2049 No Tax No Tax Separate from Price None No Tax
H 0 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
P23 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
P23 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
P23 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
5 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
5 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
5 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal

The ‘No Tax’ value is allowed only for tax codes with Tax Type set to ‘No Tax’ or ‘Calculated Tax'.

The ‘Tax Free’ and ‘Export’ values are allowed for tax codes with 0% tax rate and with Tax Type
different than ‘No Tax'.

This function is used when printing customer invoices. When the value is either ‘Tax Free’ or ‘No
Tax’, a report text “TF’ or ‘NT’ can be printed instead of the tax rate (in Polish ZW, NP).

7.5 Print Customer Orderdebit Invoice

New fields have been added to the standard report data, and existing ones have been changed to
comply with the requirement. Specific changes for other invoice types are described in the next
chapters of the document.

File modified: ORDER/CustomerOrderlvc.rdf

Report Fields Added
* Company Addresses - Company payment address is included in the report header.

XML tags: COMPANY_PAY ADDR_1 untii COMPANY_PAY _ADDR_7 is used for company
payment address.

Here is a company payment address:

<COMPANY_PAY_ADDR_1>Braty i kompany</COMPANY_PAY_ADDR_1>
<COMPANY_PAY_ADDR_2>Karpielowka 414</COMPANY_PAY_ADDR_2>
<COMPANY_PAY_ADDR_3>34-511 - Koscielisko</COMPANY_PAY_ADDR_3>
<COMPANY_PAY_ADDR_4>PL - POLSKA</COMPANY_PAY_ADDR_4>
<COMPANY_PAY_ADDR_5 xsi:nil="1"/>

<COMPANY_PAY_ADDR_6 xsi:nil="1"/>

<COMPANY_PAY_ADDR_7 xsi:nil="1"/>
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Company Tax Identity Number - Company Tax Identity Number (NIP) is added to invoice
header. The value is fetched from the Tax ID Number column on the Company/Tax
Control/Invoice tab. The tax identity number consists of ten digits separated with dashes,
e.g., 123-456-78-90. It should always be registered in the system with ‘PL’ prefix, e.g., PL123-
456-78-90. The prefix or the dashes are removed from entered value depending on the
country defined in a customer delivery address settings.

If the country is Poland or the country is not marked as EU member, then the ‘PL’ prefix is
removed from registered tax identity, e.g., 123-456-78-90
If the country is different than Poland and is marked as EU member, then the dashes are
removed from registered tax identity, e.g., PL1234567890

XML tag: COMP_TAX_ID_NUMBER

<COMP_TAX_ID _NUMBER>1112223344</COMP_TAX_ID_ NUMBER>

Tax Amount and Gross Amount - New columns — Tax Amount and Gross Amount — have
been added to the invoice line. The values are retrieved from an invoice item.

XML tags: LINE_VAT_AMOUNT, LINE_GROSS AMOUNT

<LINE_VAT_AMOUNT>354.2</LINE_VAT_AMOUNT>
<LINE_GROSS_AMOUNT>1894.2</LINE_GROSS_AMOUNT>

Tax Character — New column has been added to invoice line and tax totals. Value from this
column can be used to print tax free or no tax information (“ZW” or “NP” in Polish) instead of
tax rate 0%.
0 Tax Character Tax Free: a translatable report text ‘TF’ is presented
o Tax Character No Tax: a translatable report text ‘NT’ is presented

XML tag: TAX_CHARACTER

report.

- <INVOICE_LINE>
<TAXABLE>0<,/TAXABLE>
<MNOTE_TEXT xsi:nil="1"/=
<LOT_BATCH_NO xsi:nil="1"/=
<SERIAL_MNO xsi:nil="1"/=
<LINE_NO=3</LINE_NO=
<PREPAY_INV_NO xsi:nil="1"/>
< PREPAY_INV_SERIES_ID xsi:nil="1"/>
<TAX_CHARACTER=>TF</TAX_CHARACTER:=
<ORDER_LINE_POS>2</0ORDER_LINE_POS=>

Signatures - Two new fields for the signatures of seller and buyer are added at the end of the

New report text PURCHSIGN and SELLSIGN are defined.

<PURCHSIGN>Purch Sign</PURCHSIGN>

<SELLSIGN>Sell Sign</SELLSIGN>

Report Fields Changed

Totals and Tax Totals sections - The sections which present the information total invoice
amount and total amount per tax code have been redesigned. The column labels have been
removed from the tax totals sections and the required data (Price — Tax Base Amount, Tax
Rate, Net Amount and Gross Amount) are presented in the proper report line columns.

XML tag: TAX_AMOUNT, SHOW_SUB_TOTAL_ITEMS
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- <SUB_TOTAL_ITEMS>
- <SUB_TOTAL_ITEM=>
<FEE_AMOUNT>0</FEE_AMOUNT>
<SUB_TOTAL_AMOUNT>1000</SUB_TOTAL_AMOUNT>
<SUB_TOTAL_INCL_TAX>1230</SUB_TOTAL_INCL_TAX>
<TAX_AMOUNT>230</TAX_AMOUNT>
<SHOW_SUB_TOTAL_ITEMS>FALSE</SHOW_SUB_TOTAL_ITEMS>
</SUB_TOTAL_ITEM=>
</SUB_TOTAL_ITEMS>

7.6 Print Customer Order correction Invoice

According to legal requirements, the correction invoice contain information based on the original
invoice lines (retrieved for the corresponding debit invoice).

The Tax Totals section should not be shown in the Invoice before Correction section anymore. Only
one Tax Totals section presenting the information about the final correction amount per tax code is
shown at the end of the report.

File modified: ORDER/CustomerOrderlvc.rdf

7.7 Print Customer Order collective invoice

In IFS Cloud standard version, customer delivery addresses are always printed for each invoice line
separately. The Polish requirement states that the delivery address should be printed in the report
header when the goods have been delivered with the same delivery address. When printing
collection invoices, the system checks if a delivery address registered on all the invoiced customer
order headers is the same. If it is, then the address is presented in the header part of the report in
the same way like on debit invoices. Otherwise, it is handled as in standard: no information will be
presented in the header; the corresponding delivery addresses is present in the report data for each
invoice line.

Note: If the delivery address is specific for customer order lines (which are not marked as Default) it
is handled as an exception and is always presented under invoice line regardless of the mentioned
validation.

File modified: ORDER\CustomerOrderColllvc.rdf

7.8 Print Prepayment Based Debit/Credit Invoice

New fields have been added to the standard report layout and existing fields have been changed,
very similar to the customer order debit invoice:

. Company addresses and company tax id are added to the report header.

. Value printed in Tax Rate column depend on the Tax Character settings.

Also, the Prepayment Invoice Lines and Order Information sections which are shown in the report
details are redesigned. The existing logic for fetching the required data is not affected.
File modified: ORDER\CustOrderPrepayminvoice.rdf

Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_1',
comppayaddrl );

Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_2',
comppayaddr2_);
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Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_3',
comppayaddr3 );
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_4',
comppayaddr4 );
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_5',
comppayaddr5 );
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_6',
comppayaddr6é );
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_7',
comppayaddr7_);

Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_1', compaddrl );
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_2', compaddr2_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_3', compaddr3_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_4', compaddr4_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_5', compaddr5_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_6', compaddr6_);
Xml_Record Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_7', compaddr7_);
Xml_Record_Writer_ SYS.Add_Element(xml_,'OUR_REF', header_rec_.authorize_name);

Xml_Record Writer_ SYS.Add_Element(xml_,/COMPANY_VAT_NO', company_tax_no_);
Xml_Record_Writer_SYS.Add_Element(xml_,/CUSTOMER_VAT_NO/',
customer_tax_no_);

Xml_Record_Writer_ SYS.Add_Element(xml_, 'TAX_CHARACTER/,
Statutory _Fee APIl.Get_Tax_Character_db(company _, inv_line_rec_.vat_code));

7.9 Print Instant invoice

The changes are similar as for customer order debit invoice. The only exception is the customer
order information since they do not exist on the instant invoices (Delivery Term, Ship Via, CO
Number, Customer’s PO No, Delivery Note Number etc.).

File modified: INVOIC\Instantinvoice.rdf

TAX_CHARACTER
CUSTOMER_VAT_NO_PL

COMP_PAY_ADDR_1
COMP_PAY_ADDR_2
COMP_PAY_ADDR_3
COMP_PAY_ADDR_4
COMP_PAY_ADDR_5
COMP_PAY_ADDR_6
CURRENCY_CODE

7.10 Delimitations

No invoice print layouts are modified. It is only the RDF files that are changed. The RDL files (Report
layout) are maodified in each implementation project.
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8 Round VAT Amount for Supplier Invoices in
Accounting Currency

8.1 Overview Legal Requirement

In Poland VAT is rounded to O decimals in customs documents. Due to art. 33a of Tax law, when
using simplified procedure for importing goods, tax disbursed is reported in VAT Declaration.
Therefore, when customs document is registered as supplier invoice, Calculated Tax functionality is
used in order to have both tax disbursed and tax received. It is not possible in that case to adjust tax
amount manually.

8.2 Solution

The following is added to support this requirement:
* Possibility to set up rounding to 0 decimals for a specific tax code of type “Calculated Tax”.

* Rounding of tax amount is performed in the Preliminary Supplier Invoice and Manual Supplier
Invoice pages.

PROCESS OVERVIEW

Enter Supplier

Define Basic Data Post Invoice View Vouchers

Invoice

8.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set up chapter and the
“‘Round VAT Amount for Supplier Invoices in Accounting Currency” parameter must be enabled.

8.4 Define Basic Data

Open the Tax Codes page and select the Round to 0 Decimals check box for tax codes which are
used when customs documents are registered as supplier invoices.

Tax Codes
AT LA t 7 W B 8 v Tax Texts per Tax Code Copy to Companies Translation
Tax Code ¥  Description ¥  TaxType ¥ More ¥ O Favorites  Clear H Settings
Round to 0

~/ : Tax Code Description Decimals Tax Type Tax (%) Deductible (%)
i IM-PUD Import of goods, simplified procedure, 0% m Calculated Tax 0 100

i IM-PU23 Import of goods, simplified procedure, 23%. Calculated Tax 23 100
i IM-PU23B Import of goods, simplified procedure, 23%, m Calculated Tax 23 100
IM-PU23S Import of goods, simplified procedure, 23%, m Calculated Tax 23 100

IM-PUS Import of goods, simplified procedure, 5%, v m Calculated Tax 5 100

IM-PUSB Import of goods, simplified procedure, 5%, v m Calculated Tax 5 100

IM-PUSS Import of goods, simplified procedure, 5%, ¢ m Calculated Tax 5 100

IM-PU8 Import of goods, simplified procedure, 8%, v m Calculated Tax 8 100
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Note that it is only possible to select this check box for tax code of type “Calculated Tax” with tax
received method “Invoice Entry” or “Final Posting” and deductible percentage set to 100.

As customs documents are always registered in PLN, only supplier invoices in accounting currency
are affected by this functionality.

8.5 Enter Supplier Invoice

Follow the IFS Cloud standard process to register supplier invoice via the Preliminary Supplier
Invoice or Manual Supplier Invoice pages. Use tax code with the Round to 0 Decimals check box
selected.

8.6 Post Invoice
Follow the IFS Cloud standard process to post the invoice.

8.7 View Vouchers
Follow the IFS Cloud standard process.

Follow the IFS Cloud standard process to view voucher. Tax amount posted on IP9 and IP10 posting
types is rounded to 0 decimals.

Voucher Rows
Yo B
Currency Debit  Currency Credit Currency Conversion  Accounting

v # ection  Trans Code Amount Amount Amount Currency Rare Factor  Currency

& IP5 139.00 139.00 1 1 PLN

@ IP1 139.00 -139.00 1 1 PLN

& IF10 32.00 -32.00 1 1 PLN

? IP9 32.00 32.00 1 1 PLN

In the example above net amount = 139.00 PLN, Tax % = 23% so tax amount is calculated in the
following way: round (139.00 * 0.23, 0) = round (31.97, 0) = 32.00.

8.8 Delimitaitons
None.
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9 Polish Split Payment

9.1 Overview Legal Requirement

In July 2018 split payment model was introduced in Poland.

This model introduces additional VAT bank account for every company. The new bank
account is created in the same bank where the company has its regular bank account. The
access to the new bank account is limited.
When sending payment instruction to the bank, company can indicate that payment is to be
made in the split payment model. This requires including additional details, that is, VAT
amount, VAT identification number of the supplier and invoice number.
When bank (of the paying party) receives split payment instruction

o VAT amount is reposted from VAT account to regular account.

o Full payment amount is transferred to another bank according to the payment

instruction.

When bank (of the receiving party) receives split payment instruction

o Full payment amount is posted to regular account.

o VAT amount is reposted from regular account to VAT account.
The model is optional. However, if company receives payments via split payment model it is
forced to use this model also when sending payments since otherwise money will be blocked
on VAT bank account.
Split payment instruction can only be used when paying in PLN and from bank account in
PLN.
Split payment instruction must be created separately for each invoice.

Split Payment functionality is required for invoices in the accounting currency as well as for invoices
in the foreign currency.

In case of invoice in the accounting currency, either whole invoice or just VAT is paid in the
Split Payment model.

In case of invoice in the foreign currency, payment instruction must still be created in PLN
according to the Split Payment legislation. Therefore, in this scenario, only VAT is assumed
to be paid in PLN (with tax currency rate from the invoice). Net amount is to be paid in the
foreign currency, that is, according to standard functionality.

9.2 Process Overview

9.2.1 PROCESS OVERVIEW-PAYMENT TO SUPPLIER FOR THE INVOICES IN ACCOUNTING

Define Basic

CURRENCY

Create Supplier
Payment
Proposal

Enter Supplier

Create Supplier

Data Invoice Payment Order
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9.2.2 PROCESS OVERVIEW — REPAYMENT TO CUSTOMER FOR THE INVOICES IN
ACCOUNTING CURRENCY

Create
Customer

Create
Customer
Payment Order

Create and
Print Customer
Invoice

Define Basic

Data Repayment

Proposal

9.2.3 PROCESS OVERVIEW - PAYMENT TO SUPPLIER FOR THE INVOICES IN FOREIGN
CURRENCY

Create Supplier
Payment
Proposal

Define Basic Enter Supplier
Data Invoice

Create Supplier
Payment Order

View View
View Payment Acknowledge Acknowledge
Order Items Supplier Payment
Payment Order Details

Acknowledge

Supplier Approve Mixed Cancel Mixed
Payment in Payment Payment

Mixed Payment

Load into Mixed

Payment/Create
Mixed Payment

9.3 Solution Overview

9.3.1 SOLUTION FOR INVOICES IN THE ACCOUNTING CURRENCY

Solution is based on the First Installment only Tax functionality of payment terms (standard
functionality). All invoices that are to be paid with split payment instruction must use payment terms
with this setup.
In addition, the following has been changed to support the requirement for invoices in the accounting
currency:
¢ New column and new field are introduced in the basic data for payment institutes so that it is
possible to indicate that payment instruction should be created in the split payment variant.
¢ PLBREPLN and 1SO20022 payment formats are adjusted to handle split payment.

This functionality is available for supplier payment order flow and customer repayment order flow.
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9.3.2 SOLUTION FOR INVOICES IN THE FOREIGN CURRENCY

The following has been additionally changed to support the requirement for invoices in the foreign
currency:
¢ New column and new field are introduced in the basic data for payment institutes so that it is
possible to indicate whether tax installment from foreign currency invoice should be paid in
the accounting currency.
¢ When creating payment order, selection rules related to currency are changed.
o New columns are introduced in the payment order and acknowledge payment to indicate tax
installment paid in the accounting currency and currency of the invoice.
e PLBREPLN and ISO20022 payment formats are adjusted to handle tax installment of foreign
currency invoice paid in the accounting currency.

This functionality is available only for supplier payment order flow.

9.4 Prerequisites

The company must be set-up to use Polish localization, see the Company Set-Up chapter. The
parameter “Polish Split Payment” should be enabled.

9.5 Define Basic Data for Basic Solution for Invoices in the Accounting
Currency

Follow the IFS Cloud standard process to define basic data:

¢ In the Format Specific Info per Institute page (available from Payment Institutes page,
Payment Methods per Institute command, Format Specific Info per Institute command)
setup payment formats details as required by the bank. In case of ISO20022 format, make
sure not to select the Structured Payment option.

¢ In order to handle payment to supplier, in the Payment Addresses page (available from the
Supplier/Payment tab, Electronic Payment Addresses command) setup payment format
details as required by the bank.

¢ In order to handle repayment to customer, in the Payment Addresses page (available from
the Customer/Payment tab, Electronic Payment Addresses command) setup payment
format details as required by the bank.

¢ Inthe Payment Terms page, define payment term with “First Installment only Tax” selected
in the Tax Distribution field. Use this payment term when entering/creating invoices within
this process.

9.5.1 SETUP SPLIT PAYMENT FOR INVOICES IN THE ACCOUNTING CURRENCY

9.5.1.1 PLBREPLN format (BRE Bank/mBank)

For PLBREPLN format, the Split Payment feild is added to the Format Specific Info per Institute
page (available from Payment Institutes page, Payment Methods per Institute command, Format
Specific Info per Institute command).

Use this field to setup split payment. The following options are available:
¢ Not Used
e Optional
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¢ Mandatory

See chapter Split payment options for description of the options.

n N n N — _ R - 5 e P s _ e - ~ P - — e |
@ > Finandials > Payment Basic Data » Cash Book » Payment Institutes > Payment Methods per Institute > Format Specific Information per Institute - BRE - BREPLN &

Format Specific Information per Institute - BRE - BREPLN

s/ow |

Format D Split Payment Use Acc Curr for Tax Instaliment

PLBREPLN Optional «

-

9.5.1.2 18020022 format

For ISO20022 format, the Split Payment field is added to the Format Specific Info per Institute page
(available  from Payment Institutes page, Payment Methods per Institute
command, Format Specific Info per Institute command).

Use this field to setup split payment. The following options are available:
¢ Not Used

e Optional
¢ Mandatory

See chapter Split payment options for description of the options.

@ > Fnancials > Payment Basic Data > Cash Book > Payment Institutes > Payment Methods per Institute > Format Specific Information per Institute - BANK - 1020022 i

Company __(hmalk Polish Company._
Format Specific Information per Institute - BANK - 15020022
s ow
EERIEEEEY s sccounronasmon >
File Template XML Schema Version
CORE ~ 001.001.03 %

Initiating Party Identification Information Debter/Division |dentification Information

BICOrBEI nitiating Party ID Repeat in Debror |dentification Leve Debtor/Division ID Repeat in Intiating Party Identfication Level Hide From Debtor Level

Initiating Party Identification Scheme Name Debtor/Division Identific

oprietary ssuer Code

Payment Parameters Credit Notes Grouping For Structured Payment

Charge Bearer Level Payment Type Info Level Create Separate Payment Information per Curren... | Maximum Occurences Allow Credit Grouping for Non-SEPA Payments Allow Credit Grouping for SEPA Payments

Detailed Postal Address Batch Booking Structured Payment

Natienal Bank Code for Repayment

Polish Split Payment Parameters

Split Payment Use Acc Curr for Tax Installmen:

Optional -
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9.5.1.3 Split payment options

The following options are available for split payment:

¢ Not Used
o Standard payment instruction is created.
e Optional
o Split Payment instruction is created for invoices with “First Installment only Tax” setup

O

as long as first installment is included in the payment order.
Other payment transactions can be included in the same payment order.

¢ Mandatory

O

Only invoices with “First Installment only Tax” setup can be included in the payment
order.

If first installment of the invoice is included, split payment instruction is created.

If first installment of the invoice is not included, standard payment instruction is
created for other installments.

Other payment transactions cannot be included in the same payment order.

This option makes it possible to setup the system so that all payments to unreliable
supplier are handled via split payment method.

9.6 Define Basic Data for Solution for Invoices in the Foreign currency

9.6.1 SETUP SPLIT PAYMENT FOR INVOICES IN THE FOREIGN CURRENCY

9.6.1.1 PLBREPLN format (BRE Bank/mBank)

For PLBREPLN format, the Use Acc Curr for Tax Installment field is added to the Format Specific
Info per Institute page (available from Payment Institutes page, Payment Methods per Institute
command, Format Specific Info per Institute command). Select this option in order to pay tax
installment, that is, first installment of the invoice with “First Installment only Tax” setup, in the
accounting currency.

Also select value in the Split Payment field in the similar way as for invoices in the accounting

currency.
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@ > Finandials > Payment Basic Data » Cash Book > Payment Institutes » Payment Methods per Institute » Format Specific Information per Institute - BRE - BREPLN =
Format Specific Information per Institute - BRE - BREPLN

s/ow |

Format D Split Payment Use Acc Curr for Tax Instaliment
PLBREPLN Optional -

9.6.1.2 1S020022 format

For 1S020022 format, the Use Acc Curr for Tax Installment field is added to the Format Specific
Info per Institute page (available from Payment Institutes page, Payment Methods per Institute
command, Format Specific Info per Institute command). Select this option in order to pay tax
installment, that is, first installment of the invoice with “First Installment only Tax” setup, in the
accounting currency.

Also select value in the Split Payment field in the similar way as for invoices in the accounting
currency.

@ > Fnancials > Payment Basic Data > Cash Book > Payment Institutes > Payment Methods per Institute > Format Specific Infermation per Institute - BANK - 1020022 Company [ Chmalk Polish Company_
Format Specific Information per Institute - BANK - 1S020022

R

LA 2R e T CASH ACCOUNT INFORMATION 4

File Template XML Schema Version

CORE - 001.001.03 L

Initiating Party Identification Information Debtor/Division Identificati Inforr

BICOrBE| Initiating Party ID Repeat in Debtor Identification Leve! Debtor/Division 1D Repeat in Intiati Le Hide De Le

Initiating Party Identification Scheme Name Debtor/Division Identification Scheme Name

Code Propriecary ssuer Code Proprietary Issuer

Payment Parameters Credit Notes Grouping Fer Structured Payment

Charge Bearer Level Payment Type Info Level Create Separate Payment Information per Curren. Maximum Oceurences Allow Credit Grouping for Non-SEPA Payments Allow Credit Grouping for SEPA Payments

Detailed Postal Address Batch Booking Structured Payment

Natienal Bank Code for Repayment

Polish Split Payment Parameters.

Split Payment Use Ace Curr for Tax Instaliment

Optional .«

9.7 Details of Basic Solution for Invoices in the Accounting Currency

9.7.1 ENTER SUPPLIER INVOICE

Follow the IFS Cloud standard process to enter supplier invoice.
Make sure to enter invoice in “PLN”. Also make sure to use payment terms with “First Installment
only Tax” specified in the Tax Distribution field.
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9.7.2 CREATE SUPPLIER PAYMENT PROPOSAL
Follow the IFS Cloud standard process to create and acknowledge supplier payment proposal.

9.7.3 CREATE SUPPLIER PAYMENT ORDER

Follow the IFS Cloud standard process to create supplier payment order.

9.7.3.1 PLBREPLN format
X New Payment Order

.=- Payment Order Information = = Cash Accounts Information

Selected Proposals Payment Method

5 = | BREPLN - BRE domestic formatin PLN -

yment Institute Curre
BRE - BRE Bank in Poland ~ | |PLN

Payment Date Cash Account

b Next Cancel

Note split payment details in the output file for PLBREPLN format
o VAT amount after “/VAT/

e Supplier tax identity number after “/IDC/”
¢ Invoice number after “/INV/”
e Optional text after “/TXT/”
e “53”instruction (instead of standard “51”)
| BREPLN.DAT - Notepad — m| P4

File Edit Format View Help
D/Add Add2/ZIP city","CH-SUPPLIER1/Add @1 Add @2/7IP City/",0,18300004, '/VAT/Z}EJ,EJEJ,"IDC/123456X1/INV/@8/@17|@1/TXT/’|| PR M B
D/Add Add2/ZIP city","CH-SUPPLIER1/Add @1 Add @2/7IP City/",0,18300004, '/VAT/Z}EJ,EJEJ/'IDC/123456X1/INV/@8/@17|@2/TXT/’|| PR Mt B

-

.

.
W
w

Also note the following
¢ In the standard version, PLBREPLN format creates single payment instruction for each
payment proposal item.
e In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.
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9.7.3.2 15020022 format

X New Payment Order

N
.:- Payment Order Information = = Cash Accounts information
S

Selecte Payment Method
4 £ | |15020022 - ISO 20022 Payments -
Only Installments Spec h Default P Meth
Payment Institute [«
BANK - Bank in Poland - | |% =
Payment Date Cash Account
=) -
> Next Cancel

Note split payment details in the output file for ISO20022 format (unstructured variant)
e <Prtry>tag
o “SPLT”
e <Ustrd> tag
o VAT amount after “/VAT/
o Supplier tax identity number after “/IDC/”
o Invoice number after “/INV/’
o Optional text after “/TXT/
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<CdtTrfTxInf>
- «Pmtld=>
<Instrid=798/2021-08-01/1</Instrid =
<EndToEndld=798/2021-08-01/1</EndToEndId=
</Pmtld=
- <PmtTpInf>=
<InstrPriy >NORM</InstrPriy =
- =Svclvl=
<Cd=NURG</Cd=
</Svclvl>
- «<CtagyPurp>
<Prtry>SPLT</Prtry> |
TrgyroTy
</PmtTpInf=
- <Amt>
<InstdAmt Ccy="PLN">1230.00</Instd Amt=>
<fAmt=
- <Cdtr=
<Nm=PL Supplier 01</Nm>
- <PstlAdr>
<Ctry=PL</Ctry=
</Pstladr=

</Cdtr= m

- <CdtrAcct>
- <Id>
- «Othr>
<1d>123456</Id>
- <SchmeNm=
=Cd=BBAN</Cd=
</SchmeNm>
</Othr=
<Id=
<f/Cdtracct=
- «<RgltryRptg >
=DbtCdtRptgIlnd=DEBT</DbtCdtRptgind =
- <Dtls>
<Cd /=
<Inf /=
</Dtls>
</RgltryRptg=
- <RmtInf=>

S\
SVIFS

|<U5trd:>I‘L'ATIZEU,Ul]IIDCII23455[1NV!UBIUI—[]2)' TXT/,08/01-02/2</Ustrd> I

< [RIMCInT =
=/ CdtTrfTxInf =

</PmtInf:
</ CstmrCdtTrfInitn=
</Document=

Also note the following
In the standard version, unstructured ISO20022 format creates common payment instruction

9.7.4

for multiple invoices from the same supplier.

In case of split payment instruction this logic is changed so that single payment instruction is

created per invoice.

CREATE AND PRINT CUSTOMER INVOICE

Follow the IFS Cloud standard process to create and print customer correction invoice with negative
total amount.
Make sure to create invoice in “PLN”. Also make sure to use payment terms with “First Installment

only Tax” specified in the Tax Distribution field.

9.7.5 CREATE CUSTOMER REPAYMENT PROPOSAL

Follow the IFS Cloud standard process to create and acknowledge customer repayment proposal.

Country Solution POLAND 137



2,

9.7.6 CREATE CUSTOMER REPAYMENT ORDER
Follow the IFS Cloud standard process to create customer repayment order.

9.7.6.1 PLBREPLN format
X New Payment Order

.=- Payment Order Information = = Cash Accounts Information

Selected Proposals Payment Metnod

3 E BREPLN - BRE domestic format in PLN -
Only Instaliments Specified with Default Payment Metr

Payment Institute Currei

BRE - BRE Bank in Paland - | |PLN =
Payment Date

=]
> Next Cancel

Note split payment details in the output file for PLBREPLN format
o VAT amount after “/VAT/

Customer tax identity number after “/IDC/”

Invoice series and number after “/INV/”

Optional text after “/TXT/”

“53” instruction (instead of standard “51”)

3
File Edit Format View Help
Add2/ZIP city","Chmalk Polish customer @1/Add @1 Add @2/ /",0,18398884,I/VAT/ZB@,@@/IDC/123465/INV/FS@E/@Z—|81/TXT,"| |,I, REEN B

Also note the following
¢ In the standard version, PLBREPLN format creates single payment instruction for each
payment proposal item.
¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.

9.7.6.2 150202222 format

X New Payment Order

.:- Payment Order Information =( = Cash Accounts Information

Selected Proposals Payment Metnod

3 3 5020022 - ISO 20022 Payments -
Only Installments Specified with Defauft Payment Method

Payment Institute o

BANK - Bank in Poland - | |% =
Payment Date

=]
b Next Cancel

Note split payment details in the output file for ISO20022 format (unstructured variant)
o <Prtry>tag
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o “SPLT”
e <Ustrd> tag
o VAT amount after “/VAT/”
o Customer tax identity number after “/IDC/”
o Invoice series and number after “/INV/”
o Optional text after “/TXT/”

- <CdtTrfTxInf>
- =Pmtld>
<Instrid=>841/2021-08-02/1</Instrid=
<EndToEndld=841/2021-08-02 /1 </EndToEndId=
</Pmtld=
- <PmtTplInf>
<InstrPrty=NORM-</InstrPriy=
- =Swvclvl=
<Cd>NUGP</Cd>
=/ Svclvl=
- «CtgyPurp>

< CLgyrFa g
</PmtTpInf>
- <Amt>
<InstdAmt Ccy="PLN">1230</InstdAmt>
<fAmt=
- =Cdtr>
<Mm=CHMALK-PL</Nmz>
- =Pstladr>
<Ctry=PL</Ctry=
</ Pstladr>
<fCdtr=
- =CdtrAcct>
- <ld=
- <Othr=
<1d>123465</Id>
- <SchmeMNm=
<Cd=BBAN</Cd=
</SchmeNm=
<f0thr=
</Id=
</CdtrAcct>
- <RmtInf=
<Ustrd=/VAT/230,00/IDC/123456/INV /F508/02-01/TXT/,08/02-01/2=/Ustrd>
= RITTLLE
</ CdtTrfTxInf>
</Pmtinf=
</ CstmrCdtTrfInitn>
</Document>

Also note the following
¢ Inthe standard version, unstructured 1SO20022 format creates common payment instruction
for multiple invoices from the same customer.
¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.

9.8 Details of Solution for Invoices in the Foreign Currency

9.8.1 ENTER SUPPLIER INVOICE

Follow the IFS Cloud standard process to enter supplier invoice.
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Make sure to enter invoice in the foreign currency. Also make sure to use payment terms with “First
Installment only Tax” specified in the Tax Distribution field.

9.8.2 CREATE SUPPLIER PAYMENT PROPOSAL

Follow the IFS Cloud standard process to create and acknowledge supplier payment proposal.
9.8.3 CREATE SUPPLIER PAYMENT ORDER

Follow the IFS Cloud standard process to create supplier payment order.

9.8.3.1 Changed Selection Logic

When invoices are loaded into payment order, currencies specified in the Currencies field in the
Create Payment Order dialog box affect selection of invoices into payment order.

X New Payment Order

.:- Payment Order Information ={  J= Cash Accoun!

BANK - Bank in Poland - %

=) -

b Next Cancel

In the standard system it is currency of the invoice that is considered in this process. This logic has
been adjusted so that tax installment of the foreign currency invoice can be paid in the accounting
currency.

The changed logic is the following:

e The Currencies field in the Create Payment Order dialog box indicates currency of the
payment.

e |[fthe Use Acc Curr for Tax Installment field in the basic data is not selected, invoices will
be selected to the order as long as value of the Currencies field matches invoice currency.
Same logic as in the standard system.

¢ Ifinvoice included in the proposal has the Tax Distribution field set to value other than “First
Installment only Tax”, it is selected to the order as long as value of the Currencies field
matches invoice currency. Same logic as in the standard system.

e Ifinvoice included in the proposal has the Tax Distribution field set to “First Installment only
Tax”, net installments (Installment ID <> 1) are selected to the order as long as value in the
Currencies field matches invoice currency. Same logic as in the standard system.
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o If the Use Acc Curr for Tax Installment check box is selected and invoice included in the
proposal has the Tax Distribution field set to “First Installment only Tax”, existing logic is

changed for tax installment (Installment ID = 1)

o Regardless currency of the invoice, installment is selected to the order only if
accounting currency (PLN) is included in the selection specified in the Currencies

field.

See example scenarios:

Use Acc Curr for

Tax Installment No
Invoice: USD > All Installments
Currencies: PLN excluded
Yes
First Installment No
only Tax All Installments
excluded
Yes
Installment No 1 included
and paid in PLN
Installment No 2 excluded
Use Acc Curr for
Tax Installment No
Invoice: USD > All Installments included
Currencies: % and paid in USD
Yes
First Installment No
only Tax All Installments included
and paid in USD
Yes
Use Acc Curr for
Tax Installment No
Invoice: USD . All Installments included
Currencies: USD " and paid in USD
No

All Installments included

Yes

First Installment
only Tax ’
‘ Yes

and paid in USD

Instaliment No 1 excluded

Instaliment No 2 included
and paid in USD
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9.8.3.2 Create Supplier Payment Order — Cash Accounts

When payment order is created, cash accounts to be used for payment can be specified with respect
to currency.

X New Payment Order

(' )= Ppayment order information .=..=. Cash Accounts Information

Payment Method

ayme
5020022 BANK

4 Previous Cancel

In the standard system currencies displayed in the Currency column in the Cash Accounts dialog
box correspond to currencies of the invoices included to the payment order. This logic has been
adjusted to consider scenario when tax installment of the foreign currency invoice is paid in the
accounting currency. As a result, the displayed currencies correspond to payment currencies.

Example 1
e Only foreign currency invoices are included in the payment order.

o “First Installment only Tax” is selected in the Tax Distribution field in the Payment Terms
page for the payment term used in the involved invoices.
e Only first installments are included in the payment order.
According to the standard logic, only foreign currencies are displayed in the Cash Accounts dialog
box.
When the Use Acc Curr for Tax Installments check box is selected, only accounting currency is
displayed in the Cash Accounts dialog box.

Example 2
e Only foreign currency invoices are included in the payment order.

e “First Installment only Tax” is selected in the Tax Distribution field in the Payment Terms
page for the payment term used in the involved invoices.
e First and other installments are included in the payment order.
According to the standard logic, only foreign currencies are displayed in the Cash Accounts dialog
box.
When the Use Acc Curr for Tax Installments check box is selected, foreign currencies and
accounting currency are displayed in the Cash Accounts dialog box.
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9.8.3.3 PRBREPLN format

x

New Payment Order

.:- Payment Order Information =( = Cash Accounts Information

Selected Proposals Payment Method

=|| | BREPLN - BRE domestic format in PLN -

ied with Default Payment Method

Payment Institute Currencies

BRE - BRE Bank in Poland » | |PLN

Payment Date Cash Account

b Next Cancel

Note split payment details in the output file for PLBREPLN format

VAT amount after “/VAT/”

Supplier tax identity number after “/IDC/”
Invoice number after “/INV/”

Optional text after “/TXT/”

“53” instruction (instead of standard “51”)

Also note that total amount of the payment instruction as well as VAT amount are expressed in the
accounting currency.

| BREPLN.DAT - Notepad - O b4

File Edit Format View Help

»lish Co.LTD/Add Add2/ZIP city","CH-SUPPLIER1/Add @1 Add @2/7ZIP City/",E)_,183@99@4,I/VAT/23@@,@9/IDC/123A56X1/INV/88/QZ|791/TXT,/| |I,)

Also note the following

9.8.34

In the standard version, PLBREPLN format creates single payment instruction for each
payment proposal item.

In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.

1SO20022 format
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X New Payment Order

.:- Payment Order Information =  }= Cash Accounts |

(1]

BANK - Bank in Poland - ||%

Payment Date Cash Accourt

> Next Cancel

Note split payment details in the output file for ISO20022 format (unstructured variant)
e <Prtry>tag
o “SPLT”
o <Ustrd> tag
o VAT amount after “/VAT/”
o Supplier tax identity number after “/IDC/”
o Invoice number after “/INV/”
o Optional text after “/TXT/
Note currency and amounts details in the output file for 1ISO20022 format (unstructured variant)
o <InstdAmt> tag
o Currency “PLN” and amount in the accounting currency
o <Ustrd> tag
o VAT amount in the accounting currency
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- <CdtTrfTxInf>
- <Pmtld>
<Instrid>152/2021-05-15/ 1</Instrid>
<EndToEndld>=152/2021-05-15/1</EndToEndld>
=/Pmtid=>
- <PmtTpInf>
<InstrPriy >NORM </InstrPriy >
- <Swvclvl=
<Cd>NURG </Cd=
</Svelvl=
- <CtgyPurp>

<Priry>SPLT</Priry=>
< PR
</ PmtTpInf=

= =AINC
<Instdamt Ccy="PLN">2300.00</InstdAmt=>

L

=
- <Cdtr>
<Nm=PL Supplier 01</Nm=>
- <Pstladr>
<Ctry>PL</Ctry>
=/Pstladr>
</ Cdtr=
- <CdtrAcct>
- <Id>
- <Othr>
<1d>123456</1d>
- <SchmeNm=
<Cd=BBAN</Cd=>
</SchmeNmz=
<fOthr=
«</ld=>
</ CdtrAcct=>
- <RgltryRptg>
<DbtCdtRptgInd>=DEBT</DbtCdtRptgInd=>
- <Dtls>
<Cd />
<Inf />
</Dtls>
</RgltryRptg >
- <Rmtinf>
Ustrd=/VAT/2300,00/IDC/123456/INV/05/10-04 /TXT, Ustrd=

=/ LTof

Also note the following
¢ Inthe standard version, unstructured 1ISO20022 format creates common payment instruction
for multiple invoices from the same supplier.
¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.

9.8.4 VIEW PAYMENT ORDER ITEMS

New Tax Installment in Acc Curr and new Invoice Currency columns are added in the Payment
Order Items page:
e The Tax Installment in Acc Curr indicator is selected when tax installment of the foreign
currency invoice is paid in the accounting currency.
o When the Tax Installment in Acc Curr is selected:
o Invoice currency is displayed in the Invoice Currency column.
o Payment currency is displayed in the Currency column.
o Payment amount in the invoice currency is displayed in the Pay Amount in Inv Curr
column.
o Payment amount in the payment currency as well as in the accounting currency is
displayed in the Pay Amount in Acc Curr column.
o Payment amountin the accounting currency is calculated using tax currency rate from
the invoice.
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@ > Financials > Accounts Payable > Supplier Payment Proposal > Supplier Payment Orders > Supplier Payment Order Details £ Company [ Chmalk Polish Company.

Supplier Payment Order Details 1s:-is020022-8anx ~ 1011

» e~ V)
Payment Order Payment Date Payment Method Payment Institute
152 15020022 BANK - Bank in Poland
User ID
@ ek
Order Items
v B~ Print Order m -~
Payment One- Tax
in Advan} Series. Installment Time Pay Amountin Currency  Pay Amountin  Instaliment
% | company Status sdvance tnvoicl 1D InviPrepeymNo 1D identty Suppl inv Curr | Currengy Rate AccCurr InAcc Curr | Invoice Currency
CHMALKPL  (Unscknowieazed ([ [ED FZ 051004 1 @ PL SUPPLIER 01 - PL Supplier 01 o] 23000 | PLN 230000 (29 usp
—_— —
CHMALKPL | Unacknowledged m m FZ 05/10-04 2 G PL SUPPLIER 01 - PL Supplier 01 m 1000.00 | USD 4000.00 m
CHMALKPL  Unacknewledgad u m FZ 03/10-01 2 @ PL SUPPLIER 01 - PL Supplier 01 m 1000.00 | USD 4000.00 m
CHMALK PL Unecmoniedgen) m u Fz 05/07-01 2 @ PL SUPPLIER 01 - PL Supplier 01 m 1000.00 USD 4000.00 m
CHMALKPL  Unacknowledgad u m 74 05/06-04 I 2 @ PL SUPPLIER 01 - PL Supplier 01 m 100000 USD 4000.00 ﬂ
CHMALKPL  Unacknowledged m n 74 05/06-03 2 @ PL SUPPLIER 01 - PL Supplier 01 m 1000.00 | USD 4000.00 m

9.8.5 VIEW ACKNOWLEDGE SUPPLIER PAYMENT ORDER

When tax installment of the foreign currency invoice is paid in the accounting currency, payment
amount in the accounting currency related to this installment affects total amounts in the
Acknowledge Supplier Payment Orders page for a line with accounting currency in the Currency
column.

© ) Fnania > Accouts Payebe>Supper Py Froposal> Acknowlecge Supplie Peymenc Orders [ o
Acknowledge Supplier Payment Orders
Y R~ Update Payment Status m

Grouping Criteria: Payment Order ID ~ @  Reset  Clear () Settings

Bank Fayment
Payment Payment Transaction Amount  Cash Amountin  Amountinlnv  PayAmountin | Feein Payment Cash RcforFee | Cash Account

Acknowledg. | Date Pahent Orcer  Instute Payment Method Code Currency | Cash Account Cashamount  Including Fees Ace Curr Curr AccCure Currency in Accljurr Currency Rate.

[~ ] 5/15/2021 | 15 BANK 15020022 = PLN BANK-PLN 2300.00 2300.00 2300.00 2300.00 230000 0.00 000

-] 5/15/2021 | 15 BANK 15020022 £ usD BANK-PLN 5000.00 20000.00 20000.00 5000.00 20000.00 0.00 0.00

o 721/2021 | 597 BANK 15020022 = usD BANK-PLN 1000.00 4000.00 4000.00 1000.00 4000.00 0.00 000

[+ ] 81021 | 797 BRE BREPLN = PLN BRE-PLN 1230.00 123000 123000 1230.00 1230.00 0.00 000

o &1r2021 | 798 BANK 15020022 £ PLN BANK-PLN 1230.00 1230.00 1230.00 1230.00 1230.00 0.00 0.00

o 8172021 | 801 BRE BREPLN = PLN BRE-PLN 2300.00 2300.00 2300.00 2300.00 230000 0.00 000

[+ ] 8112021 | 804 BANK 15020022 = PLN BANK-PLN 2300.00 2300.00 2300.00 2300.00 230000 0.00 000

m 8172021 804 BANK 15020022 - usD BANK-PLN 1000.00 4000.00 4000.00 1000.00 4000.00 0.00 0.00
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9.8.6 VIEWACKNOWLEDGE PAYMENT DETAILS

New Tax Installment in Acc Curr and new Invoice Currency columns are added in the
Acknowledge Payment Details page:
e The Tax Installment in Acc Curr indicator is selected when tax installment of the foreign
currency invoice is paid in the accounting currency.
e When the Tax Installment in Acc Curr is selected:
o Invoice currency is displayed in the Invoice Currency column.
o Payment currency is displayed in the Currency field in the page header.
o Payment amount in the invoice currency is displayed in the Pay Amount in Inv Curr
column.
o Payment amount in the payment currency as well as in the accounting currency is
displayed in the Pay Amount in Acc Curr column.
o Payment amount in the accounting currency is calculated using tax currency rate from
the invoice.

@ > Financials > Accounts Payable > Supplier Payment Proposal > Acknowledge Supplier Payment Orders > Acknowledge Supplier Payment Order Details & Company [ Chmalk Polish Company.

Payment Order Details

Pay Amountin  Instaliment

\an = 3 mount in mount
T Status Changed  Invoice  Series ID InviPrepaym No ID | Identity I Cure Acc Curr | InAcc Curr | Invoice Currency

ledged n m 74 05/10-04 1 @DLSLDDUERD‘\-DLSJpp\iE'O‘\ 230.00 2300.00 ﬂ usD

9.8.7 ACKNOWLEDGE SUPPLIER PAYMENT IN MIXED PAYMENT

Follow the IFS Cloud standard process to enter mixed payment with acknowledge supplier payment
order transaction. When acknowledge supplier payment transaction is saved, invoices are
automatically matched with the lump sum transaction.

e Transactions with the Tax Installment in Acc Curr field selected (in the Acknowledge
Payment Details page) are considered when matching lump sum transactions in the
accounting currency.

e Payment amount in the invoice currency is fetched from the Pay Amount in Inv Curr field
from the Acknowledge Payment Details page.

o Payment amount in the payment currency and payment amount in the accounting currency
are fetched from the Pay Amount in Acc Curr field from the Acknowledge Payment
Details page.

e Tax currency rate from the invoice is fetched into the Currency Rate field.
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Search
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Company [ Chmalk Polish Company_

Payment Status ¥  StatementNo ¥  PaymentDate ¥  More ¥ ' Favorites  Clear Q i semings
Group  Q Sewings
Mixed P NotApproved
IXe ayment sank-rin-3-5152021 v
»@ + s W B~ New Transaction Approve Print Mixed Payment Notes Check Collection Level ©
ra Balances
Cash Account Statement No Remaining Amount Debit
BANK-PLN 2300.00
redit Debit Amount in Acc Curr Credit Amount in Acc Curr
0.00 2300.00
™ ion Details
s Open supplier Bills  Open Issued Checks  Open Planned Non-Supplier Payments  Copy Canceled Customer Check =
Amountin  Debi)
Lilnp su Lump Sum Trans Amountin Acc Debit Amountin | Crecic Amount Paralle
st Tranglumber  Payment Transaction Type Date Currency CurrencyRate TaxCurrRate  Order 1D Amount  DebitAmount]  Credit Amourt T Acc Curr in Acc Curr Currency
1 Acknowledge Supplier Payment Order 5/15/2021 PLN 1 1152 -2300.00 2300.00 2300.00 -460.00
Atzachments @ ~
. i Polish Company.
View/Edit Transactions 1 ~ 1«
o
rder
HIMA
Maiched Transactions Details
[ =
Pay A
=i Paralel yrment
ame reoaym talimentiD  Payer/Payse sy InvoiceCurency  Cumency Rate Fac urrency Rate or ernoa
@ rsurrusmon  Pusuppiieron 0571004 1 @ rusurruRor o 1 230000 6000 510202

9.8.8 APPROVE MIXED PAYMENT

Follow the IFS Cloud standard process to approve mixed payment.
Postings are created and transactions are removed from the Supplier Payment Orders and
Acknowledge Supplier Payment Orders pages.

9.8.9 CANCEL MIXED PAYMENT

In case of mistakes in payment registration, follow the IFS Cloud standard process to cancel mixed

payment.

Postings are reversed and transactions are recreated in the Supplier Payment Orders and
Acknowledge Supplier Payment Orders pages, including new Tax Installment in Acc Curr check
box and new Invoice Currency column.

9.8.10 LOAD INTO MIXED PAYMENT/CREATE MIXED PAYMENT FROM EXTERNAL PAYMENT
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Follow the IFS Cloud standard process to load bank statement transactions from CAMT file into the
Mixed Payment page, that is:

Place the file under respective IN folder. The file is loaded automatically, and details are
displayed in the External Payments and External Payment Details pages.

Select Match & Check All ltem command.

Select Load Into Mixed Payment or Create Mixed Payment command.

Transaction of type “Acknowledge Supplier Payment” is created on the Mixed
Payment/Transactions tab.

When transaction with the Tax Installment in Acc Curr field selected (in the Acknowledge Payment
Details page) is loaded into the Mixed Payment/Transactions tab, currency, currency rate and
amounts are handled in the same way as described in the “Acknowledge Supplier Payment Order
in the Mixed Payment” chapter.

9.9 Delimitations

Split Payment for invoices in the accounting currency is only available in supplier payment
order flow and customer repayment order flow.

Split Payment for invoices in the foreign currency is only available in supplier payment order
flow.

1ISO20022 format is only supported in the unstructured variant, based on information from
ING bank.

Split payment is not supported for invoice with payment reference or remittance.

Payment order with split payment for foreign currency invoices can only be acknowledged
from the mixed payment.

Rounding to nearest is always used after recalculating tax amount from the foreign currency
to the accounting currency with a use of tax currency rate.
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10 Access Control for Inventory Transactions and
Reservations

10.1 Overview of Legal Requirements

In Poland, warehouse manager or other personnel must be appointed by management as acting
authority for material located in warehouses. This is a legal requirement. Due to this requirement
only, authorized personnel may change quantity and/or value of material in warehouses. Warehouse
access authorization is required to prevent any inventory transactions or reservations to be executed
by unauthorized personnel.

10.2 Solution

In IFS Cloud standard version IFS Cloud users are connected to sites and this connection
determines the possibility to reserve inventory parts or conduct operations which are resulting in
inventory transactions.

For IFS Polish Localization an additional level of authority is added where IFS Cloud users are
connected to warehouses and given the authority to perform inventory transactions and make
reservations.

Making Reservation Allowed

i :
I \\ User's Inventory
: Source of S, Inventory Access reservation
I Demand s’ reservation Rights Completed
| S OK?

————————— 4

Reservation
Not
Completed

Perform Transaction Allowed

1 N
1 S ’

\ User’s Inventory
i g‘;‘ggidﬁ ;» Invento_ry Access Transaction
| R Transaction NS Completed
D e P OK?

Transaction
Not Completed
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Basic Data: A basic data page is added where the authority is set up per user over warehouses in
a site. This page is Warehouse Access.

Inventory transactions: Controls are added when a user is saving inventory operations (e.g.
receipt, scrap, pick, move, transfer between warehouses, revaluation etc.):
e |f access has been granted the user can register the operation.
e |f access has not been defined or not granted an error message is displayed and the user
cannot proceed.

Reservations: Controls are added when a user is reserving inventory parts (e.g., customer order,
work order, shop order, material requisition):
e |[f access has been granted the user can reserve the quantity.
e |f access has not been defined or not granted an error message is displayed and the user
cannot proceed.

10.3 Prerequisites

The company must be set-up to use Polish localization.
Warehouse Access

Use the Warehouse Access page to give users access to make reservations or/and transactions.
Users can be added to this page and the access can be controlled over inventory reservation and
transaction as required. To control an inventory transaction, enable/disable the option in the column
“‘Making Stock Reservation Allowed”. To control an inventory reservation, enable/disable the
option in the column, “Making Stock Reservation Allowed”.

Search  Advanced

User: LALWLK ~ @ Warehouse ¥ Performing Inventory Transaction Allowed ¥ More ¥ O Favorites  Clear Q Settings

Warehouse Access

=V BV s B v
Making Stock Reservation  Performing Inventory Transaction
v i | User Site Warehouse Allowed Allowed
@ LALWLK - Lalitha Wijebandara LPSS1 - Polish Supply Site-1 WH-01 - WH-01 @ m
@ LALWLK - Lalitha Wijebandara LPDS1 - Polish Demand Site-1  WH-01 - WH-01 Yes m
@ LALWLK - Lalitha Wijebandara LWPS1 - LW Poland Site - 1 WH-01 - WH-01 m
@ LALWLK - Lalitha Wijebandara LWPS1 - LW Poland Site - 1 WH-02 - WH-02 m

To save a record in Warehouse Access page a user must have at least one option enabled out of
the 2 controls, reservation, and transaction. A record with a user whose both “Making Stock
Reservations Allowed” and “Performing Inventory Transactions Allowed” disabled, is
considered as an invalid record which cannot be saved.
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10.3.1 INVENTORY RESERVATION CONTROL

2,

Controls are added when a user is reserving inventory parts (e.g., Customer Order, Work Order,

Shop Order, Material Requisition, Pick by Choice:

e |f access has been granted the user can reserve the quantity

e |f access has not been defined or not granted an error message is displayed and the user cannot

proceed.
H HP - Released
Material ReqUISItIOI'I 200067 - LWPST - Released - LWIC ¥
& 2 t / m B B~ Plan Stop Pre Posting Document Text Q
Order No Site Internal Customer Due Date Created
200067 = LWPS1 LWIC - LW Int Cus v  7/29/2021 712972021
Created By Total Amt/Base Internal Destination Document Text
[ JARUE 20.00 S o |
MNotes
B
Lines
= W B~ t e w B 2 v Reserve Reserve Manually Connect to Activity | v
Delivery
{l) : Release Na Part Due Qty UoM Createrd Creatard R Nam
AR LW A2450 - Air Filter - I... 2 | PCS LALWLK does not have access to make %
stock reservations in the warehouses
T of Site LWPS1

10.3.2 INVENTORY TRANSACTION CONTROL

Controls are added when a user is saving inventory operations (e.g., Receipt, Scrap, Pick, Move,
Move Reserved Materials, Transfer between Warehouses, Revaluation, Attach to Handling Unit,
Unattached from Handling Units, Pack According to Pack Instructions, Pack According to Handling

Unit Capacity, etc...):

e If access has been granted the user can register the operation

e If access has not been defined or not granted an error message is displayed and the user

cannot proceed
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Receive Inventory Part .wazaso-air ilter - internal - LWps1-* ¥ 103

L P 7 B~ Create New Part Revision Q
Part Site Configuration Id UoM Catch UoM
LW A2450 - Air Filter - Internal = LWPS1 * PCS
Unit Cost Print Barcode Note
10.00 B
= Y B~ 1 B 8~ Print Barcode Labels Print Serviceability Tag =z
Quantity Catch Quantity  On Hand Catch
i & Received On Hand Qty Received Qty Expiration date Location No Handling Unit ID  Handling |
L 2 10 158 202376 . 0
B 13 LALWLK does not have access to x

perform inventory transactions in
Warehouse WH-01 of Site LWPS1

Attachments

When moving parts directly into the new inventory, you should have access to both warehouses, on
each site. If access is not authorized, you will receive an error message.

When moving into transit at first (i.e., the goods are under transportation) you can put the material
into transit, but you can move them from transit into the target location only if you have an access to
that target warehouse. If access is not authorized, you will receive an error message.

Note:
e You may grant a user an access to a warehouse but not connect him to the site. In this case
the user cannot perform any transactions or/and reservations.
e |If the user does not have warehouse access defined or the access is set to “No”, the user
cannot perform Inventory transactions or/and reservations.
o If the company’s parameter is not enabled, the effect is that no access control will occur.

10.4 Automatic Reservation

With the automatic reservation, the system decides under IFS Cloud standard logic from which
locations and in what order inventory parts are reserved. During automatic reservation the Cloud will
only reserve material from locations from/to which the user has access according to the Access
Rights enabled in the Warehouse Access Page.
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10.5 Exceptions in Access Rights

For changing inventory part locations between two sites, the user must be authorized to perform
transactions in warehouses of both sites. During the transportation of Parts to another site, two
transactions are generated: INVM-OUT (direction -) and INVM-TRIN (direction 0). The second
transaction, INVM-TRIN, refers to a target location. But, if the user is not granted access to the
Warehouse in destination Site the Part cannot be moved to a destination location, so that
transactions cannot be completed.

10.6 Delimitations
None

Country Solution POLAND 154



>\§\\«!r/,
11 Tax Reliability Control on Suppliers

11.1 Overview Legal Requirement

The amendment of the polish VAT act, in force since 1% of September 2019, introduced regulations
on the electronic database of taxpayers registered for VAT purposes in Poland (known as ‘white list',
or 'e-register’). This new database allows to verify the current status of the taxpayers (suppliers),
whether the supplier is an active VAT payer, deregistered, restored or exempted. Additionally, there
will be information regarding the bank accounts numbers of the suppliers. For instance, if a company
has to make payments exceeding 15000PLN, company have to pay only to the suppliers’ bank
accounts disclosed in the white list. If company fail to do so, following sanctions will be applied,

o For VAT: responsible for payment of output VAT (if not settled by the supplier (up to the VAT
amount disclosed on the invoice)).

e For income taxes (corporate and personal): the expenditure will not be treated as tax
deductible costs.

To avoid sanctions the company will have to notify the tax authority about making a payment to an
undisclosed on the list bank account within three days from the transfer date or make payment using
split payment.

11.2 Solution Overview

Functionality is added to define if suppliers are considered unreliable and if bank accounts are valid
for payments. There are also added controls and warning messages raised in the following
scenarios:

e Control of supplier reliability is performed in following scenarios:
o Purchase order entry
o Manual supplier invoice entry
o Creating supplier payment proposal
o Acknowledging tax proposal
e Control of bank account validity is performed in the following scenarios:
o Authorizing invoice for payment
o Creating supplier payment proposals

Process Overview

Register Purchase

Define Supplier Define Supplier Bank Order, Supplier Invoices,

Payment Proposal, Tax
Proposal

Reliability Status Account Validity
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11.3 Prerequisites

e The company must be set up to use Poland localization, see the Company Setup chapter,
and the “Tax Reliability Control on Suppliers” parameter must be enabled.

11.4 Define the reliability status on the Supplier

After checking the tax authority’s database, the user can manually update the supplier basic data
via Application Base Setup/Enterprise/Supplier/Supplier/Address tab and Document Tax
Information sub tab.

The following columns are added:

e Supplier Tax Reliability Status. Enter the status for the supplier. Values are “Not set”,
“Reliable” and “Unreliable”.

e Supplier's Tax Reliability Declaration Date. This is the date the tax authorities have
classified the supplier’s reliability. The information is provided via the tax authority’s web site
and entered manually.

e Supplier's Tax Reliability Status Last Modified. This is the date when the reliability data
was last updated, it's entered manually.

Address reios- rieips nwaok unReLBLE ~  10f1

€« #F B

FIELDS FIELDS NIWADK UNRELIABLE

Address ID: 01 ¥

=] &

GENERAL ADDRESS INFORMATION ~ DELIVERY TAX INFORMATION QRelalall Bl a@rb4L00e BT e Il PURCHASE ADDRESS INFORMATION

i= I 1] - & m i 8o Valldate Tax 1D Number Edit Tax Reliability Information
. Valldated
; . B C:"’\:al’l:r Tax ID _;-':E Tax ID Number Date
~ @ :  NIWAPOLAND PL 4534334534353
Attachme DEIEE
Add to Favorites

Validate Tax ID Number

I Edit Tax Reliability Informaticn I
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Tax Reliability Information

= W [~ ra
Tax Tax
Reliability Reliabiliy
Tax Reliability Declaration  Status Last
Tax ID Number Status Date Modified
4634643535 Unreliable 72372021 72372021

11.5 Define the bank account validity on the Supplier

Supplier reliability status and bank account validation recognized as independent functionalities.
Therefore, irrespective of the Supplier Reliability Status, electronic payment address’s Account
Validation checkbox can be updated to define the bank account validity on the supplier.

This is defined as supplier basic data via the Application Base Setup/ Enterprise/ Supplier/
Supplier/ Payment tab and sub tab Payment Method. Open the context menu and select
Electronic Payment Addresses to open the Bank Address page. A new, Account Validated
check box and Account Validated Date fields are added where the user may define if the account
is valid or not with the account validated date.

Paymenl: FIELDS - FIELDS NIWADK UNRELIABLE ¥ 1 of 1

€« F B

FIELDS FIELDS NIWADK UNRELIABLE

Company: NIWAPOLAND - NIWADK POLISH COMPANY A/S ¥

Payment

fault Template » MNoAdvice =

~ Payee -
Payment Method
= i I t w8~ Electronic Payment Addresses et Default
i Payment Methad
¢ SUPBOE- supplier Bill Of Exchange

:  BREPLN - Poland bank
Delete

Add to Favorites

Electronic Payment Addresses

set Default
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BREPLN Payment Addresses - FIELDS

I
mn
:

|[Qj BREPLM 1

Payment Method Address ID

Cescription ACCounT

Polish Krakrow branch 342533345324324

= IFS

Bank
Blocked lAccount  Bank Account
Default  forUse Qvalidated Valldated Date

SWIFT Codes/BIC

Yes

11.6 Validation and Warning when entering a purchase order
When creating a new purchase order, the reliability of the supplier is validated.

If the value on the supplier is “Unreliable” a warning message is displayed.

@ This supplier is classified unreliable as tax payer.

Recipients of supplies will be liable for any tax not paid by

suppliers, who are identified as unreliable. Do you want to

continue?

o J

The supplier's document address as defined in the purchase order header will be used to perform

the validation.

PART LINES  NO PARTLINES = RENTAL PART LINES

General

Currency
PLN
Project

Purchase Code

Schedule Order

Delivery Address

©@ 10 - Ewa Sokolova -

Delivery Address Reference

ORDER DETAILS |ReGEN {52 AUTHORIZATION

Buyer
- o *_ IFs Applications
Release Date

v  7/28/2021
Total Weight
* 0

Document Text

Single Occurren

Coordinator Supplier Contact

f'a CHSULK - Champika Subasighe -
Revision No Supplier's Order No

0
Total Volume Language Code

0 en - English -
Note

Sl

Document Address

Document Address

© 10 - Ewa Sokolova -
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11.7 Validation and Warning when entering a manual supplier invoice

When creating a manual supplier invoice, the reliability of the supplier is validated. If the value on
the supplier record is set to “Unreliable” a warning message is displayed when saving the invoice.

r is classified unreliable as tax paEyer.

Recipients of supplies will be liable for any tax not paid by
suppliers, who are identfied as unrefiable. Do you want to
continue?

The chosen supplier invoice address set for the invoice will be used to perform the validation. This
may be changed in Manual Supplier Invoice page and the General Invoice Information dialog box
accessed under the General Info... context menu option. The reliability of the selected address is
displayed in the Tax Reliability Status field.

X More Information

1 2 6/30/2021

Reliable

oK Cancel

11.8 Validation and Warning when acknowledging a Tax Proposal

When acknowledging a tax proposal, the reliability of the supplier is validated. If the value on the
supplier record is set to “Unreliable” a warning message is displayed.

(D Tax proposal includes transactions related to suppliers
whao are identified as 'tax-unreliable’. Do you want 1o

continue?
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To show the tax reliability status in the tax proposal, Tax Reliability Status column is added to Tax
Proposal Details page. This column is automatically updated with the changes in the supplier basic
data.

S Acknowledged
Tax Proposal Details >-mix + 101 -
| B v~ Q
Tax Proposal Creation Date User ID
2-mix 7/28/2021 eALA\N
Tax Report Tax Template
MIX - All tax codes 5103 - Generic Tax Template
PARAMETER 4 2
Y B v =
Tax Base
Tax Amountin Amountin Tax
Reporting Reporting Tax ID Tax Number pf  Reliability
v Pt Currengy Rate Currency Currency = Correction Reference  Trans Code Tax Book ID Subgroup Tax Code Status
1 -60.0000 -240.0000 m P10 8 Unreliable
1 60.0000 240.0000 m P2 L] Unreliable
1 60.0000 240.0000 m P9 T8 Unreliable
1 -20.0000 -80.0000 m P10 T8 Unreliable
1 -20.0000 -80.0000 m P10 L] Unreliable
1 -20.0000 -80.0000 m P10 T8 Unreliable
1 -20.0000 -80.0000 m P10 L] Unreliable
1 -20.0000 -80.0000 (09 P10 8 Unreliable

11.9 Validation and warning when authorizing invoice for payment

A validation is done to control whether the bank account on the payment method is valid. If the
chosen bank account is not valid for the supplier or connected payee for the supplier, a warning
message is displayed. The warning is generated at time of authorizing the invoice installment for the
payment.

(D The chosen payment method's bank account has not
been validated by tax authorities. Do you want to

continue?

This authorization can be done manually or automatically. This is set up as basic data on the supplier
in the Supplier/Invoice tab and General subtab, this is IFS Cloud standard functionality.
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Invoice rewos- rewos nwaok unkeusaie = 1er1

«# B

FIELDS FIELDS NIWADK UNRELIABLE
Company: NIWAFOLAND - NIWADK POLISH COMPANY A/S ¥

a s G Motes. Default Cost Code String

External v 0-External

™ No invoicing
- - . - FN) FIELDS - FIELDS NIWADK UNRELIABLE
AT Final Posting
en Posted
- =

The following options are available:

¢ “No”. The validation of the account is done when the Authorize check box is manually
selected in the Supplier Invoice Installment Plan and Discount page.

o “At Final Posting”. The validation of the account is done when final postings are created.

o “When Posted” The validation of the account is done when the first postings are created for
the invoice.

On company level, on the Company/Invoice tab. it's possible to control if invoice authorization
should be done in a separate function/page, this is IFS Cloud standard functionality. If the Supplier
Invoice Authorization Only by Separate Function check box is selected the authorization can
only be done from the Authorize Invoices for Payment page. The validation of the account is
performed when the Authorized check box is selected.

INVOICE nwaPoLAND - NIWADK POLISH COMPANY A/s ¥ 1of 25+

«# B ©

OLAND NIWADK POLISH COMPANY A/S

GENERAL DEFAULT INVOICE TYPES = PO MATCHING 4 »

I ® Upgrade Invoices with Posting Proposals
Posting Parameters

Posting at Invoice Entry Same No Preliminary and Final Supplier Invoice Same Date Preliminary and Final Supplier Invoice Use Posting Proposal

Accepted Invoice Voucher Difference in Accounting Curren...  Accepted Invoice Rounding Difference in Invoice Currency

Miscellaneous Parameters

Planned Payment Date Calculation Base Unigue Supplier Invoice No Pe: Incoming Invaice Currency Rate Base Outgoing Invaice Currency Rate Base
Pay. Term Base Date ~  Supplier * Voucher Date ~ Invoice Date -
Supplier Invoice Authorization Only by Separate Function I Cash Discount Based on Gross Amount Set Invoice Date to Current Date When Printing Outgoing Print Advance Payments Information on Customer Invoice
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Search agances @) Show only current results

Status ¥ Installment|D ¥ Authorizer ¥

More +

O Favorites

Authorize Invoices for Payment

@MAFm *

- IFS Applications

#
&
&
&
& @BELJm *-
&
&
&
&

Authorize

Supplier Authorized JAuthorizer

FS Application

FS Application

* - IFS Applications

@BELJ o] .
@BELJ m *

5

5

FS Applications

FS Applications

- IFS Applications

- IFS Applications

5

5

Clear

Q

Modify Remittance Information

Series

D

sl

SI

SI

Sl

Sl

Sl

SI

SI

Invoice
Mumber

NIWAD4

NIWAQ4

WWwW

NIWA15

NIWA31

NIWA30

NIWAS0

NIWA102

Insta...

1

1

1

1

1

1

1

1

i Settings

Amount
10,000.0000 PLF
1,000.0000 PLN
1,000.0000 PLN

700.0000 PLN
1,000.0000 PLN
500.0000 PLN
100.0000 PLN

100.0000 PLN

Due Date

712642021

7i27/2021

7/30/2021

7/30/2021

8/5/2021

8/6/2021

8/21/2021

B8/24/2021

_5\\\!5

On On Hold Reason
1]

. | Status
Created
Created
Created
Created
Created
Created

Created

Created

o
a

11.10 Validation and Warning when creating a Payment Proposal

When creating a new supplier payment proposal, a validation is done to control the reliability status
of the supplier and a control is done to check that the account connected to the payment method is

valid.

If the supplier or payee is unreliable and/or the account is not valid a warning message is displayed.
For the account to be validated, it's required that the invoices are registered with a Payment Method
and Payment Address ID.

The validation is performed in the following scenarios:

e When creating the proposal under the Create Proposal context menu option in the Accounts
Payable/Supplier Payment Proposal/Supplier Payment Proposals page

e When connecting invoices manually in the Supplier Payment Proposal Details page in the

Details tab.

Read IFS Cloud Documentation for more information on how to use these functions.
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.— General Information —O— Cash Account and Payment Method Information —O— Filtering and Additional Information ==

Start Option

®
(@ start now

Run in background
() scnedule

Date Selection

Based On

(@ Date
(O substitution Variables

Company and Supplier Selection
Company

NIWAPOLAND
Based On

@ Supplier %
(O supplier Group

First Possible Pay Date

Cance!

_\>\\\!r,
- Z
7N

New Supplier Payment Proposal

Schedule Schedule Options

Until Plan Pay Date

7/29/2021 712912021

Priority

IFS

Once the proposal is created you can go to the detail page and view connected invoices. There are
five new columns added, Tax Reliability Status, Declaration Date, Last Modified, Account
Validated Date and Account Validated, to indicate the supplier’s status. Based on this information
decision can be made whether to pay or not before acknowledging the payment.

Supplier Payment Proposal Details s ~ 1o

<«

PATMENT METHOD PLAN | PARAMETERS

[ + 7 erint Proposal

11.11 Delimitations

Recalculate Neming Possibiity

©

Recalculate Offset Possibilty

Created

nososa
ayman: ™
o n e etnos ’ Retaby
Penveyome | bxe o T Nows | posting | Gasnaccon | Creck Recplnt Fae pan | paymemtwemos | anoress P
2172021 oo Payee O@ == 1 unreliacle
3172021 oo Bayes @lm CHK ol Unrelianle
112021 (o I Payee Q@ o2 o Unreliaple | 77232021 723202

e There is no online, nor offline connection developed to integrate IFS Cloud with the tax
authorities’ database.
e This functionality is only available in purchase order entry, manual supplier invoice entry,
supplier invoice authorization for payment, payment proposal and tax proposal.
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12 Polish E-Invoice

12.1 Overview Legal Requirement

KSeF, Krajowy System e-Faktur (National System of e-Invoices), is a platform intended for issuing
and receiving invoices by electronic means. Using of KSeF platform is facultative. From July 2024,
issuing of B2B invoices via KSeF platform will be mandatory for domestic, EU as well as non-EU
sales.

In order to make it possible to issue invoices via KSeF platform, Tax Authorities publish official
schema of E-invoice (FA(2) as for September 2023) and enable API which allows to send the XML
message and receive response. Accepted invoices are available in KSeF platform for companies
having Polish tax identity and they are archived for 10 years. KSeF platform does not include any
function to inform buyers that new invoice is available. In order to check whether any new invoices
have been issued, buyers must integrate with KSeF platform or login to one of the applications
prepared by the Tax Authorities.

12.2 Solution Overview

The solution is based on standard E-invoice process which is using a 3rd party service provider to
handle the communication of invoice information. The solution has been developed in cooperation
with the IFS partner Pagero but other local or global service providers can be utilized. The service
provider is needed to transform the IFS style invoice file to required format and to transform the
response file to an IFS style format. The service provider is also needed to transform received
invoice file in the official format to IFS style invoice file. Read more about the IFS elnvoice solution
in IFS cloud documentation.

The following is added/changed to support this requirement:

e New E-invoice Poland is added to the Format drop-down in the Message Setup section in
the E-invoice Processing Type page.

¢ New STD-PL E-invoice processing type is added.

¢ |IFS Cloud standard functionality which allows to create XML in IFS Style is enhanced with
new information for Polish E-invoice.

In this document

e Polish E-invoice XML in IFS Style refers to IFS Style E-invoice XML enhanced with Polish
specific attributes. This file is generated from IFS Cloud and can be send to service provider
for conversion.

e Polish E-invoice XML in KSeF Style refers to Polish specific legally required XML format
(FA(2) as for 2024) which can be sent by service provider to KSeF platform, as a result of
conversion of Polish E-invoice XML in IFS Style.
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12.3 Process Overview
12.3.1 PROCESS OVERVIEW - BASIC DATA

Define Basic Data

=)

Send Polish
E-invoice in IFS
Style to Service

Provider
(IFS)

Receive Response
Message in KSeF
Style from KSeF

Platform

(Service Provider)

Post Invoice

Load E-Invoice
in IFS Style

((ZS)]

Update General
Ledger

(IFS)

Receive Polish
E-invoice in IFS
Style from IFS

(Service Provider)

Convert Response
Message to IFS
Style

(Service Provider)

Update General
Ledger

(IFS)

View External
Supplier Invoice

(IFS)

Fetch Tax Ledger
Info

(=)

12.3.2 PROCESS OVERVIEW - CUSTOMER INVOICES

Convert Polish
E-invoice to KSeF
Style

(Service Provider)

Send Response
Message in IFS
Style to IFS

(Service Provider)

Fetch Tax Ledger
Info

(IFS)

12.3.3 PROCESS OVERVIEW - SUPPLIER INVOICES

Create Manual
Supplier Invoice

(IFS)

View Tax
Transactions

(=)

Send Polish
E-Invoice in KSeF
Style to KSeF
Platform

(Service Provider)

Receive Response
Message in IFS
Style from Service
Provider

(IFS)

View Tax
Transactions

(IFS)

Post Manual
Supplier Invoice

(IFS)
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12.4 Prerequisites

e The company must be set-up to use Polish localization, see the Company Set up chapter.
“Polish E-Invoice” parameter must be enabled.

o To support reporting of split payment invoices, the “Standard Audit File-Tax for Poland (JPK)”
functionality is also used. “Standard Audit File-Tax for Poland (JPK)” parameter is mandatory
and enabled by default.

e Itis recommended to create the company using Standard Polish Template (STD-PL).

12.5 Basic Data

12.5.1 BASIC DATAADDED DURING INSTALLATION
The following new data is added for Poland during the installation:

¢ In the E-invoice Processing Type page, new value E-invoice Poland is added in the
Format drop-down.
e New STD-PL e-invoice processing type with the E-invoice Process enabled, Process after
Response enabled, and E-invoice Poland selected in the Format drop-down is added.
12.5.2 DEFINE BASIC DATA

12.5.2.1 Modify Process Type
Using IFS Cloud standard functionality, select user from the Approval User drop-down in the

E-Invoice Processing Type page for STD-PL process type.
E'inVOice ProceSSing Type STD-PL - Standard Template for Invoice Processing Type - Poland ¥ 60f6

« + @B 7 mW 4 v

Process Type Description

STD-PL Standard Template for Invoice Processing Type - Pol...

E-invoice Process
E-invoice Process Process after Response Automatically Process Accepted Invoice

Yes Yes m

Approval User

Message Setup

Format Service Provider

E-invoice Poland IFS_CLOUD - IFS Cloud

12.5.2.2 Define Company

Using IFS Cloud standard functionality, enter company tax identity in the Tax Liability Countries
section in the Company/Tax Control/Invoice tab for country “POLAND”. If company has been
registered for EU sales, enter EU tax identity with PL prefix. Company tax identity can be specified
with dashes (for example PL123-456-78-90) or without dashes (for example PL1234567890).
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Tax Control waseroLanp - polish company ~

K # 40~

Company

MABE-POLAND

GENERAL INVOICE SUPPLY CHAIN

Name

Polish Company

EXTERNAL TAX SYSTEM

Vd
General Information
Amount Method Tax Rounding Level
Gross Amount Entry -  Total Level -
Tax Amount Limit, Outgoing Invoice Lines Use Tax Invoice
a» »
Post Preliminary Tax Withholding
Tax Liability Countries
Yy + 7
Tax ID
Validated
v Country Tax ID Type Tax ID Number Date
POLAND NIP PL1234567890

Association No

Invoice Fee Tax Code

Correspondence, Invoice Net Amount - Tax Withholdi_..

»

Tax Registration Text Branch

(@]
Created By
MABEPL
«
Tax Correspondence, Inveice Line - Manual Postings
-
Supplement Tax Withholding
a»
{é} v B~ 24~ B v
Valid From Valid Until
3/17/2023 12/31/2049

Using IFS Cloud standard functionality, in the Company/Invoice/General tab, select STD-PL in the
Process Type drop-down and enable Set Invoice Date to Current Date When Printing Outgoing

Invoices.

INvoice wase-roLaND - Polish Company ¥ 10f1

K # L

Company

MABE-POLAND

GENERAL DEFAULT INVOICE TYPES

7

Posting Parameters

Create Posting at Invoice Entry

»

Accepted Invoice Voucher Difference in Accoun...

Miscellaneous Parameters

Planned Payment Date Calculation Base

Pay. Term Base Date -

PO MATCHING

Process Type

STD-PL - Standard Template for Invoice.. W

Print Advance Payments Information on Custo...

@O

Name

Polish Company

DOCUMENT MANAGEMENT

Same No on Preliminary and Final Supplier Inv_.

»

Accepted Invoice Rounding Difference in Invoic...

Unique Supplier Invoice No Per
Supplier -
Supplier Invoice Authorization Only by Separat...

»

Unique Payment Reference Validation

»

12.5.2.3 Define Tax Codes and Tax Categories 1

Using IFS Cloud standard functionality, define separate tax code used in order to follow invoices
which are a subject to the mandatory split payment mechanism.

Association No

Same Date on Preliminary and Final Supplier In__.

E
(

Rounding Line

Not Used

Incoming Invoice Currency Rate Base

Invoice Date

Cash Discount Based on Gross Amount

«©

Q
Created By
MABEPL
L
Use Posting Proposal
e
-
Qurtgoing Invoice Currency Rate Base
w  Invoice Date -

Set Invoice Date to Current Date When Printing__

@«
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Tax Codes

V + / {é} v m v 24 v B v
Tax Code Description Tax Type Tax (%)

Deductible (%) Valid From Valid To

MPP Mandatory Split Payment Tax 23 100 1/1/2023 12/31/2049

Using IFS Cloud standard functionality, select Tripartite EU Trade in the Tax Reporting Category
drop-down for tax codes intended for scenarios in which company is second party in EU tripartite
trade.

Tax Codes

Y + 7 & v B v

Tax Code Description Tax Type Tax (%) Deductible (%) Valid From

0§ Tripartite EU Trade

Tax Reporting Category

WDTWTT EU Sales - triangulation Tax 100 1/1/2017

Polish E-invoice XML in KSeF Style requires

¢ classification of tax transactions
e indicating invoices with reverse charge
e indicating exception base.

Polish E-invoice XML in IFS Style is enhanced with additional tags with this information.

Using IFS Cloud standard functionality, make sure that all categories listed below are available in
the Tax Category 1 page all tax codes used in customer invoicing are connected to relevant tax
category 1 in the Tax Codes page. When Polish E-invoice XML in IFS Style is created, the
<PLTaxCategoryl> tag includes this information in the <InvoiceRow> section, the
<VatSpecificationDetails> section and, in case of prepayment based invoices, <PLOrderRow>
section. During conversion to Polish E-invoice XML in KSeF Style, this information should affect the
P_12 tag (tax percentage, ‘zw’, ‘o0’ or ‘np’), the P_18 tag (reverse charge indicator) and total
amounts reported in tags with patterns P_13 % (tax base amounts), P_14 % (tax amounts) and
P_14 %W (tax amounts in PLN).

Tax Category 1 | KSeF tag to | KSeFP_12 | KSeF P_18 Comment
report tax | (Tax Rate) | (Reverse
base Charge)
1-Yes, 2-No
P 13 1 P 13 1 Tax Code | 2 Domestic,
Percentage basic percentage
(23% or
22%)
P 13 2 P 13 2 Tax Code | 2 Domestic,
Percentage first reduced
(8% or 7%) percentage
P 13 3 P 13 3 Tax Code | 2 Domestic,
Percentage second reduced
(5% or 3%) percentage
P13 6 1 P 1361 0% 2 Domestic 0%
P 13 6 2 P 13 6 2 0% 2 EU Sales of Goods
P 13 6 3 P 13 6 3 0% 2 Export
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Tax Category 1 | KSeF tag to | KSeFP_12 | KSeF P_18 Comment
report tax | (Tax Rate) | (Reverse
base Charge)
1-Yes, 2-No

 7/P_19A | P_13 7 A 2 Tax Free
- 7/P_19B
7/P_19C

8 P 13 8 np 1 Other than EU
Sales of Services

P 13 9 P 13 9 np 1 EU Sales of
Services

P_13 10 P 13 10 00 1 Domestic Reverse
Charge

Tax Categories

RSN s AR TAX CATEGORY 2 4 »

Y + 7 &v Bv uv BV

v Category ID Description
P_131 P_13_1=Tax Base, P_14_1/P_14_1W =Tax Amount, P_12=230r 22, P_18=2
P_13_10 P_13_10 = Tax Base, P_12 = 00, P_18 = 1 (Domestic Reverse Charge)
P_132 P_13_2 =TaxBase, P_14_2/P_14 2W =Tax Amount, P_12=80r7,P_18=2
P_133 P_13_3 =Tax Base, P_13_1/P_13_1W =Tax Amount, P_12=50r3,P_18=2
P_13.6_1 P_13_6_1 =Tax Base, P_12 =0, P_18 = 2 (Domestic 0%)
P_13.62 P_13 6 2=Tax Base,P_12=0, P_18 = 2 (EU Sales of Goods 0%)
P_1363 P_13_6_3 =Tax Base, P_12=0, P_18 = 2 (Export 0%)
P_13_7/P_19A P_13_7 = Tax Base, P_12 = zw, P_18 = 2, Tax Code Textin P_19A
P_13_7/P_19B P_13_7 = Tax Base, P_12 = zw, P_18 = 2, Tax Code Textin P_19B
P_13_7/P_19C P_13_7 = Tax Base, P_12=2zw, P_18 = 2, Tax Code Textin P_19C
P_13_8 P_13_8 = Tax Base, P_12 = np, P_18 = 1 (Other than EU Sales of Services 0%)
P13 P_13 9 = Tax Base, P_12=np, P_18 =1 (EU Sales of Services 0%)
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Tax Codes
Y + 7 S v B~v 24~ @A~
TaxCode ¥  Description ¥  TaxType ¥ Tax(%) ¥ TaxCategory1:% ¥ X  More ¥ © Favorites Apply Clear Saved Filters v
Tax Code Description Tax (%) [ Tax Category 1 Tax Reporting Category Deductible (%) Tax Type valid From
0 VAT 0%, domestic, sales and purchase O P_13.6_1-P_13.6_1=Tax Base, P_. None 100 Tax 17172017
OF Export of goods 0% 0] P_13.6_3-P_13.6_3 = Tax Base, P_. None 100 Tax 1172017
23 VAT 23%, domestic, sales and deductible purchase 23 § P_13.1-P_13_1=Tax Base, P_14_1 None 100 Tax 112017
5 VAT 5%, domestic, sales and deductible purchase 5 P_13.3-P_13_3 =Tax Base, P_13_1.. None 100 Tax 1/1/2017
8 VAT 8%, domestic, sales and deductible purchase 8 | P_13_2-P_13_2=Tax Base, P_14_2. None 100 Tax 1/1/2017
MPP Mandatory Split Payment 23 @ P_13.1-P_13_1 =Tax Base, P_14_1 None 100  Tax 1/1/2023
WDTO EU Sales - 0% ol P_13.6_2-P_13.6_2 = Tax Base, P_. None 100 Tax 1172017
WDTWTT EU Sales - triangulation OQ P13 8-P_13_8=TaxBase P_12= Tripartite EU Trade 100 Tax 17172017
ZAGU Non domestic services with deductible tax (not included in Art100) 0l P_13.8-P_13_8=Tax Base, P_12= None 100 Tax 1172017
ZAGU-UE Non domestic services with deductible tax (included in Art 100) O @ P_13.9-P_13_9 =Tax Base, P_12= EU Services 100 Tax 1/1/2017
ZAGUB Non domestic services with non deductible tax (not included in Art 1 O P_13.8-P_13_8=Tax Base, P_12=.. § None 100 Tax 1172017
ZAGUB-UE Non domestic services with non deductible tax (included in Art 100) Of P_13.9-P_13_9=Tax Base,P_12= EU Services 100 Tax 1/1/2017
w Domestic and import of goods (sales and purchase) exempted 0§ P_13_7/P_19A-P_13_7 = Tax Base, .. None 100  Tax 17172017

In case of exemption, select tax category depending on the reference you would like to include:

o Select “P_13_7/P_19A” category if exemption base refers to Polish VAT Law.
e Select “P_13_7/P_19B” category if exemption base refers to EU Directive.
o Select “P_13_7/P_19A” category if exemption base refers to other rules.

Using IFS Cloud standard functionality, click Tax Texts per Tax Code in the Tax Codes page and
enter details referring to exemption base in the Tax Code Text field.

Tax Texts per Tax Code

Y + 7
v Tax Code Tax Code Text Valid From Valid Te
~
ZW - Domestic and import of goods (sales and purchase) exempted Tax Free Text (connected to P_19A) 7/3/2023 12/31/2049

Polish E-invoice XML in KSeF Style requires sending company basic tax identity for domestic sales
and export sales (tax id without PL prefix) and company EU tax identity for EU sales (tax id with PL
prefix).

Handling of <SellerOrganizationTaxCode> tag in the Polish E-invoice XML in IFS Style is adjusted,
depending on the attributes of the selected tax code.

¢ In case of invoices issued in connection to EU sales of goods, select P_13 6 _2 in the Tax
Category 1 drop-down.

e |n case of invoices issued in connection to EU sales of services, select EU Services in the
Tax Reporting Category drop-down and select P_13_9 in the Tax Category 1 drop-down.

e In case of invoices issued by second party in the EU tripartite trade, select Tripartite EU
Trade in the Tax Reporting Category drop-down and select P_13_8 in the Tax Category 1
drop-down.

When sending invoices with such tax code included, “PL” prefix remains in company tax identity.
Otherwise “PL” prefix is removed from company tax id number.
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12.5.2.4 Define Invoice Information per Currency

Using IFS Cloud standard functionality, in the Invoice Information per Currency page, select All
Invoice Recipients in the Print Tax in Alternative Currency drop-down and select Accounting
Currency in the Alternative Tax Currency drop-down for all foreign currencies.

Invoice Information per Currency

v + 7 G v v 24v = v
Print Euro
Invoice Fee Invoice Fee  Equivalents

> Currency Code Rounding Factor Amount  Threshold Amount  oninvoice  Print Tax in Alternative Currency Alternative Tax Currency
BRL 0 m All Invoice Recipients Accoul nting Curren:y

cAD 0 o All Invoice Recipients Accounting Currency

CHF 0 m All Invoice Recipients Accoul ”[\ng (urren(y

DKK 0 o] All Invoice Recipients Accounting Currency

UR 0 m All Invoice Recipients Accoul ”[\ng (urren(y

GBP 0 o All Invoice Recipients Accounting Currency

HUF 0 m All Invoice Reclp\eﬂ[s Accoul ﬂ[\ng (ur’r’er\:y

Y 0 m All Invoice Recipients Accoul nting Curren:y

MXN 0 o All Invoice Recipients Accounting Currency

MXV 0 m All Invoice Recipients Accoul nting Curren:y

NOK 0 o All Invoice Recipients Accounting Currency

PLN 0 m Never Accoul ”[\ng (urren(y

SEK 0 o All Invoice Recipients Accounting Currency

UAH 0 m All Invoice Recipients Accoul ”[\ng (urren(y

usp 0 o All Invoice Recipients Accounting Currency

12.5.2.5 Define Audit Format for Poland
Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:
e Country as “Poland”
o Report Type as “SAF-T”.
12.5.2.6 Enter Audit File Basic Data
Click Audit File Basic Data to open the Audit File Basic Data page.

Audit Formats

Yy + @ ~» @ 4«

Audit File Basic Data § Audit File Tax Information = Audit File Log B v By 2av Hv

Thousands Negative  Leading
m Country Report Type Decimal Symbol Seperator Format Zeroes Time Format Date Format File Type File Template ID Default
: POLAND SAF-T -(point) , (comma) -9 09 13:59 YY-MM-DD JPK_V7M2 JPK_V7M2_TEMPLATE Yes

Using IFS Cloud standard functionality add a header record in the Audit File Basic Data page.

The new tab SAF-T Poland Setup includes ten sections. For Polish E-Invoice functionality, the Tax
Codes for Specific Procedures section is applicable.

Enter tax code used in order to follow invoices which are a subject to the mandatory split payment
mechanism in the (V7M) MPP/(FA) P_18A field.
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Audit File Basic Data

Z
HEADER STANDARD AUDIT CODE MAPPING 4« »
Z 1
General Info v
Misc Parameters v
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) ~
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v

Tax Codes for Specific Procedures

(V7M) MPP/ (FA) P_18A

23 =

Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings %

12.5.2.7 Define Customer

Using IFS Cloud standard functionality, enter customer tax identity in the
Customer/Address/Document Tax Information tab. In case of Polish tax identity, value can be
specified with dashes (for example 123-456-78-90) or without dashes (for example 1234567890). In
case of EU customer, enter customer tax identity including country prefix.

Add F@SS WB-cUST-PL-PL - Polish Customer in Polish Company ¥ 5o0f7

£« @ L~ Q
Customer Name Association No
MB-CUST-PL-PL Polish Customer in Polish Company

Address ID: A1-CUST-PL ¥
a + 7 M

End Customer

Custemer's Own Address ID Customer Name End Customer Address Identity
-
GENERAL ADDRESS INFORMATION ~ DELIVERY TAX INFORMATION [OTeIIIVEEN R /VAINZLIVIN(TeT' M SALES ADDRESS INFORMATION « »
Y + 7 v B~ v BH-
Tax ID
Validated
v Company Supply Country  Delivery Country Tax ID Type Tax ID Number Date
e 2 MABE-POLAND = = NIP 1234567890
Attachments v

Using IFS Cloud standard functionality, enable Print Tax Code Text in the
Customer/Invoice/General tab.

Using IFS Cloud standard functionality, in the Customer/Invoice/General tab

o Leave the Process Type drop-down empty if invoice should be issued via KSeF for the
customer.
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e Select process type (with e-Invoice Process disabled) from the Process Type drop-down
to switch off Send E-invoice for scenarios when invoice should not be issued via KSeF

(B2C).

|rIVOIce MB-CUST-PL-PL - Polish Customer in Polish Company ¥ 50f7

« & L0

Customer

MB-CUST-PL-PL

Company: MABE-POLAND - Polish Company ¥

Q + Z i Notes
GENERAL PROPERTIES ~ MESSAGE SETUP
Customer Type

External -

No of Invoice Copies

1

National Bank Code

Process Type

Attachments

Name

Polish Customer in Polish Company

IPD Tax Information

Default Currency Rate Type

Assaciation No

Currency

v PLN

Numeration Group

Payment Terms

w  0-Due Immediately

Inactive Date

Invoice Fee

Inactive Reason

Print Tax Code Text

Notes

Q
4«
Customer Group
¥  0- Domestic Associated Unit v
Tax Code
- -
-
Exclude Invoice Image
s

It is also possible to modify the process type at the invoice level (Instant Invoice/Customer Order
Invoice/Project Invoice) when it is connected to the Company or Customer. In such cases, the
system will automatically fetch the process type associated with the Company or Customer. Priority
is given to the customer-level process type. This functionality enables the exclusion of non-liable
invoices from being sent to Tax Authorities by selecting a process type that is not enabled for “E-
invoice Process” at the invoice level.

More Information

Process Type ayment Reference
UF-GEN-1| -

Transrer Status

Tax Currency Rate

Signature

SASGLK

Nature of Business

Payer Language
€5 CUSTOMER SW - CUSTOMER 5. English

Our Reference Customer Reference

Order Date Customer's FO Number

Ref Inuoice Series 10 Refinvoice No.

CUSTORDDEB - Customer Order Invoice, Debit
Invoice Address Invoice Date

v 22002025

© swap

UF-GEN-1- UF GEN 1 -

Printed Date

Notes

Comecton Exist

B usLon B h
@ > Sales > Invoicing > Customerinvoice &
Customer Invoice
@ search ()
»  CUSTOMER SW - CUSTOMER SW - 213357 - CUSTORDDEB - V12368 ¥  20f3 Prefiminary
#O £ L ~ share~  Cancellwoice  Posting ~  Instaliment Plan and Discounts  Notes [w]
Customer No Customer Address Name Series ID Invoice No Company Site Inveice Created Order Created
05 CUSTOMER SW CUSTOMER SW. PR 213357 SWG - SWG SWG 2202025 2/2012025
Amounts
Currency Gross Amt Net Amt Tax Amt Currency R Tax C y Rate
uso 27400.00 20000.00 740000 1 1
LINES GENERAL HISTORY “«
Indicators
Invoice Type Process Type Price adustment Acdvance/prepsyment invoice Use price Inci Tax

Correction Invoice
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® > Project Management > Invoicing > FrojectInvoice & Company  SWG
Project Invoice
@ search (2)
» PJ-20010002 ¥ Preliminary
o

& F W L v Nowes InwciceText Printout  Custemer Installment Plan

Customer Customer Name project invaice Series
CUSTOMER SW CUSTOMER SW - 7
Invoice No Invoice Period Start nuoice Period End Notes Inveice Text
20010002 20172025 B 2172025 = 0

Amounts
Currency Grass Amount Net Amount Tax Amount
use 227009 1657.00 613.09

LINES m PREPOSTING  ACCOUNTING >

Inveice Information

Invoice Date * imaice Type s Type ceries Reference
21742025 SR UF-GEN-1 - UF GEN 1 -
Invoice Number Reference currency Rate Our Reference. Customer Ref

1

12.5.2.8 Define Supplier

Using IFS Cloud standard functionality, enter supplier tax identity in the
Supplier/Address/Document Tax Information tab. In case of EU supplier, enter supplier tax
identity including country prefix.

@ > Application Base Setup > Enterprise > Supplier > Supplier > Address &

Add FE@SS MB-suPP-PL-PL - Polish Supplier in Polish Company ¥  1of1

> 2 L -
Supplier Name Association No
MB-SUPP-PL-PL Polish Supplier in Polish Company

Address ID: A1-SUPP-PL ¥

Q + @ 7 m@

Supplier’'s Own Address ID Supplier Name Supplier Branch

GENERAL ADDRESS INFORMATION ~ DELIVERY TAX INFORMATION [elelaV[ VI @V NIZe LV P i[e 'l  PURCHASE ADDRESS INFORMATION ~ OUTBOUND ADDRESS INFORMATION

Y + / W LA -«  Validate Tax ID Number

Tax ID
Validated
Company Tax ID Type Tax ID Number Date

(4}

N i MABE-POLAND NIP 1234567890
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Using IFS Cloud standard functionality, enter new record in the Supplier/Invoice/Message Defaults
tab and select “E-INVOICE” in the Media Code field.

® > Financials > Supplier Invoice > Supplier > Invoice &

|nVOIce MB-SUPP-PL-PL - Polish Supplier in Polish Company ¥ 1of1

[>]e o- o

Supplier Name Association No

MB-SUPP-PL-PL Polish Supplier in Polish Company

Company: MABE-POLAND - Polish Company ¥

Q + / [ Notes  Default Cost Code String

GENERAL PROPERTIES ~ TAX INFORMATION PO MATCHING [NISSNE Rel3 IR A

«
Y + Z S v By 24v =v
Automatic
Media Code Approval  Default Load Type Approval User
E-INVOICE o MB) MABEPL

12.6 Customer Invoices

12.6.1 SEND POLISH E-INVOICE IN IFS STYLE TO SERVICE PROVIDER
Using IFS Cloud standard functionality, enter/create customer invoice.

In the Instant Invoice page or the Project Invoice page, click Send E-invoice. In the Customer
Invoice page click Share and next click Send E-invoice.

= Prelimina
Customer INVOICe@ ws-cust-pLpL- Polish Customer in Polish Company - 204405 - CUSTORDDEB - P10785 ¥ 5 of 10 -

« 2 7 VAN D Cancel Invoice Posting v  Installment Plan and Discounts  Notes Q

Print Work Copy

Send E-invoice
Customer No Cud Series ID Invoice No Company Site Invoice Created

Order Created

MB-CUST-PL-PL Polish Customer in Pol WS 204405 MABE-POLAND - Polish MBPL 4/13/2023 4/13/2023
Amounts
Currency Gross Amt Net Amt Tax Amt Currency Rate Tax Currency Rate
usbD 1,230.0000 1,000.0000 230.0000 4 4
LINES GENERAL HISTORY 4 »
Indicators
Invoice Type Invoice Address Price Adjustment Advance/Prepayment Invoice Use Price Incl Tax
CUSTORDDEB - Customer Order Invoice, Debit © A1-CUST-PL - m m m
Invoice Date Printed Date Preliminary Invoice No Notes Correction Exist Correction Invoice
4/13/2023 204405 m m m
Refatenca st ferer Stomi tenceName
Our Reference Customer Reference Customer Reference Nam Corection Reason 1D Correction Reasorn
IFS Applications R -
Branch Customer Branch Jinsui Status
- Non Jinsui
Payment v | Delivery v

In the E-Invoice Process Monitoring page, verify status of the invoice. As a result of enabling
Process After Response in the E-Invoice Processing Type page, invoice series and invoice
number are assigned but Document Status remains Preliminary.

If any error was identified when creating E-invoice, status is Failed and error is displayed in the Error
field.

Otherwise, status is Pending and XML file is available in the outgoing folder of IFS Connect.
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E-Invoice Process Monitoring

Y

v Identity Series ID Document No

MB-CUST-PL-PL ZK 200700050 Preliminary

Document Status

Sent Time Status E-invoice Reference Number

9/5/23, 4:38 PM

12.6.1.1 Polish E-invoice XML in IFS Style

S

S\
SVIFS

S By uv B

E-invoice Reference Date Document Type Attachmen_. Error

Customer Invoice m B

Polish E-invoice XML in IFS Style is based on the standard IFS Style E-invoice XML and includes a
number of adjustments. In the file header Version is set to “2.0-PL” instead of standard “2.0”. New
tags are added and reported values are changed from standard version.

New tags.

New tag in Related/affected tags in Comment

Polish E-invoice XML Polish E-invoice XML

in IFS Style in KSeF Style

InvoiceDetails/ Fa/ VAT (normal invoice)

PLInvoiceTypeCode RodzajFaktury KOR (correction invoice for VAT)
ZAL (debit prepayment based
invoice)
KOR_ZAL (credit invoice for ZAL)
ROZ (final invoice after prepayment
based invoice)
KOR_ROZ (correction invoice for
ROZ).

InvoiceDetails/ Fa/ Additional information included for

PLKSeFOriginalnvoiceDate DaneFaKorygowanej/ correction invoices.

& DataWystFaKorygowanej E-invoice Reference Date, E-invoice

InvoiceDetails/ & Reference Number and Invoice Date

PLKSeFOriginalnvoiceNumber Fa/ of the original invoice.

& DaneFaKorygowanej/

InvoiceDetails/ NrKSeFFaKorygowanej

PLOriginalnvoiceDate

InvoiceDetails/ Fa/ Additional information included for

PLPreviousPrepaymentBasedInvoice/
PLPreviousPrepaymentBasedInvoiceNumber

&

InvoiceDetails/
PLPreviousPrepaymentBasedInvoice/
PLKSeFPreviousPrepaymentBasedInvoiceNumber

FakturaZaliczkowa/
NrFaZaliczkowej

&

Fa/
FakturaZaliczkowa/
NrKSeFFaZaliczkowej

final invoice with prepayment-based
invoice connected and for next
prepayment-based invoice for the
same customer order.

Invoice Series&Number and E-
invoice Reference Number of
previous prepayment based

invoices.
InvoiceDetails/ Fa/ Y if at least one tax code from
PLSplitPaymentindicator Adnotacje/ invoice line is specified in the (V7M)
P 18A MPP / (FA) P_18A field in the Tax
- Codes for Specific Procedures
section on the Audit File Basic
Data/SAF-T Poland Setup tab.
Otherwise N.
InvoiceRow/ Fa/ Tax Category 1 selected for the tax
PLTaxCategoryl FaWiersze/ code in the Tax Codes page.
FaWiersz/
P 12 See Define Tax Code chapter for
& details.
Fa/
Adnotacje/
P_18
&
Fa/
Adnotacje/
Zwolnienie/

P_19 and P_19A and P_19B and
pP_19C
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New tag in Related/affected tags in Comment
Polish E-invoice XML Polish E-invoice XML
in IFS Style in KSeF Style
InvoiceRow/ Fa/ Tax Reporting Category selected
PLTaxReportingCategory Adnotacje/ for the tax code in the Tax Codes
P_23 page.
See Define Tax Code chapter for
details.
InvoiceRow/ Fa/ Price after discount.
PLRowUnitDiscountedPriceAmount FaWiersze/ If column Total Line Discount is 0%
FaWiersz/ (or has no value), whole tag is not
(just for consistency with standard structure P_9A be created and stadard price tag can
InvoiceRow/ be used in mapping.
AmountCurrencyldentifier attribute from
PLRowUnitDiscountedPriceAmount tag
&
InvoiceRow/
UnitPriceUnitCode attribute from
PLRowUnitDiscountedPriceAmount tag)
InvoiceRow/ Fa/ Indicator of line before correction.
PLBeforeCorrectionIndicator FaWiersze/ Y for lines before correction on the
FaWiersz/ correction invoice.
StanPrzed Otherwise N.
Information on lines with Y indicator
should be reserved during
conversion.
InvoiceRow/ Indicator of instant invoice text line.
PLInvoiceTextLinelndicator Lines with this indicator should not be
reported in <FaWiersz>.
InvoiceRow/ Indicator of all lines of prepayment
PLPrepaymentBasedInvoiceRowIndicator based invoices and lines of final
invoices which represent matching
with previous prepayment based
invoices.
Lines with this indicator should not
be reported in <FaWiersz>.
VatSpecificationDetails/ Fa/ Tax Category 1 selected for the tax
PLTaxCategoryl P_13 %, P_14 % and P_14_ %W code in the Tax Codes page.
&
Fa/ See Define Tax Code chapter for
Adnotacje/ details.
P_18
&
Fa/
Adnotacje/
Zwolnienie/

P_19 and P_19A and P_19B and
P_19C

Country Solution POLAND 177



A\,
SUIFS

New tag in Related/affected tags in Comment

Polish E-invoice XML Polish E-invoice XML

in IFS Style in KSeF Style

PLOrderRow/ Fa/ New block with order details in case
PLArticleName Zamowienie of prepayment based invoices.
& The structure of tags follows the
PLOrderRow/ same principle as for InvoiceRow tag.

QuantityUnitCode attribute from
PLDeliveredQuantity tag

&

PLOrderRow/
PLDeliveredQuantity

&

PLOrderRow/
PLUnitPriceAmount

&

PLOrderRow/
PLRowVatRatePercent

&

PLOrderRow/
PLTaxCategoryl

&

PLOrderRow/
PLRowVatAmount

&

PLOrderRow/
PLRowVatExcludedAmount

(just for consistency with standard structure
PLOrderRow/
AmountCurrencyldentifier attribute from
PLUnitPriceAmount tag

&

PLOrderRow/

UnitPriceUnitCode attribute from
PLUnitPriceAmount tag

&

PLOrderRow/
AmountCurrencyldentifier attribute from
PLRowVatAmount tag

&

PLOrderRow/
AmountCurrencyldentifier attribute from
PLRowVatExcludedAmount tag)

Changed tags.

Existing tag in
E-invoice XML
in IFS Style

Comment

VatSpecificationDetails/

According to IFS Cloud standard functionality, when rows are created in this
block, one row is created per tax percentage, in particular, all tax codes with
0% will end up as one line.

Rules for creating this block are changed so that rows are created separately
for each Tax Category 1.

SellerPartyDetails/
SellerOrganizationTaxCode

Handling of PL prefix of company tax identity is changed.
See Define Tax Code chapter for details.

All characters other than letters and digits are removed from company tax
identity.

BuyerPartyDetails/
BuyerOrganizationTaxCode

All characters other than letters and digits are removed from customer tax
identity if country from document address is PL.
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12.6.2 ACTIVITIES AT SERVICE PROVIDER

The following steps are handled by Service Provider

Receiving Polish E-Invoice in IFS Style from IFS

Conversion of Polish E-invoice to KSeF Style

Sending Polish E-Invoice in KSeF Style to KSeF Platform
Receiving Response Message in KSeF Style from KSeF Platform
Conversion of Response Message to IFS Style

Sending Polish E-Invoice in KSeF Style to IFS

12.6.3 RECEIVE RESPONSE MESSAGE IN IFS STYLE FROM SERVICE PROVIDER

Response message in IFS Style is placed in incoming folder of IFS Connect. From this folder it is
automatically uploaded to IFS Cloud.

12.6.3.1 Response Status - Accepted
In case of response Accepted, in the E-Invoice Process Monitoring page.

e Status is set to Accepted.

e E-Invoice Reference Number is set based on value of the
<EINVOICE_REFERENCE_NUMBER> tag from the response message.

o E-Invoice Reference Date is set based on value of the <EINVOICE_REFERENCE_DATE>
tag from the response message.

E-Invoice Process Monitoring

Y S v 2uv @Y

dentity Series ID Document No Document Status Sent Time Status E-invoice Reference Number E-invoice Reference Date Document Type Attachmen...  Error

i MB-CUST-PL-PL i3 200700050 Preliminary 9/5/23, 4:38 PM Accepted |  9999999999-20230830-08F1EOACCIEE-43  9/5/23, 12:00 AM Customer Invoice m B

When accepted invoice is later referred:

e as original invoice in case of correction invoice

e as previous prepayment based invoice in case of next prepayment based invoice or final
invoice

number from the E-Invoice Reference Number field and, in case of correction invoice, date from
the E-Invoice Reference Date field of the accepted invoice are included in the later invoice.

12.6.3.2 Response Status - Rejected
In case response status is Rejected, in the E-Invoice Process Monitoring page:

e Status is set to Rejected.

e Response Error is set based on value of the
<RESPONSE_ERROR-> tag from the response message.

e Response Error Code is set based on value of the
<REPONSE_ERROR_CODE> tag from the response message.

Adjust basic data to correct the reason of the rejection.

As a result of enabling Process After Response in the E-Invoice Processing Type page
Document Status is Preliminary and rejected invoice can also be adjusted in Instant Invoice page,
Customer Invoice page or Project Invoice page respectively.

When reason for rejecting the invoice is fixed, click Resend E-invoice in the E-Invoice Process
Monitoring page.
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12.6.4 POST INVOICE

If Automatically Process Accepted Invoice is enabled in the E-Invoice Processing Type page,
invoice is automatically posted (Document Status set to Posted Auth in the E-Invoice Process
Monitoring page) when Status is set to Accepted.

If Automatically Process Accepted Invoice is disabled in the E-Invoice Processing Type page,
invoice should be posted manually.

¢ Inthe Print Invoice page, select the invoice and click Print.

e Inthe Instant Invoice page, select the invoice and click Print Invoice.

e In the Customer Invoice page, select the invoice and click Share and next click Print
Invoice.

e Inthe Project Invoice page, select the invoice and click Release Invoice.

3 Preliminan
Customer INVOoiCe we-custrL-pL- Polish Customer in Polish Company - 200700050 - CUSTORDDEB - P10785 ¥ 20f5 8

« 2 Q ~ Share Posting ~  Installment Plan and Discounts Notes Q
1
Print Invoice
I

Print Work Copy

Customer No CUS i srsnn s aaan S€FIES (D nvoice No Company Site Invoice Created Order Created

PG MB-CUST-PL-PL Polish Customer in Poli_. 7K 200700050 MABE-POLAND - Polish.. MBPL 4/13/2023 4/13/2023
Amounts
Currency Gross Amt Net Amt Tax Amt Currency Rate Tax Currency Rate

usD 1,230.0000 1,000.0000 230.0000 4 4
LINES HISTORY 4 »
“ | Indicators ~
Payment Vv | Delivery v
References v | Invoice Text v

E-invoice Information

Status E-invoice Reference Number E-invoice Reference Date Response Error Code
Accepted 9999999999-20230830-08F1 EDACCIEE-43 9/5/23, 12:00 AM
Response Error Error
& 5]
Attachments ~

12.6.5 UPDATE GENERAL LEDGER
Using IFS Cloud standard functionality, update vouchers to General Ledger.

12.6.6 FETCH TAX LEDGER INFO
Using IFS Cloud standard functionality, update tax transactions with additional information.

12.6.7 VIEW TAX TRANSACTIONS

Using IFS Cloud standard functionality, view tax transactions.
In the Tax Transactions page, value is fetched to the E-invoice Reference Number field.

@ > Financials > Tax Ledger > Tax Transactions & Company Polish Company

Tax Transactions

Y Z/ L +  Validate Tax ID Number Voucher Details Modify Tax Transactions  Include Tax Proposal ltem  Calculate Income Amount & v B
a Fetched  E-invoice Reference Number dentity Party Type nvoice Type Series ID nvoice No Tax Code
& I5285537316720240711VSDE0D0CEAA76738 I PE) MB-CUST-PL-PL - Polish Customer in Polish Company Customer FP P 200700039 23
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12.7 Supplier Invoices

12.7.1 LOAD E-INVOICE IN IFS STYLE

Using IFS Cloud standard functionality, load XML file.
E-invoice XML in IFS Style is placed in incoming folder of IFS Connect. From this folder it is

automatically uploaded to IFS Cloud.

12.7.2 VIEW EXTERNAL SUPPLIER INVOICE

Using IFS Cloud standard functionality, in the External Supplier Invoices page, enter number
assigned by Tax Authorities in the E-invoice Reference Number field for the uploaded invoice.

@ > Financials > Suppller Invoice > External Invoice > External Supplier invoices &3

External Supplier Invoices

Y /Z & 4 nvoice Line Information  Advance Invoice Information  Installment Information ~ Recalculate Payment Term Info  Create Invoices  View Local File  View Error Log  Notes

Load 1D E-Invoice Reference Number invoice No Supplier invoice Type statu: Invoice Status Transaction Date Invoice Date Delivery Date

: P 150 I5285537316»2024011|-BDEODOCEAA75-10 IZK200700001-3 PS) MB-SUPP-PL-PL-P.. ZZ Checked 1/31/2024 11172024 171172024

12.7.3 CREATE MANUAL SUPPLIER INVOICE
Using IFS Cloud standard functionality, create supplier invoice from external supplier invoice.

@ > Financials > Supplier Invoice > External Invoice > External Supplier invoices &3

External Supplier Invoices

Y /7 © 4 nvoice Line Information ~ Advance Invoice Information  Installment Information ~ Recalculate Payment Term Info [§ Create Invoices [| View Local File  View Error Log  Notes

Load 1D E-Invoice Reference Number invoice No Supplier invoice Type statu: Invoice Status Transaction Date Invoice Date Delivery Date

: @ 15 5285537316-20240111-8DEODOCEAA76-10 ZK200700001-3 PS) MB-SUPP-PL-PL-P.. ZZ Checked 1/31/2024 171172024 171172024

Using IFS Cloud standard functionality, in the Manual Supplier Invoice page click the More
Information command. In the More Information dialog, value in the E-invoice Reference Number
field can be changed for invoice in Preliminary status.

X More Information
Reference Series Reference Invoice No Invoice Recipient
MABEPL - Maria Beresewicz v
Supplier Invoice Address Delivery Address Use Project Address for Tax
AT-SUPP-PL v | A1-COMP-DEL (No
Reference Supplier Preliminary Code National Bank Code
- -
Nature of Business Creator Reference
E-INVOICE
Tax Currency Rate Parallel Currency ...  Delivery Date Tax Invoice Series ...  Tax Invoice No Tax Invoice Date
5 171172024
Transfer Status Customs Declaration Date
Correction Reason ID Correction Reason
-
Branch Supplier Branch
-

E-invoice Reference Number

ISZSSSE?BWG-ZDZJOW 11-8DEODOCEAATS-10 I

oK Cancel
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Using IFS Cloud standard functionality, invoice can also be entered using the New Manual Supplier
Invoice assistant. In the More Information section, enter number assigned by Tax Authorities in
the E-invoice Reference Number field.

® > Financials > Supplier inusice > New Manual Suppiier Invoica

New Manual Supplier Invoice

'_ Header Information —(  }— Line Information —

ucher Date Accourting Year Accounting Period User Group Voucher Type Voucher No

MABEPOLAND 3112028 & | 2024 3 ac -

Project D o
= = = | W) wiB-suPP-RL-PL - Polish Supplier in Polish Company -
v N Cureny  CumenyRate  lnvoi ce Date Arrival Date Pay Term Base Date
Fz ~ TEST 2 31112024 B | | 312024 B | 3172024 =]
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12.7.4 POST MANUAL SUPPLIER INVOICE

Using IFS Cloud standard functionality, post supplier invoice. If Date of Final Posting is selected in
the Supplier Invoices drop-down in the Tax Liability Date Control page, post invoice finally.

12.7.5 UPDATE GENERAL LEDGER

Using IFS Cloud standard functionality, update vouchers to General Ledger.

12.7.6 FETCH TAX LEDGER INFO

Using IFS Cloud standard functionality, update tax transactions with additional information.
12.7.7 VIEW TAX TRANSACTIONS

Using IFS Cloud standard functionality, view tax transactions.
In the Tax Transactions page, value is fetched to the E-invoice Reference Number field.

® > Financials > TaxLedger > TaxTransactions

Tax Transactions

Y /  Calculate Income Amount

Fetcned  E-Invoice Reference Number \dentity Party Type Invoice Type serles ID invoice No Invoice Date Tax ID Number
| I5285537316~ZOZAD111vSDEODUCEAA7640 I B8 MB-SUPP-PL-PL - Polish Supplier in Polish Company Supplier zZ zZ ZK200700001-3 1/11/2024 1234567890

12.8 Delimitations for Customer Invoices
This is an initial solution for Polish E-Invoice.

When creating Polish E-invoice XML in IFS Style

e Only basic information is supported.

¢ Non-mandatory elements/tags are not supported.
e Rebate invoice is not supported.

¢ Invoices with price including tax are not supported.
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Information for some of the KSeF tags is not included in Polish e-Invoice. In particular the following

is not available.

KSeF
Element/Tag

Description

Podmiot3

Information identifying a third party entity/entities referred to in the invoice

PodmiotUpowazniony

Information identifying an authorized entity referred to in the invoice

Stopka Other information included in the invoice such as, among other things, the invoice’s footer and the
KRS and REGON numbers

P_13 4 Amounts related to flat rate applicable to taxi services

P_14 4

P_14_4w

P_13 5 Amounts related to invoice documenting transactions realized by a taxable person identified in the

P_14 5 territory of the country as EU OSS

P_13 11 Amount related to invoice with margin based scheme

P_16 Annotation “cash-basis settlement method”

P_17 Annotation “self-billing”

pP_22 Intra-community supply of new means of transport

P_PMarzy Margin based scheme details

NrFaKorygowany Correct number of the invoice corrected in cases where the correction is made to amend the invoice’s
number

Podmiot1K Element containing the data of Podmiot1 put on the invoice corrected

Podmiot2K Element containing the data of Podmiot2 put on the invoice corrected

P_157ZK

KursWalutyZK

ZaliczkaCzesciowa

Zwrot akcyzy

Additional information necessary for farmers claiming refund of excise duty included in the price of
fuel oil

When additional information is fetched to tax transactions for posted invoices, value in the Status
field from the E-invoice Process Monitoring page is not validated. In case of using processing type
with Process After Response disabled, information can be fetched for not accepted status. When
invoice is accepted after the fetch process, E-invoice Reference Number is missing for the tax

transaction.

12.9 Delimitations for Supplier Invoices
This is an initial solution for Polish E-Invoice.

e E-invoice Reference Number (KSeF number) cannot be loaded from E-INVOICE XML.
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13 Appendix

Sample schema (XSD) for e-Invoice sending as well as receiving can be found in the Technical
Documentation (TechDocs) for 25R1.
In - Solution Manager User Guide/Integration/IFS Cloud Business Components/...

13.1 JPK_KR_PD XML FILE TAG MAPPING

The below attached files describe the legal requirement and the mapping of IFS data to xml tags
along with the attribute values for S_12 1,S 12 2and S_12 3tags.

& 3

Broszura_informacyjn JPK KR PD XSD file Schemat_JPK_KR_PD( JPK_KR_PD_xml_tag_
a_dotyczaca_struktury. (version 1-1) 1.pdf 1)_v1-1xsd mapping.xlsx
[, [, [,
S_12_1_attribute_valu S_12_2_attribute_valu S_12_3_attribute_valu
es.xlsx es.xlsx es.xlsx

13.2 JPK_ST_KR XML FILE TAG MAPPING

[

x}
IFS%20MAPPING%20
OF%20JPK_ST_KR.xlsx
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